Oracle CX

Implementing Customer Data Management for CX Sales and B2B Service

21A
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>i</td>
</tr>
<tr>
<td>1 About This Guide</td>
<td>1</td>
</tr>
<tr>
<td>Audience and Scope</td>
<td>1</td>
</tr>
<tr>
<td>Related Guides</td>
<td>1</td>
</tr>
<tr>
<td>2 Implementation Overview</td>
<td>3</td>
</tr>
<tr>
<td>Overview of Implementing Customer Data Management</td>
<td>3</td>
</tr>
<tr>
<td>Where You Perform Customer Data Management Setup Tasks</td>
<td>4</td>
</tr>
<tr>
<td>System Requirements</td>
<td>4</td>
</tr>
<tr>
<td>Verify the Need for Additional Licenses</td>
<td>5</td>
</tr>
<tr>
<td>Considerations for Migrating Data Between Environments</td>
<td>5</td>
</tr>
<tr>
<td>3 Profile Options, Lookups, and Scheduled Processes</td>
<td>7</td>
</tr>
<tr>
<td>What are Profile Options, Lookups, and Scheduled Processes?</td>
<td>7</td>
</tr>
<tr>
<td>Profile Options</td>
<td>7</td>
</tr>
<tr>
<td>Lookup Types</td>
<td>9</td>
</tr>
<tr>
<td>Scheduled Processes</td>
<td>16</td>
</tr>
<tr>
<td>4 Users and Security</td>
<td>19</td>
</tr>
<tr>
<td>Overview of Defining Setup Users</td>
<td>19</td>
</tr>
<tr>
<td>Configure Password Policies</td>
<td>19</td>
</tr>
<tr>
<td>Discard Domain Emails</td>
<td>19</td>
</tr>
<tr>
<td>5 Geographies</td>
<td>23</td>
</tr>
<tr>
<td>Overview of Geographies</td>
<td>23</td>
</tr>
<tr>
<td>Best Practices for Managing Geography Mismatches</td>
<td>40</td>
</tr>
<tr>
<td>Import Geographies and Zones</td>
<td>42</td>
</tr>
<tr>
<td>Set Up Geocoding</td>
<td>64</td>
</tr>
<tr>
<td>How You Set up Address Cleansing</td>
<td>68</td>
</tr>
<tr>
<td>FAQs for GBG</td>
<td>Loqate Support</td>
</tr>
<tr>
<td>FAQs for Define Geographies</td>
<td>71</td>
</tr>
</tbody>
</table>
## 6 Personally Identifiable Information

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>How You Protect Personally Identifiable Information</td>
<td>77</td>
</tr>
<tr>
<td>How You Work with Protected Information</td>
<td>78</td>
</tr>
<tr>
<td>Manage Personally Identifiable Information</td>
<td>79</td>
</tr>
<tr>
<td>Assign PII Privileges Using Security Console</td>
<td>81</td>
</tr>
</tbody>
</table>

## 7 Source Systems

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>How You Set up Source Systems</td>
<td>83</td>
</tr>
<tr>
<td>Source System Entities</td>
<td>83</td>
</tr>
<tr>
<td>Define Source System Confidence</td>
<td>84</td>
</tr>
<tr>
<td>Manage Source System Confidence Levels</td>
<td>84</td>
</tr>
<tr>
<td>FAQs for Define Source Systems</td>
<td>85</td>
</tr>
</tbody>
</table>

## 8 Party Usages

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>How You Define Party Usage</td>
<td>87</td>
</tr>
<tr>
<td>Manage Party Usages</td>
<td>87</td>
</tr>
<tr>
<td>Party Usage Filter Rules</td>
<td>89</td>
</tr>
<tr>
<td>Manage Party Usage Filter Rules</td>
<td>89</td>
</tr>
<tr>
<td>FAQs for Define Party Usages</td>
<td>91</td>
</tr>
</tbody>
</table>

## 9 Names and Identifiers

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Name Types</td>
<td>93</td>
</tr>
<tr>
<td>Manage Additional Name Types</td>
<td>93</td>
</tr>
<tr>
<td>Identifier Types</td>
<td>94</td>
</tr>
<tr>
<td>Manage Identifier Types</td>
<td>94</td>
</tr>
</tbody>
</table>

## 10 Relationships

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationships Types</td>
<td>97</td>
</tr>
<tr>
<td>Relationship Groups</td>
<td>98</td>
</tr>
<tr>
<td>Manage Relationship Types</td>
<td>98</td>
</tr>
<tr>
<td>Manage Relationship Groups</td>
<td>101</td>
</tr>
</tbody>
</table>

## 11 Classifications

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classification Components</td>
<td>103</td>
</tr>
<tr>
<td>FAQs for Define Classifications</td>
<td>104</td>
</tr>
</tbody>
</table>
# Oracle CX
Implementing Customer Data Management for CX Sales and B2B Service

## 12 Data Formats
- Data Styles and Data Formats 107
- Types of Data Formats 107
- Create an Address Style Format 108
- Update Address Formats 111
- Seeded Address Formats for Countries 111
- Create a Name Style Format 123
- FAQs for Define Data Formats 126

## 13 Contact Points
- Telephone Numbering Plan 129
- Update Telephone Numbering Plans 129
- How Telephone Number Plans Setup Fits in with other Setup Tasks 130
- FAQs for Define Contact Points 130

## 14 Data Import
- Data Import Options 131
- FAQs for Data Import 137

## 15 Export Management
- Overview of Export Management 139
- Export Data 139
- Export Queues 143
- How You Monitor Export Activity 145

## 16 Bulk Data Export
- Overview of Bulk Data Export 147
- Perform Bulk Export 148
- How Bulk Export Process Components Work Together 150
- FAQs for Manage Bulk Data Export 151

## 17 Configure Oracle DaaS and Oracle DataFox for Data Enrichment
- Overview of Configuring Data Enrichment 153
- Specify the Industry Classification for Accounts 153
- Manual Data Enrichment 154
18 Manage Profile Options

Customer Hub Profile Options
Data Quality Profile Options
Trading Community Model Profile Options

19 Duplicate Identification Setup

Overview of Duplicate Identification
Enterprise Data Quality Server Configurations
Enterprise Data Quality Matching Configurations
Manage Enterprise Data Quality Matching Configurations
Unique Identifiers and Elimination Identifiers
Manage Custom Match Rules and Scoring
Create Custom Match Rules
Considerations for Selecting Sources of Match Rules and Scoring
How You Configure Synonyms and Skip-words Dictionary
Key Generation
Identify Duplicates in Real-Time Using REST APIs and SOAP Web Services
FAQs for Duplicate Identification

20 Address Cleansing Setup

Overview of Address Cleansing
Address Cleansing Configurations
Manage Address Cleansing Configurations
How You Cleanse Addresses in Real-Time Using Web Services
How You Enable Search Mode for Address Verification Cloud Service
FAQs for Address Cleansing Setup

21 Duplicate Resolution Setup

Duplicate Resolution Simplified Profile Options
Run Request Dispatch Job
Set Up Duplicate Resolution Using Groovy Scripts
Set Up Duplicate Resolution Using Oracle Business Rules
Source System Confidence
Automerge
High Volume Batch Deduplication
## 22 Customer Data Management Integration with Other Cloud Services

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Data Management Integration Approaches</td>
<td>249</td>
</tr>
<tr>
<td>Merge Operation Process During Integration Cloud Service Based Integration</td>
<td>251</td>
</tr>
</tbody>
</table>
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Help

Use help icons 🎨 to access help in the application. If you don’t see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access the Oracle Help Center to find guides and videos.

Watch: This video tutorial shows you how to find and use help.

You can also read about it instead.

Additional Resources

- Community: Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.

- Training: Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>boldface</td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td>monospace</td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>
Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website. Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.

Contacting Oracle

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions

Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 About This Guide

Audience and Scope

This guide provides conceptual information and procedures needed to implement customer data management-specific components and features of your application.

You can use this guide to implement customer data management capabilities such as duplicate identification, duplicate resolution, address verification, and data enrichment. This guide assumes that the application is up and running at a basic level, as described in the use case contained in the Getting Started with Your Sales Implementation.

This guide also assumes that you have done additional setup for Core Sales following the Implementing Sales guide.

Related Guides

You can refer to the related guides listed in the following table to understand more about the tasks covered in this guide.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding Import and Export Management for CX Sales and B2B Service</td>
<td>Describes how to import legacy and other data into Oracle CX Sales and B2B Service using Import and Export Management, and export data out of these applications.</td>
</tr>
<tr>
<td>Understanding File-Based Data Import and Export for CX Sales and B2B Service</td>
<td>Describes how to import legacy and other data into Oracle CX Sales and B2B Service using File-Based Data Import, and export data out of these applications.</td>
</tr>
<tr>
<td>File-Based Data Import for CX Sales and B2B Service</td>
<td>Describes file-based data imports to import or update legacy and other data into Oracle CX Sales and B2B Service from external applications.</td>
</tr>
<tr>
<td>Using Data as a Service</td>
<td>Describes how to use Data as a Service (DaaS) to update company and contact data in your Oracle Cloud application.</td>
</tr>
<tr>
<td>Using Oracle Address Verification Cloud</td>
<td>Describes how to use Oracle Address Verification Cloud to verify and standardize addresses in your Oracle Cloud application.</td>
</tr>
</tbody>
</table>
Chapter 1
About This Guide
# 2 Implementation Overview

## Overview of Implementing Customer Data Management

To start an implementation of Customer Data Management Cloud, a user with the Application Implementation Consultant role (ORA_ASM_APPLICATION_IMPLEMENTATION_CONSULTANT_JOB) must opt into the offerings applicable to your business requirements. Refer to the Oracle Applications Cloud Using Functional Setup Manager guide to manage the opt-in and setup of your offerings.

### Customer Data Management Offering

Use this offering to configure the customer data management processes to clean, consolidate, and enrich customer information, and to create a trusted master customer profile.

The following table specifies the primary functional areas of this offering. For the full list of functional areas and features in this offering, use the Associated Features report that you review when you plan the implementation of your offering.

<table>
<thead>
<tr>
<th>Functional Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Quality</td>
<td>Manage data quality configurations to define how the data quality services, such as data quality matching and cleansing, are run during real time and during batch execution. Data quality services use these configurations to call appropriate services of the embedded data quality engine to consolidate, cleanse, and enrich customer data.</td>
</tr>
</tbody>
</table>
| Customer Hub    | Manage setup for the following features:  
  - **Customer Information Management**: Import, create, and manage customer information, such as profile, usage assignments, relationships, classifications, source system references, hierarchy memberships, linked records, accounts, and contacts, in the Organizations, Persons, and Groups work areas.  
  - **Hierarchy Management**: Manage the hierarchy of your customers across business processes. For example, you can use the hierarchy management capability to capture your customer’s corporate hierarchy and to show how headquarters, branches, subsidiaries, and so on are related. You can use the corporate hierarchy information to process payments from one customer and apply them to another customer in the same hierarchy.  
  - **Data Enrichment**: Enrich account and contact data to ensure it’s comprehensive. Data enrichment improves the quality of your existing account or contact data and address information as well as enriches that data with additional information.  
  - **Duplicate Identification**: Identify potential duplicates during data entry, data integration, or among records already in the application.  
  - **Duplicate Resolution**: Resolve duplicates either by directly merging them or by creating duplicate resolution request, such as merge or link. The resolution request can be verified, approved or rejected, and processed later.  
  - **Address Cleansing**: Cleanse address data existing in the registry and ensures data accuracy over time. Real-time address cleansing ensures that the incoming data from source systems follows the same convention as the target system for consistent information. |
Where You Perform Customer Data Management Setup Tasks

For most Customer Data Management setup tasks, you use the Setup and Maintenance work area to access the setup pages associated with the component or feature. The Setup and Maintenance work area is also known as the Functional Setup Manager.

**Note:** To start an implementation of Customer Data Management, a user with the Configure Oracle Fusion Applications Offering privilege (ASM_CONFIGURE_OFFERING_PRIV) such as Application Implementation Consultant, must opt into the offerings applicable to your business requirements. Refer to the Oracle Applications Cloud Using Functional Setup Manager guide to manage the opt-in and setup of your offerings.

For Customer Data Management setup tasks, a user with the Master Data Management Application Administrator role performs many, if not most, of the setup and configuration tasks.

You navigate to the Customer Data Management offering to access setup tasks:

1. Sign in as the Master Data Management Application Administrator or as a setup user and navigate to the Setup and Maintenance work area. The Setup page appears with an offering selected.

   **Tip:** To navigate to Setup and Maintenance, you can use the Navigator menu or the menu underneath your user image or name in the global header.

2. In the Setup page, select the Customer Data Management offering. The Setup: Customer Data Management page appears with a list of functional areas.

3. In the list of functional areas, click the functional area that has the tasks you need to access. A list of required tasks for the area is displayed.

4. In the list of tasks that appears, find the task you want and select it. (If the task you want isn't in the list, select All Tasks in the tasks filter.) The setup page for the task appears.

For more information about Functional Setup Manager, see the Oracle Applications Cloud Using Functional Setup Manager guide and the related topics.

**Related Topics**
- Plan Your Implementation
- Configure Offerings

System Requirements

Before using Oracle cloud applications in browsers and on your mobile devices, check the supported browsers and other system requirements. For information about system requirements, see https://www.oracle.com/system-requirements/.
Related Topics

- System Requirements for Oracle Applications Cloud

Verify the Need for Additional Licenses

You can only enable the functional areas for which your company has purchased licenses.

Customer Data Management is shipped free of cost with some Oracle Cloud Services such as Oracle CX. An Oracle CX license provides you access to the following customer data management functionality:

- Data Steward Productivity Tools
- File-Based Import and Import Management
- Reporting and Analytics
- Audit Reporting
- Customer Hub
- Customer Hierarchy Management

To make use of Data Quality, Data Enrichment, and Address Verification capabilities, you require the following additional licenses:

- Oracle Fusion Data Quality Cloud Service: This service enables you to identify and resolve potential duplicates records in the database or potential duplicates of the records in the database within an import batch. You can use this service for both real-time and batch duplicate identification.
- Oracle Address Verification Cloud Service: This service enables you to cleanse and verify addresses.
- Oracle Account Enrichment Cloud Service and Oracle Contact Enrichment Cloud Service: These Data as a Service (DaaS) licenses enable you to enrich company and contact data.
- Oracle DataFox: This service enables you to elevate business performance across the enterprise with account intelligence data.

Considerations for Migrating Data Between Environments

Almost all Oracle Cloud Applications implementations require moving data from one instance into another at various points in the life cycle of the applications. For example, one of the typical cases in any enterprise application implementation is to first implement in a development or test application instance and then deploy to a production application instance after thorough testing. You use various methods or tools to accomplish the migration of data.

Note: When you migrate data to a new environment the application does not retain all the values, and you need to add these values manually. For example, you would have to set some profile option values again, even if they were previously set.
For more information, see the Setup Data Export and Import chapter in the Oracle Applications Cloud Using Functional Setup Manager guide.

Related Topics

- Oracle Applications Cloud Using Functional Setup Manager guide
- Overview of Setup Data Export and Import
3 Profile Options, Lookups, and Scheduled Processes

What are Profile Options, Lookups, and Scheduled Processes?

Profile options, lookup types, and scheduled processes let you configure application behavior and process data. Briefly, here's what profile options, lookup types, and scheduled processes do:

- Profile options: Let you configure the application behavior.
- Lookup types: Provide the lists of values in applications. Many lookup types can be modified to fit your business needs.
- Scheduled processes: Act on data in the applications.

Get additional information on profile options, lookup types, and scheduled processes in this chapter and in the related topics.

Related Topics
- How can I access predefined profile options

Profile Options

Overview of Profile Options

Profile options let you configure and control application data centrally. Administrators and setup users manage profile options in the Setup and Maintenance work area.

Profile options store various kinds of information. This table lists some examples:

<table>
<thead>
<tr>
<th>Type of Information</th>
<th>Profile Option Setting Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>User preferences</td>
<td>Set preferences at the user level</td>
</tr>
<tr>
<td>Installation information</td>
<td>Identify the location of a portal</td>
</tr>
<tr>
<td>Configuration choices</td>
<td>Change UI skins and actions</td>
</tr>
<tr>
<td>Processing options</td>
<td>Determine how much information to log</td>
</tr>
</tbody>
</table>
Profile Option Hierarchy Levels

Profile options can be set at different levels, such as site level or user level. The application gives precedence to certain levels over others, when multiple levels are set. The levels that are allowed to be set are preconfigured with the application.

In the predefined profile option levels, the hierarchy levels and their precedence are:

1. **User**: This level affects only the current user. It has the highest precedence, over Site and Product.
2. **Product**: This level affects a product or product family. The application gives it priority over Site level. However, if the user level is set, the user level takes precedence.
3. **Site**: This level affects all applications for a given implementation. The application gives it the lowest precedence when other levels are set. If no other levels are set, however, it's the highest level.

As a best practice, set site-level profile option values before specifying values at any other level (where available). The profile option values specified at the site-level work as the default until profile option values are specified at the other levels.

This table shows an example of the predefined profile option hierarchy levels and their priorities.

<table>
<thead>
<tr>
<th>Level</th>
<th>Priority</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>Lowest</td>
<td>Currency for a site is set to Euros.</td>
</tr>
<tr>
<td>Product</td>
<td>Supersedes Site</td>
<td>Currency for the product or set of products is set to UK pound sterling.</td>
</tr>
<tr>
<td>User</td>
<td>Highest, supersedes Product</td>
<td>Currency for a user is set to US dollars.</td>
</tr>
</tbody>
</table>

You can find additional information about profile options in the related topics.

**Related Topics**

- Set Profile Option Values
- How can I access predefined profile options

Import Profile Values

Use the Import option on the Manage Administrator Profile Values page to import profile values in bulk and associate them with a profile option.

**Prerequisite**

The file containing the profile values is available in the document repository of Oracle WebCenter Content.

**Importing Profile Values**

To import profile values:

1. In the Setup and Maintenance work area, go to the **Manage Administrator Profile Values** task.
2. In the Profile Option: Profile Values section, from the Actions menu, select **Import**.
3. On the Import User Profile Values dialog box, select the WebCenter Content account to which the file was uploaded.
4. Enter the name of the file containing the profile values. The name here must match with the name of the file uploaded to the selected account.
5. Click **Upload**. The profile values are imported.

**Note:** If the import fails, click the link to the log file on the confirmation dialog box and examine the cause of failure.

### Related Topics
- Import Flexfields, Lookups, or Profile Values Using Web Services

### File Format for Importing Profile Values

To import profile option values into the application, you create a text file with the values and upload the file to the Oracle WebCenter Content document repository. The file must follow a specific format, as described here. After the file is in the document repository, you can then import the profile values into the application following the instructions in the Importing Profile Option Values: Procedure topic.

To create a file containing the profile values, include the following headers:

- **ProfileOptionCode**: The profile option code.
- **LevelName**: Must contain the value (Site, Product, or User).
- **UserName**: Must correspond to the registered user name in the application. Don’t provide any other shortened or coded name of the user.
- **ProfileOptionValue**: The profile value to be imported.

While creating the file, adhere to the following guidelines:

- Use a vertical bar or pipe ( | ) as a delimiter between fields for both header and value rows.
- Set the file encoding to UTF-8 without the Byte Order Mark (BOM), as per the Oracle WebCenter Content specification.

Here’s a sample file that contains the header values at the beginning of the file, followed by line entries of the two profile values that are to be imported. For importing several profile values, add more line entries in a similar format.

```
ProfileOptionCode|LevelName|UserName|ProfileOptionValue
AFLOG_BUFFER_MODE|USER|APP_IMPL_CONSULTANT|TEST
AFLOG_LEVEL|USER|APPLICATION_DEVELOPER|FINEST
```

### Related Topics
- Overview of Files for Import and Export
- Guidelines for File Import and Export
- Upload Files to WebCenter Content Server
- Overview of Profile Options

### Lookup Types
Overview of Lookup Types

**Lookup types** in the applications provide the lists of values in application fields that are drop-down lists. For example, when closing an opportunity, salespeople can pick a reason that an opportunity was won or lost from the Win/Loss Reason field, which is a drop-down list. The values in that list are derived from the lookup type, MOO_WIN_LOSS_REASON, which has several potential values known as lookups, each with its own unique lookup code and a meaning that displays in the UI.

Configuring Lookup Types

You can configure many lookup types to fit your business needs. The level at which a lookup type is extensible determines whether the lookups in that lookup type can be edited. The levels are: User, Extensible, and System.

The following table shows which lookup management tasks are allowed at each level.

<table>
<thead>
<tr>
<th>Allowed Task</th>
<th>User</th>
<th>Extensible</th>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleting a lookup type</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Inserting new codes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Changing the wording that displays on the page (Meaning field)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Updating start date, end date, and enabled fields</td>
<td>Yes</td>
<td>Yes, only if the code isn’t predefined data</td>
<td>No</td>
</tr>
<tr>
<td>Deleting codes</td>
<td>Yes</td>
<td>Yes, only if the code isn’t predefined data</td>
<td>No</td>
</tr>
<tr>
<td>Updating tags</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Updating module</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

If a product depends on a lookup type, the configuration level must be System or Extensible to prevent deletion. After the configuration level is set for a lookup type, it can’t be modified. The configuration level for lookup types created using the Define Lookups page is by default set at User level.

Sales Lookup Types

You find lookup types by accessing the associated task in the Sales offering in the Setup and Maintenance work area. Here are some of the common sales lookup tasks or task lists:

To access sales lookup types:

1. Sign in as a setup user and navigate to the Setup and Maintenance work area.
2. In Setup and Maintenance, go to the Sales offering.:
3. In the list of functional areas, click the area where the lookup appears. See the list at the end of this procedure for more information.
A list of tasks for the area is displayed.
4. In the list of tasks, click the lookups task.
5. In the lookup types page, modify the lookup type as needed.

The following are the Sales lookup type tasks and the functional areas where they appear:

- **Sales Foundation functional area:**
  - Manage Geography Lookups
  - Manage Applications Core Standard Lookups
  - Manage Activity Standard Lookups

- **Users and Security functional area:**
  - Manage Resource Role Lookups
  - Manage Resource Lookups

- **Accounts and Contracts functional area**
  - Manage Group Lookups
  - Manage Source System Lookups
  - Manage Hierarchy Lookups
  - Manage Trading Community Common Lookups
  - Manage Party Usage Lookups
  - Manage Relationship Lookups
  - Manage Contact Point Lookups
  - Manage Trading Community Organization Lookups
  - Manage Trading Community Location Lookups
  - Manage Trading Community Person Lookups
  - Manage Contact Lookups
  - Manage Customer Account Lookups
  - Manage Customer Center Lookups

- **Sales Catalog and Products functional area:**
  - Manage Product Group Lookups

- **Sales Campaigns functional area:**
  - Manage Marketing Standard Lookups

- **Leads functional area:**
  - Manage Sales Lead Standard Lookups
  - Manage Set Enabled Lookups

- **Opportunities functional area:**
  - Manage Set Enabled Lookups
• Territories functional area:
  ◦ Manage Territory Management Non-extensible Lookups

• Business Plans functional area:
  ◦ Manage Business Plan Non-extensible Lookups
  ◦ Manage Objectives Non-extensible Lookups

• Partners functional area:
  ◦ Manage Partner Lookups

Set-Enabled Lookup Types
Several applications support lookup types at the reference set level, allowing you to present different lists of values for different business units. You can find these in the Manage Set Enabled Lookups task within the functional area that supports these lookup types.

Related Topics
• Reference Data Sets

How can I access predefined lookups?
Search for predefined lookups using any of the manage lookups tasks.

1. In the Setup and Maintenance work area, go to any of the following tasks that contains the lookups you’re looking for:
   ◦ Manage Standard Lookups
   ◦ Manage Common Lookups
   ◦ Manage Set-enabled Lookups

2. Enter any of the search parameters and click Search. If you don’t know the lookup type or the meaning, use the Module field to filter search results.
3. Click a lookup type to view its lookup codes.

   Tip: Click the Query By Example icon to filter the lookup codes.

Related Topics
• Use Query By Example

How can I edit lookups?
On any of the Manage Lookups pages, you can edit the existing lookup codes of a lookup type or add new lookup codes. You can edit lookups using the following tasks in the Setup and Maintenance work area:

• Manage Standard Lookups
• Manage Common Lookups
• Manage Set-enabled Lookups

Each task contains a predefined set of lookup types that are classified and stored. Open a task to search and edit the required lookup. However, you may not be able to edit a lookup if its configuration level doesn’t support editing.

Why can't I see my lookup types?

Lookup types are classified using tasks that involve a group of related lookups, such as Manage Geography Lookups. Each task gives you access only to certain lookup types. However, the generic tasks provide access to all lookup types of a kind, such as common lookups associated with the Manage Common Lookups task.

If the lookup types in an application are available in the standard, common, or set-enabled lookups view, they’re central to an application. However, lookup types defined for a specific application are managed using the task for that application.

Import Lookups

On each page pertaining to the tasks of managing the Standard, Common, and Set Enabled lookups, use the Import option to import the lookup type and lookup code information.

Prerequisite

The separate files containing the lookup types and lookup codes are already available in the document repository of Oracle WebCenter Content.

Importing Lookups

To import lookups:

1. In the Setup and Maintenance work area, go to the Manage Standard Lookups task. Depending on the lookup you want to import, you may select the other lookup tasks.
2. In Search Results, from the Actions menu, select Import.
   The Import Lookups dialog box appears.
3. Select the WebCenter Content account to which the files were uploaded.
4. Enter the names of the separate files containing the lookup type and lookup code information. The names here must match with the names of the files uploaded to the selected account.
5. Click Upload. The lookup details are imported.

   Note: If the import fails, click the link to the log file on the confirmation dialog box and examine the cause of failure.

Related Topics

• Import Flexfields, Lookups, or Profile Values Using Web Services

File Format for Importing Lookups

To import lookups into an application, you create separate text files containing the lookup types and lookup codes and upload them to the Oracle WebCenter Content document repository. The files must follow a specific format, as
described here. After the files are in the document repository, you can then import the lookup types and lookup codes into the application following the instructions in the Importing Lookups: Procedure topic.

While creating the file, adhere to the following guidelines:

- Use a vertical bar or pipe ( | ) as a delimiter between fields for both header and value rows.
- Set the file encoding to UTF-8 without the Byte Order Mark (BOM), as per the Oracle WebCenter Content specification.

The following sections contain details about the specific lookup types and codes.

Prerequisite
You must have worked with lookups in Oracle Cloud applications.

Standard and Common Lookups
The lookup types and codes are similar for standard and common lookups. To create a file containing the lookup types, include the following headers:

- **LookupType**: The lookup type.
- **Meaning**: The display name of the lookup type.
- **Description**: The description of the lookup type. This header is optional.
- **ModuleType**: The module with which the lookup type is associated.
- **ModuleKey**: The module code.

Here's a sample file that contains the header values at the beginning of the file, followed by line entries of the two lookup types that are to be imported. For importing several lookup types, add more line entries in a similar format.

```
LookupType|Meaning|Description|ModuleType|ModuleKey
AFLOG_22APR_1|Log1|AFLOG_desc_1|APPLICATION|FND
PROD_22APR_2|Product1|PROD_desc_2|APPLICATION|FND
```

To create a file containing the lookup codes, include the following headers.

- **Required headers**:
  - **LookupType**: The lookup type.
  - **LookupCode**: The lookup code associated with the lookup type.
  - **DisplaySequence**: The sequence position at which the lookup code appears in the list of values.
  - **EnabledFlag**: Indicates the status of the lookup code, whether it's enabled for display or not.
  - **Meaning**: The display name of the lookup code.

- **Optional headers**:  
  - **StartDateActive**: Beginning of the date range during which the lookup code is active and visible on the page. The format is dd/M/yyyy.
  - **EndDateActive**: End of the date range during which the lookup code is active and visible on the page. The format is dd/M/yyyy.
  - **Description**: Description of the lookup code.
  - **Tag**: Any tag associated with the lookup code that may be used for a quick reference or retrieval of information.
  - **Seg**: The name of the API used for a global segment defined for the descriptive flexfield associated with the lookup.
Here's a sample file that contains two lookup codes:

<table>
<thead>
<tr>
<th>LookupType</th>
<th>LookupCode</th>
<th>DisplaySequence</th>
<th>EnabledFlag</th>
<th>StartDateActive</th>
<th>EndDateActive</th>
<th>Meaning</th>
<th>Description</th>
<th>Tag</th>
<th>Seg</th>
</tr>
</thead>
<tbody>
<tr>
<td>TASK_22APR_1</td>
<td>Code1_1</td>
<td>1</td>
<td>Y</td>
<td>25/12/2014</td>
<td>25/5/2015</td>
<td>TASK_22apr_1</td>
<td>Task_desc_1</td>
<td>Tag1_1</td>
<td>testSeg1</td>
</tr>
<tr>
<td>TASK_22APR_1</td>
<td>Code1_2</td>
<td>2</td>
<td>N</td>
<td>25/1/2014</td>
<td>25/11/2015</td>
<td>TASK_22apr_1</td>
<td>Task_desc_1</td>
<td>Tag1_2</td>
<td>testSeg1</td>
</tr>
<tr>
<td>TASK_22APR_2</td>
<td>code2_1</td>
<td>3</td>
<td>N</td>
<td>25/12/2012</td>
<td>25/7/2015</td>
<td>TASK_22qpr_2_1</td>
<td>Task_desc_2_1</td>
<td>tag2_1</td>
<td>testSeg2</td>
</tr>
<tr>
<td>TASK_22APR_2</td>
<td>code2_2</td>
<td>3</td>
<td>Y</td>
<td>25/12/2012</td>
<td>25/7/2015</td>
<td>TASK_22qpr_2_2</td>
<td>Task_desc_2_2</td>
<td>tag2_2</td>
<td>testSeg2</td>
</tr>
</tbody>
</table>

Set Enabled Lookups

To create a file containing the set enabled lookup types, include the following headers:

- **LookupType**: The lookup type.
- **Meaning**: The display name of the lookup type.
- **Description**: The description of the lookup type. This header is optional.
- **ModuleType**: The module with which the lookup type is associated.
- **ModuleKey**: The module code.
- **ReferenceGroupName**: Name of the reference group that contains the reference data set.

Here's a sample that contains two set enabled lookup types:

<table>
<thead>
<tr>
<th>LookupType</th>
<th>Meaning</th>
<th>Description</th>
<th>ModuleType</th>
<th>ModuleKey</th>
<th>ReferenceGroupName</th>
</tr>
</thead>
<tbody>
<tr>
<td>CODE_22APR_1</td>
<td>CODE_22apr_1</td>
<td>Code_desc_1</td>
<td>APPLICATION</td>
<td>FND</td>
<td>BU_APAC</td>
</tr>
<tr>
<td>CODE_22APR_2</td>
<td>CODE_22qpr_2</td>
<td>Code_desc_2</td>
<td>APPLICATION</td>
<td>FND</td>
<td>BU_APAC</td>
</tr>
</tbody>
</table>

To create a file containing the set enabled lookup codes, include the following headers.

- **Required headers**:
  - **LookupType**: The lookup type.
  - **LookupCode**: The lookup code associated with the lookup type.
  - **DisplaySequence**: The sequence position at which the lookup code appears in the list of values.
  - **EnabledFlag**: Indicates the status of the lookup code, whether it's enabled for display or not.
  - **Meaning**: The display name of the lookup code.
  - **SetName**: Name of the reference data set.

- **Optional headers**:
  - **StartDateActive**: Beginning of the date range during which the lookup code is active and visible on the page. The format is dd/M/yyyy.
  - **EndDateActive**: End of the date range during which the lookup code is active and visible on the page. The format is dd/M/yyyy.
  - **Description**: Description of the lookup code.
  - **Tag**: Any tag associated with the lookup code that may be used for a quick reference or retrieval of information.

Here's a sample file that contains the header values at the beginning and lists four set enabled lookup codes to be imported. For importing several lookup codes, add more entries in the same format.
Profile Options, Lookups, and Scheduled Processes

LookupType|LookupCode|DisplaySequence|EnabledFlag|StartDateActive|EndDateActive|Meaning|Description|Tag|
---|---|---|---|---|---|---|---|---|
DATA_22APR_1|Code1_1|1|Y|25/12/2014|25/5/2015|DATA_22apr_1|Data_desc_1|Tag1_1|TEST SET CODE 2
DATA_22APR_1|Code1_2|2|N|25/1/2014|25/11/2015|DATA_22apr_2|Data_desc_2|Tag1_2|TEST SET CODE 3
DATA_22APR_2|Code2_1|3|N|25/12/2012|25/7/2015|DATA_22qpr_2_1|Data_desc_2|Tag2_1|TEST SET CODE 2
DATA_22APR_2|Code2_2|3|Y|25/12/2012|25/7/2015|DATA_22qpr_2_2|Data_desc_2_2|Tag2_2|TEST SET_ERR_CODE_Z

Related Topics
- Overview of Files for Import and Export
- Guidelines for File Import and Export
- Upload Files to WebCenter Content Server
- Overview of Lookups

Scheduled Processes

Overview of Scheduled Processes
Some tasks are too complicated or would take way too long if you had to do them manually, especially one record at a time. So, you can run scheduled processes that do the task for you, for example to import data or update the status for a bunch of records. Some processes give you printable output. Those processes might have Report in their name.

Jobs and Job Sets
Each scheduled process that you run is based on a job. The job is the executable that controls what the process can do and what parameters and other options you have for the process. A job set contains multiple jobs.

Process Sets
A process set is a scheduled process that's based on a job set. So, when you submit a process set, you're running more than one job.

Note: When you submit certain scheduled processes, the job logic causes other processes to automatically run. But in this case, you're not submitting a process set that includes those other processes.

Submission
When you submit a scheduled process, you can use its parameters to control which records are processed and how. For example, a process includes only the transactions that were edited by the person you select for a Last Updated By parameter. Some processes don't have parameters.

As part of the submission, you can also set up a schedule for the process, for example to run once a week for two months. Every time a process runs, there's a unique process ID.

Output
Some scheduled processes provide output in PDF, HTML, and other formats. For example, a process can import records and also produce output with details about those records. There are many types of output, for example a tax document or a list of transactions.

Related Topics
- Process Sets
View Details About Predefined Scheduled Processes

To use web services to run predefined scheduled processes, you require details about the processes. View job definitions that the processes are based on, for example to get information about parameters. You might also need to find security requirements for running the scheduled process.

Job Definitions

A job definition contains the metadata that determines how a scheduled process works and what options are available during submission.

To view job definitions:

1. Go to the Setup and Maintenance work area.
2. From the Application Extensions functional area, open any of these tasks as appropriate:
   - Manage Enterprise Scheduler Job Definitions and Job Sets for Financial, Supply Chain Management, and Related Applications
   - Manage Enterprise Scheduler Job Definitions and Job Sets for Human Capital Management and Related Applications
   - Manage Enterprise Scheduler Job Definitions and Job Sets for Customer Relationship Management and Related Applications
3. In the Manage Job Definitions tab, select your job definition and click Edit.

   Note: Predefined job definitions are marked with an asterisk.

4. Cancel after you get the information you need.

Security

Privileges provide the access required to run specific scheduled processes. Privileges are granted to duty roles, which are granted to job roles. To see which job roles inherit the required privileges, use the Security Console or the security reference manuals for the appropriate product family.
4 Users and Security

Overview of Defining Setup Users

One of your first tasks when setting up the application is the creation of users who can perform setup tasks.

Oracle creates an initial user for you when your environment is provisioned. This initial user is configured to perform security tasks, such as creating other users and granting additional privileges. As an initial user you can create users, known as setup users, to help with application setup. The setup user performs the tasks in implementation projects, sets up enterprise structures, creates application users, and administers security.

Use the Manage Users task in the Setup and Maintenance work area to create setup users. You can access this task in the Setup and Maintenance work area by selecting these options:

- Offering: Customer Data Management
- Functional Area: Users and Security
- Task: Manage Users

For information about creating setup users, see the Getting Started with Your Sales Implementation guide.

Related Topics
- Getting Started with Your Sales Implementation guide
- Securing CX Sales Sales and B2B Service guide

Configure Password Policies

The applications have default settings around the user sign-in policies. For example, by default, users have 90 days before their sign-in passwords expire. You can change this default value, and you can configure other sign-in parameters. See the related topics for more information.

Related Topics
- Password Policy
- How can I reset a user's password
- User-Name and Password Notifications
- How can I notify users of their user names and passwords

Discard Domain Emails

During an implementation, you set up users and test business flows that trigger automatic emails. During this stage of setup, you probably don’t want emails being sent to real users, so you can simply use discard email domains that Oracle has made available.
Discard Email Domains
Oracle recommends that you don't use fictitious email addresses, because this causes email bounces. Fictitious emails generally take three forms:

- An incorrect user identifier at a valid domain
- A random domain
- A domain that doesn't exist

Using fictitious email addresses can have numerous negative consequences, including unintentionally sending email to a real person or damaging the reputation of the IP address that sends out the email, potentially flagging it as a sender of spam. For example, you might send an email to tina.best@ssf.com, thinking that ssf is just a random alphabetic sequence and not an actual domain. However, your email is actually sent to the Spruce Street Foods (ssf.com). The Spruce Street Foods email server must then determine if there is a valid recipient and, if not, make a reputation decision about the sender's IP address.

To avoid these undesirable conditions, Oracle has established email domains in each of its data centers that you can use temporarily during setup. Any email sent from Oracle cloud applications to one of the discard domains doesn't leave the data center. Instead, it's discarded by the mail servers during the send process. You can turn any recipient address into a discard address by replacing the domain information with one of the discard domains. So, in the example presented here, we might use tina.best@discard.mail.us1.cloud.oracle.com.

Here are the discard domains and the data centers that they're associated with:

<table>
<thead>
<tr>
<th>Discard Domain</th>
<th>Data Center</th>
</tr>
</thead>
<tbody>
<tr>
<td>@discard.mail.us1.cloud.oracle.com</td>
<td>Austin</td>
</tr>
<tr>
<td>@discard.mail.us2.cloud.oracle.com</td>
<td>Chicago</td>
</tr>
<tr>
<td>@discard.mail.us6.cloud.oracle.com</td>
<td>Ashburn</td>
</tr>
<tr>
<td>@discard.mail.ca2.cloud.oracle.com</td>
<td>Markham</td>
</tr>
<tr>
<td>@discard.mail.ca3.cloud.oracle.com</td>
<td>Calgary</td>
</tr>
<tr>
<td>@discard.mail.ap1.cloud.oracle.com</td>
<td>Sydney</td>
</tr>
<tr>
<td>@discard.mail.ap2.cloud.oracle.com</td>
<td>Singapore</td>
</tr>
<tr>
<td>@discard.mail.em1.cloud.oracle.com</td>
<td>Linlithgow</td>
</tr>
<tr>
<td>@discard.mail.em2.cloud.oracle.com</td>
<td>Amsterdam</td>
</tr>
<tr>
<td>@discard.mail.em3.cloud.oracle.com</td>
<td>Slough</td>
</tr>
</tbody>
</table>
Discard domains cross data center boundaries. You can use any of them, no matter which data center supplies your service. Oracle provides data center-specific domains in case you’re concerned about geopolitical boundaries and want to ensure that discard data remains in your data center region.

Discard domains are also available for government and defense data centers. For details on these restricted data centers, log a service request for cloud operations through My Oracle Support.

If you're importing your users, you can use the discard domains in your import file and then go back later and re-import the users with the real domain information. For more information on importing users, see the importing users topics in the Getting Started with Your Sales Implementation guide.

**Related Topics**
- Getting Started with Your Sales Implementation guide
- Securing CX Sales and B2B Service guide
5 Geographies

Overview of Geographies

How Geography Structure, Hierarchy, and Validation Fit Together

There are three components that are dependent on each other when defining a country: geography structure, geography hierarchy, and geography validation. Every country has to have the geography structure defined first before the hierarchy can be defined, and the geography hierarchy has to be defined before the validation can be defined.

Geography Structure

Firstly, you need to create a geography structure for each country to define which geography types are part of the country structure, and how the geography types are hierarchically related within the country structure. For example, you can create geography types called State, City, and Postal Code. Then you can rank the State geography type as the highest level within the country, the City as the second level, and the Postal Code as the lowest level within the country structure. Geography structure can be defined using the Manage Geographies task, or can be imported using tasks in the Define Geographies activity.

Geography Hierarchy

Once the geography structure is defined, the geographies for each geography type can be added to the hierarchy. For example, in the hierarchy of United States you can create a geography called California using a State geography type.

As part of managing the geography hierarchy you can view, create, edit, and delete the geographies for each geography type in the country structure. You can also add a primary and alternate name and code for each geography. A geography hierarchy can be created using the Manage Geographies task, or can be imported using tasks in the Define Geographies activity.

Geography Validation

After defining the geography hierarchy, you need to specify the geography validations for the country. You can choose which address style format you would like to use for the country, and for each selected address style format you can map geography types to address attributes. You can also select which geography types to include in geography or tax validation, and which geography types will display in a list of values during address entry in other user interfaces. The geography validation level for the country, such as error or warning, can also be selected.

Geography Structures

This topic describes geography structures and the tasks you can perform using geography structures.

A geography structure is a hierarchical grouping of geography types for a country. The following table describes the geography structure for the United States.
You can use the geography structure to relate geography types for a country and define geography types for a country.

**Relate Geography Types for a Country**

You can determine how a country’s geographies are hierarchically related by creating the hierarchy of the geography types in the geography structure. When you define a country’s structure, the geography type Country is implicitly at the highest level of the geography structure with level as 1. The subsequent geography types that you add after country are numbered in sequence.

You must add a geography type as a level in the country structure before you can define a geography for that geography type in a country. For example, before defining the state of California, the State geography type must be added to the United States country structure. To quickly create country structure, you can copy a structure from another country and modify the geography types for the country.

**Define Geography Types for a Country**

You can use any of the master reference geography types to create your geography structure. If required, you can create a geography type, before adding it to the country structure. Each geography type is added at a lower level to the current lowest level.

**Note:** You can’t delete geography types that have associated geography data. You can only delete the lowest level geography type of the country structure.

You can use a geography type that you create within the country structure for other country structures as well.

**Geography Hierarchy**

This topic describes geography hierarchy and various aspects of geography hierarchy.

Geography hierarchy is a data model that creates conceptual parent-child relationships between geographies. At the highest level of the geography hierarchy is country, which is the parent, and the hierarchy contains several child geographies. The following table shows sample parent-child relationships in a geography.

<table>
<thead>
<tr>
<th>California</th>
<th>Parent of San Mateo county</th>
</tr>
</thead>
<tbody>
<tr>
<td>San Mateo County</td>
<td>Parent of Redwood City</td>
</tr>
</tbody>
</table>
When you enter just 94065, the application determines that the postal code is in California and the corresponding city is Redwood City.

The application uses geography hierarchy information to facilitate business processes that rely on geography information, such as, tax calculation, order sourcing rules, and sales territory definition. The geography hierarchy information is centrally located and shared among other application offerings.

The geography hierarchy includes:

- Geography: Geography is a physical space with boundaries that’s a defined instance of a geography type, such as country, state, province or city. For example, San Jose is a geography of the City geography type.
- Geography type: Geography types are divisional grouping of user defined geographies, for example, Continent, Country Regions, and Tax Regions.
- Geography usage: Geography usage indicates how a geography type or geography is used in the application.
- Master reference geography hierarchy: The geography hierarchy data is considered the single source of reference for all geography related data such as geography types and geographies.

The geography usage for the entire hierarchy is the master reference, and defined geography types and geographies are the master reference geography types and geographies. For example, you can create geography types called State, City, and Postal Code. Then, you can rank the State as the highest level, City as the second level, and Postal Code as the lowest level within the country structure.

- User defined zones: User defined zones are a collection of geographical data, created from master reference data for a specific purpose. For example, while the territory zones are collections of master reference geographies ordered with a hierarchy, the tax and shipping zones are without a hierarchical grouping.

#### Geography Validation

Geography validation determines the geography mapping and validation for a country's address styles, as well as the overall geography validation control for a country.

The **No Styles Format** address style format is the default address style format for a country. By defining the mapping and validation for this format you will ensure that validations can be performed for any address in the country. After the **No Styles Format** is defined you can set up additional mapping for specific address styles.

For each address style format, you can define the following:

- Map to attribute
- Enable list of values
- Tax validation
- Geography validation
- Geography validation control
Attribute Mapping

For every address style format, you can map each geography type to an address attribute. For example, you can map the `State` geography type to the `State` address attribute for the United States, or map the `State` geography type to the `County` address attribute for the United Kingdom. The geography types that appear are based on how the country structure is defined. The list of address attributes that appear are based on address formats delivered with the application, or your customer defined address formats.

**Note:** You only need to map geography types that you want to use for geography or tax validation purposes.

Enable List of Values

Once a geography type is mapped to an attribute, then you can specify whether the geography type will appear in a list of values during address entry in user interfaces. It is very important to review carefully if you want to enable a list of values. You should only enable a list of values if you have sufficient geography data imported or created for that geography. If the setup for master geography data is incomplete, then the geography data is either not imported or created. As a result, the list of values for the address attribute doesn't list any geography data.

Once you have enabled a list of values for an address attribute, you can only select the geography data available for the geography type. This means that if a specific geography value isn't available in the geography hierarchy, you can't create an address with a different geography value.

Tax Validation

You can also specify whether a geography type will be included in tax validation. For example, for the United States North America address style format you specify that County, State, and City are used for tax validation. This will mean that when a transaction involves an address with the North America address style, the address must have the correct county, state, and city combination based on the geography hierarchy data, to be considered valid for tax calculation.

Geography Validation

You must set up geography validation for those geography elements that you plan to use in your sales territories. Setting up validation also helps users fill in missing address information, and validate addresses during entry. For example, you can have users select states or other address elements from lists to ensure accuracy during entry, and you can have the application fill in missing values. For example, when the user enters a Postal Code, the application can retrieve the city and state.

You can specify whether a geography type will be included in geography validation. For example, when the user enters a United States address using the North America address style format, the address must have the correct country, state, and postal code combination based on geography hierarchy data to be considered geographically valid.

If an address element is mapped to a geography type, but not selected for geography validation usage, then during address entry suggested values are provided for the address element, but the address element isn't be validated.

You need to verify that the default mapping between **Geography Type** and **Map to Attribute** is valid in the Geography Mapping and Validation region and update it if required when you define geography validation. Oracle recommends that you use the following valid mapping for the countries that GBG | Loqate supports:

<table>
<thead>
<tr>
<th>Country Name</th>
<th>Country Code</th>
<th>Geography Type</th>
<th>Map to Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>Andorra</td>
<td>AD</td>
<td>- Country</td>
<td>- Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Parroquia</td>
<td>- State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Settlement</td>
<td>- City</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------</td>
<td>-----------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Angola</td>
<td>AO</td>
<td>• Country</td>
<td>• Country Code</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Provincia</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Municipio</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Comuna</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Localidad</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Argentina</td>
<td>AR</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Province</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Department</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Municipality</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Australia</td>
<td>AU</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• State</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Austria</td>
<td>AT</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Bundensland</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Bezirk</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Gemeinde</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Belgium</td>
<td>BE</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Gewest</td>
<td>• Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Provincie</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Gemeente</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Bolivia</td>
<td>BO</td>
<td>• Country</td>
<td>• Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Departamento</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Provincia</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Canton</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Bosnia and Herzegovina</td>
<td>BA</td>
<td>• Country</td>
<td>• Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• District</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Kanton</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Opcine</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Nasalje</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Brazil</td>
<td>BR</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• State</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• City</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------</td>
<td>---------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Bulgaria</td>
<td>BG</td>
<td>Country, Oblast, Obshhina, Settlement, Postal Code</td>
<td>Country, Additional address attribute 1, Province, City, Postal code</td>
</tr>
<tr>
<td>Canada</td>
<td>CA</td>
<td>Country, Province, City, Postal Code</td>
<td>Country, Province, City, Postal code</td>
</tr>
<tr>
<td>Cayman Islands</td>
<td>KY</td>
<td>Country, Island, District, Postal Code</td>
<td>Country, State, City, Postal code</td>
</tr>
<tr>
<td>Chile</td>
<td>CL</td>
<td>Country, Region, Provincia, Kommune, Postal Code</td>
<td>Country, State, County, City, Postal code</td>
</tr>
<tr>
<td>China</td>
<td>CN</td>
<td>Country, Province, City, Postal Code</td>
<td>Country, Province, City, Postal code</td>
</tr>
<tr>
<td>Croatia</td>
<td>HR</td>
<td>Country, Zupanije, Grad, Postal Code</td>
<td>Country, Province, City, Postal code</td>
</tr>
<tr>
<td>Cuba</td>
<td>CU</td>
<td>Country, Provincia, Municipio, City, Postal Code</td>
<td>Country, Province, County, City, Postal code</td>
</tr>
<tr>
<td>Cyprus</td>
<td>CY</td>
<td>Country, Periochi, Dimos, Postal Code</td>
<td>Country, Province, City, Postal code</td>
</tr>
<tr>
<td>Czech Republic</td>
<td>CZ</td>
<td>Country, Kraj, Okres, Obec</td>
<td>Country, State, County, City</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>Denmark</td>
<td>DK</td>
<td>- Country&lt;br&gt; - Amt&lt;br&gt; - Settlement&lt;br&gt; - Postal Code</td>
<td>• Country&lt;br&gt; • Province&lt;br&gt; • City&lt;br&gt; • Postal code</td>
</tr>
<tr>
<td>Dominican Republic</td>
<td>DO</td>
<td>- Country&lt;br&gt; - Provincia&lt;br&gt; - Municipio&lt;br&gt; - Town&lt;br&gt; - Postal Code</td>
<td>• Country&lt;br&gt; • Province&lt;br&gt; • County&lt;br&gt; • City&lt;br&gt; • Postal code</td>
</tr>
<tr>
<td>Ecuador</td>
<td>EC</td>
<td>- Country&lt;br&gt; - Province&lt;br&gt; - Canton&lt;br&gt; - City&lt;br&gt; - Postal Code</td>
<td>• Country&lt;br&gt; • Province&lt;br&gt; • County&lt;br&gt; • City&lt;br&gt; • Postal code</td>
</tr>
<tr>
<td>Estonia</td>
<td>EE</td>
<td>- Country&lt;br&gt; - Maakond&lt;br&gt; - Vald&lt;br&gt; - Postal Code</td>
<td>• Country&lt;br&gt; • State&lt;br&gt; • City&lt;br&gt; • Postal code</td>
</tr>
<tr>
<td>Finland</td>
<td>FI</td>
<td>- Country&lt;br&gt; - Laani&lt;br&gt; - Kunta&lt;br&gt; - Postal Code</td>
<td>• Country&lt;br&gt; • State&lt;br&gt; • City&lt;br&gt; • Postal code</td>
</tr>
<tr>
<td>France</td>
<td>FR</td>
<td>- Country&lt;br&gt; - Region&lt;br&gt; - Department&lt;br&gt; - Commune&lt;br&gt; - Postal Code</td>
<td>• Country&lt;br&gt; • Additional address attribute&lt;br&gt; • State&lt;br&gt; • City&lt;br&gt; • Postal code</td>
</tr>
<tr>
<td>Germany</td>
<td>DE</td>
<td>- Country&lt;br&gt; - Bundesland&lt;br&gt; - Kreis&lt;br&gt; - Gemeinde&lt;br&gt; - Postal Code</td>
<td>• Country&lt;br&gt; • State&lt;br&gt; • County&lt;br&gt; • City&lt;br&gt; • Postal code</td>
</tr>
<tr>
<td>Great Britain</td>
<td>GB</td>
<td>- Country&lt;br&gt; - County&lt;br&gt; - Township&lt;br&gt; - Postal Code</td>
<td>• Country&lt;br&gt; • State&lt;br&gt; • City&lt;br&gt; • Postal code</td>
</tr>
<tr>
<td>Greece</td>
<td>GR</td>
<td>- Country&lt;br&gt; - Periferia&lt;br&gt; - Nomi&lt;br&gt; - Dimotika</td>
<td>• Country&lt;br&gt; • State&lt;br&gt; • County&lt;br&gt; • City</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>----------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Guadalupe</td>
<td>GP</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Commune</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Guam</td>
<td>GU</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• State</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• County</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Municipality</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Village</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Guernsey</td>
<td>GG</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Parishes</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Villages</td>
<td>• Additional address attribute 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Hungary</td>
<td>HU</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Megye</td>
<td>• Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Jaras</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Telepules</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Settlement</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Ireland</td>
<td>IE</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Province</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Post County</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Post Town</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>India</td>
<td>IN</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• State</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Indonesia</td>
<td>ID</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Province</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Regency</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Ireland</td>
<td>IE</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Province</td>
<td>• Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Post County</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Post Town</td>
<td>• City</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>---------------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>Isles of Man</td>
<td>IM</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Locality</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Settlement</td>
<td>• Additional address attribute 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Israel</td>
<td>IL</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• District</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Subdistrict</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Italy</td>
<td>IT</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Regione</td>
<td>• Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Provincia</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Comune</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Jamaica</td>
<td>JM</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Parish</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Settlement</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Japan</td>
<td>JP</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Prefecture</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Jordan</td>
<td>JO</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Muhafazat</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Liwa</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tajma</td>
<td>• Postal code</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td></td>
</tr>
<tr>
<td>Kenya</td>
<td>KE</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• County</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Division</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Settlement</td>
<td>• Additional address attribute 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td></td>
</tr>
<tr>
<td>Latvia</td>
<td>LV</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Rajons</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Pilseta</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Liechtenstein</td>
<td>LI</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Wahlkreis</td>
<td>• Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Gemeinde</td>
<td>• State</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>----------------</td>
<td>------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>District</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Lithuania</td>
<td>LT</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>County</td>
<td>State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Municipality</td>
<td>County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ward</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>LU</td>
<td>District</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Canton</td>
<td>State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Commune</td>
<td>County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Settlement</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Malaysia</td>
<td>MY</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>State</td>
<td>State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>District</td>
<td>County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Subdistrict</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Malta</td>
<td>MT</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Region</td>
<td>State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Local Council</td>
<td>County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Postal code</td>
</tr>
<tr>
<td>Martinique</td>
<td>MQ</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Region</td>
<td>State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Department</td>
<td>County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Commune</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Mexico</td>
<td>MX</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>State</td>
<td>State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Municipality</td>
<td>County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locality</td>
<td>Additional address attribute 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Netherlands</td>
<td>NL</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Province</td>
<td>Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Gemeente</td>
<td>County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Settlement</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>New Zealand</td>
<td>NZ</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Region</td>
<td>State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Town</td>
<td>City</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------</td>
<td>---------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Norway</td>
<td>NO</td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Country</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Fylke</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Kommune</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td></td>
</tr>
<tr>
<td>Oman</td>
<td>OM</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Muhafazah</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• District</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• City</td>
</tr>
<tr>
<td>Peru</td>
<td>PE</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Region</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Provincia</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Distrito</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Poland</td>
<td>PL</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Wojewodztwo</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Powiat</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Gmina</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Portugal</td>
<td>PT</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Distrito</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Concelho</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Settlement</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Puerto Rico</td>
<td>PR</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Commonwealth</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Municipio</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Barrio</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Qatar</td>
<td>QA</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Municipality</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Zone</td>
<td>• City</td>
</tr>
<tr>
<td>Reunion Island</td>
<td>RE</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Region</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Department</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Commune</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Romania</td>
<td>RO</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Regiune</td>
<td>• Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Judet</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Settlement</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Comuna</td>
<td></td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------</td>
<td>----------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Russia</td>
<td>RU</td>
<td>- Postal Code</td>
<td>- City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Country</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Federal_District</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Respublik</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Kray</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Oblast</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td></td>
</tr>
<tr>
<td>San Marino</td>
<td>SM</td>
<td>- Country</td>
<td>- Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Comune</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td></td>
</tr>
<tr>
<td>Singapore</td>
<td>SG</td>
<td>- Country</td>
<td>- Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Region</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- District</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td></td>
</tr>
<tr>
<td>Slovakia</td>
<td>SK</td>
<td>- Country</td>
<td>- Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Kraj</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Okres</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Obec</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td></td>
</tr>
<tr>
<td>Slovenia</td>
<td>SI</td>
<td>- Country</td>
<td>- Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Regija</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Upravna Enota</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Obcina</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Settlement</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td></td>
</tr>
<tr>
<td>South Africa</td>
<td>ZA</td>
<td>- Country</td>
<td>- Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Province</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- District</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Municipality</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Local Municipality</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td></td>
</tr>
<tr>
<td>South Korea</td>
<td>KR</td>
<td>- Country</td>
<td>- Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Jibang</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Siti</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td></td>
</tr>
<tr>
<td>Spain</td>
<td>ES</td>
<td>- Country</td>
<td>- Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Region</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Department</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Commune</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td></td>
</tr>
</tbody>
</table>

Note: The table lists the geographies and corresponding attributes for various countries, with each country having a unique country code.
<table>
<thead>
<tr>
<th>Country Name</th>
<th>Country Code</th>
<th>Geography Type</th>
<th>Map to Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sri Lanka</td>
<td>LK</td>
<td>• Country • Province • District • Divisional Secretariat • Postal Code</td>
<td>• Country • Province • County • City • Postal code</td>
</tr>
<tr>
<td>Swaziland</td>
<td>SZ</td>
<td>• Country • District • Inkhundla • Town • Postal Code</td>
<td>• Country • Province • County • City • Postal code</td>
</tr>
<tr>
<td>Sweden</td>
<td>SE</td>
<td>• Country • Lan • Settlement • Postal Code</td>
<td>• Country • Province • City • Postal code</td>
</tr>
<tr>
<td>Switzerland</td>
<td>CH</td>
<td>• Country • Kanton • Bezirk • Gemeinde • Postal Code</td>
<td>• Country • State • County • City • Postal code</td>
</tr>
<tr>
<td>Taiwan</td>
<td>TW</td>
<td>• Country • County • Town • Postal Code</td>
<td>• Country • State • City • Postal code</td>
</tr>
<tr>
<td>Thailand</td>
<td>TH</td>
<td>• Country • Region • Changwat • Amphoe • Postal Code</td>
<td>• Country • Additional address attribute 1 • State • City • Postal code</td>
</tr>
<tr>
<td>Tunisia</td>
<td>TN</td>
<td>• Country • Governorate • Delegation • Postal Code</td>
<td>• Country • State • City • Postal Code</td>
</tr>
<tr>
<td>Turkey</td>
<td>TR</td>
<td>• Country • Sehir • Ilce • Kasaba • Postal Code</td>
<td>• Country • Province • County • City • Postal code</td>
</tr>
<tr>
<td>United Arab Emirates</td>
<td>AE</td>
<td>• Country • Emirate</td>
<td>• Country • State</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------</td>
<td>-----------------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Area</td>
<td>• Additional address attribute 2</td>
</tr>
<tr>
<td>United States</td>
<td>US</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• State</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• County</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Uruguay</td>
<td>UY</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Departamento</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Vatican City</td>
<td>VA</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Municipal</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Settlement</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Vietnam</td>
<td>VN</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Region</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tihn</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Quan</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Thank Pho</td>
<td>• Postal code</td>
</tr>
</tbody>
</table>

**Note:** For either the tax or geography validation, don't skip more than one consecutive level unless you're certain that the selected geography types can uniquely identify geographies. For example, the United States country structure is: State, County, City, and Postal Code, and you want to select just State and Postal Code for geography or tax validation. However, for the combination of California and 94065, the city can be either Redwood Shores or Redwood City. In this case, you should also select at least the City geography type for geography or tax validation.

**Geography Validation Control**

You can select the geography validation level for a country. Validation will check if the entered address maps to the geography hierarchy data available for the country, and the geography validation control determines whether you can save an address that didn't pass validation during address entry. For example, if the validation level is **Error**, then an address can't be saved if the values don't match the geography hierarchy data.

These are the geography validation levels you can choose:

- **Error** - only completely valid addresses can be saved, with all mandatory address elements entered.
- **No Validation** - all addresses can be saved including incomplete and invalid addresses.

Regardless of the result of validation, the validation process will try to map any address attribute to a geography of the country, and store any mapping it could establish based on the available data. This is called **Geography Name Referencing** and it's executed as part of validation. The result of this referencing is used in several business processes in the application to map an address to a specific geography or zone.
The Geography Dimension value in territories is derived from sell-to addresses of sales accounts. To use geography dimensions in territories, you must validate the geography elements in the addresses, such as state, city, and postal code. You can validate the address by enabling geography validation for each country using the Manage Geographies task. Perform the following in the Manage Geographies task:

- Enable at least one level in the geography hierarchy for geography validation.
- Enable geography validation for all geography levels that you intend to use for territory definition for each country.
- If needed, enable a list of values containing specific geography elements. This will help users search and select appropriate geography values during addresses entry and eliminate all possibilities of wrong address entry.

You can set geography validation control to Error in the Manage Geography Validation page. This ensures that users can only use valid geography elements in addresses.

**Note:** If you have already created addresses before setting up geography validation for a country, you must enable geography validation and then execute the Run Maintain Geography Name Referencing task for that country. This validates all your geography elements.

### Manage Geography Structures, Hierarchies, and Validation

This example shows how you can configure the geography structure, hierarchy, and validation for a country geography, using the United Kingdom country geography as an illustration.

The following table summarizes the key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy an existing country structure?</td>
<td>No, create a new country structure.</td>
</tr>
<tr>
<td>What is the structure of the geography types?</td>
<td>Create geography types with the following ranking structure:</td>
</tr>
<tr>
<td></td>
<td>1. County</td>
</tr>
<tr>
<td></td>
<td>2. Post Town</td>
</tr>
<tr>
<td>What is the geography hierarchy?</td>
<td>Create the following hierarchy:</td>
</tr>
<tr>
<td></td>
<td>1. Country of United Kingdom</td>
</tr>
<tr>
<td></td>
<td>2. County of Berkshire</td>
</tr>
<tr>
<td></td>
<td>3. Post Town of Reading</td>
</tr>
<tr>
<td>Which address style format will you use when mapping geography validations?</td>
<td>The default address style format called the No Styles Format.</td>
</tr>
<tr>
<td>Are you using Oracle Fusion Tax for tax purposes?</td>
<td>No, don’t select Tax Validation for the geography types.</td>
</tr>
</tbody>
</table>
Define the Geography Structure
You can add the County and Post Town geography types to the United Kingdom geography structure.

1. On the Manage Geographies page, enter GB in the Code field. Click Search.
2. On the Manage Geographies page, click Structure Defined.
3. On the Manage Geography Structure page, click the Create button next to the Copy Country Structure From field.
4. In the Geography Structure section, select the County list item in the Add Geography Type field.
5. Click Add.
6. Select the Post Town list item in the Add Geography Type field.
7. Click Add.

Define the Geography Hierarchy
You can add the geographies for the County and Post Town geography types using the geography hierarchy user interfaces to create the geography hierarchy for United Kingdom. You can also use Import Management to import geography hierarchies using a CSV or XML file.

1. On the Manage Geographies page, enter GB in the Code field. Click Search.
2. On the Manage Geographies page, click Hierarchy Defined.
   
   **Note:** If there are many child geographies for the selected parent geography, a message asking you to refine the search criteria is displayed. The child geographies are displayed after you refine the search criteria. If there are many search results, you may have to further refine the search criteria.
3. In the Geography Hierarchy section, click United Kingdom to highlight the table row, and click Create.
4. In the Create County page, Primary and Alternate Names section, enter Berkshire in the Name field.
5. Click Save and Close.
6. In the Geography Hierarchy section, click Berkshire to highlight the table row, and click Create.
7. In the Create Post Town page, Primary and Alternate Names section, enter Reading in the Name field.
8. Click Save and Close.

Define the Geography Validations
You can define the geography mapping and validation for the United Kingdom default address style format to specify the geography validations for the geography types you added to United Kingdom. You can then map the geography types to attributes, enable the geography types for Lists of Values and Geography Validation, and set the geography validation level.

1. On the Manage Geographies page, click Validation Defined.
2. In the Address Style section, click No Styles Format to highlight the table row.
3. For the County geography type, click the County list item in the Map to Attribute field.
4. Select the Enable List of Values and Geography Validation options.
5. For the Post Town geography type, click the City list item in the Map to Attribute field.
6. Select the Geography Validation option.
7. In the Geography Validation Control section, select Error in the Geography Validation Level for Country list.
8. Click Save and Close.
Manage Territory Geography Splits

You must group territory geographies into group zones to manage territory geography level splits. Grouping the territory geographies involves two steps, selecting the geography level based on which you need grouping and initiating the grouping.

Select the Geography Level for Grouping

You can perform these steps to select the geography level based on which you want to create the group zones:

1. Sign in as a set up user such as Application Implementation Consultant.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Enterprise Profile
   - Task: Manage Geographies
3. Search for the country for which you want to enable territory geography level grouping.
5. Select the Subject to Grouping check box corresponding to the geography type level for which you want to enable grouping.

   You must select the geography level that suits your business requirements. For example, if your product delivery is based on postal code, and your territory geographies don't have higher levels of master geographies such as counties and cities, then you may have postal code splits. In this case you must select postal code as the geography type level for grouping.

   Note: You can enable grouping for only one level at a time.

6. Click Save and Close.

Initiate Grouping

Here are the steps to initiate grouping:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Sales
   - Functional Area: Territories
   - Task: Manage Territory Geographies

   The Manage Territory Geographies page opens.

2. Click Initiate Grouping.
3. Click OK in response to the warning message and confirm the process.

   Note: You can’t automatically un-group the grouped territory geographies. You can manually undo the grouping process by recreating territory geography hierarchy either through the UI or import process.
The geography level that you selected for grouping appears as an expandable Group Zone when the grouping is complete is shown in the following figure.

4. Click **Save and Close**.

**How Territory Geographies are Grouped**

This topic describes how we can overcome the problem of territory geography splits by grouping them into group zones.

You do a territory geography grouping when any of your territory geography levels has multiple splits. A territory geography splits occur when the lower level master geographies are added to territory geography hierarchy, while skipping the higher level master geographies. This may cause multiple occurrences of the lower geography level members in a territory geography hierarchy.

For example, postal code split happens when a postal code overlaps across many master geography levels such as cities and counties. Suppose that the business firm Vision Corp. delivers its product according to the postal codes. If counties and cities aren't included in the territory geography hierarchy of Vision Corp., then the end user can see the multiple occurrences of the postal code 97229.

When there is a territory geography level split, and if you want to group the split geographies, first you must specify the master geography level for which you want the grouping to be performed, then initiate grouping. When grouping is performed, all the splits of the selected master geography level get grouped under a new group zone. In the previous example, if you select postal code in the master geographies as the level for grouping and initiate the grouping process, then the 12 postal code splits for the postal code 97229 gets grouped together under one group zone named 97229. So, the Territory Manager user can define territories on a clean list of postal codes or their ranges, although some of those postal codes would in fact be the groupings of the postal code splits. The grouped splits are hidden for the Territory Manager user.

**Best Practices for Managing Geography Mismatches**

This topic employs a couple of use cases to illustrate the best practices for setting up Master Reference Geographies for sales customers using the Oracle Data as a Service (DaaS) for Sales for data enrichment and the Address Verification Cloud Service for address verification.

When you perform the real-time enrichment of accounts or contacts using the Oracle Data as a Service, if there's a geography data mismatch between the predefined master geography data and the Dun and Bradstreet (D&B) data, then the Service enriches the accounts and contacts data but you can't edit or save the enriched data unless the master geography data mismatches are resolved. In addition, you can verify the enriched address using the Address Verification Cloud Service, however, in case of mismatches between Address Verification Cloud Service (GBG | Loqate) and predefined master geography data you can't save the verified address.
The second use case describes the setup required to enable address verification and to avoid data conflicts between the Address Verification Cloud Service and master reference geography data.

**Use Case 1**

You're a sales customer using master reference geographies for territory assignments or tax calculation and have purchased Oracle Data as a Service for data enrichment as well as the Address Verification Cloud Service. In this case, while the GBG | Loqate geography reference data is configured as master geography, Tax calculation is being done using Vertex master geography data. Also, address validation is enabled based on the customer's requirement.

**Best Practice:** Review geography mapping for the countries where you do business. If the geography mapping for a specific country isn't mapped according to the country-specific address attributes, update the mapping. Oracle recommends performing enrichment before verifying address.

Suppose that you're doing real time enrichment of account or contact. If there's a geography data mismatch between the predefined master geography and the D&B data, the Oracle Data as a Service still enriches the accounts and contacts data but can't edit or save the enriched account or contact unless the master geography data mismatches are resolved. However, you can verify the enriched address using the address verification cloud service.

To save a verified address that has master geography data mismatch, you must add alternative names for the mismatched hierarchy elements in master geography. The following are the steps to add alternative name for the mismatched hierarchy element:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Enterprise Profile
   - Task: Manage Geographies

2. On the Manage Geographies page, search for the country by the name or country code, for example US.

3. Click the Go to Task button in the Hierarchy Defined column. The Manage Geographies Hierarchy page for the particular country appears.

   **Note:** If there are many child geographies for the selected parent geography, a message asking you to refine the search criteria is displayed. The child geographies are displayed after you refine the search criteria. If there are many search results, you may have to further refine the search criteria.

4. Highlight the mismatched hierarchy element, for example California State, and click the Edit icon.

5. Click the Add icon on the Edit page.

6. Add an alternative name CA for the California state geography element.

7. Click Save and Close

Once the alternative name is added for the mismatched hierarchy element in master geography, you can save the enriched address.

**Use Case 2**

You're a sales customer who doesn't use geographies for territory assignment or tax calculation and has purchased Oracle Data as a Service for data enrichment and the Address Verification Cloud Service for address verification. To
enable address verification and to avoid data conflicts between the Address Verification Cloud Service and master reference geography data you must do the following setups:

- Deselect the Enable List of Values option in the Geography Mapping and Validation region to avoid Address Verification Cloud Service data conflicts with master reference geography data. By deselecting this option you can avoid any UI level validation against master geographies while adding address.
- Select Geography Validation Level for Country as No validation to verify address data by Address Verification Cloud Service.

Perform the following steps on the Manage Geography Validation page to enable address verification and to avoid data conflicts between the Address Verification Cloud Service and master reference geography data:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Enterprise Profile
   - Task: Manage Geographies
2. On the Manage Geographies page, search for the country by the name or country code, for example US.
3. Click the Go to Task button in the Validation Defined column. The Manage Geography Validation page appears.
4. Deselect the Enable List of Values check boxes for all the geography attributes to avoid any UI level validation against master geographies while entering the addresses. If the Enable List of Values check boxes are selected then, in case of data conflicts, Geography Naming References records aren't created.

Note: If any of the Geography Types listed isn't applicable to the selected country's territory structure, then you must deselect the geography validation for that type.

If you're planning to create territories based on a particular Geography Type, such as County, then you must deselect all the Geography Validation levels under that Geography Type (in this case City and Postal Code) based on which you want to create the territory.

Tip: Review the Address Style Formats that are selected on the Manage Geography Validation page. The review is required because on the Account or Contact Simplified UI page, address attributes are displayed based on the address formats and verified or enriched addresses are saved in Oracle Applications Cloud based on the selected address formats.

Import Geographies and Zones

How You Import Geographies

A geography, such as Tokyo or Peru, describes a boundary on the surface of the earth.

You can use the following options when importing geographies:

- Oracle-licensed geography reference data
- Import Management

Oracle-Licensed Geography Reference Data

You can import Oracle-licensed data from GBG | Loqate, for those countries where the data is available. For more information about the supported countries, see the List of Available Countries with GBG | Loqate Geography Reference Data topic. You can import geography data using the Manage Geographies task. Search for the country, and select
Import Geography Data from the Actions menu. If the licensed data isn't available or already set up for a particular country, then the Import Geography Data action is disabled.

**Note:** GSI (Global Single Instance) customers who either actively implement or who could prospectively implement HCM Cloud for payroll or payroll interface purposes must import Vertex Geography data for the United States and Canada.

**Import Management**

The Import Management process reads the data included in your XML or text file and imports the data into the application.

To access Import Management functionality, go to Navigator > Tools > Import Management

For more information, see the Import Your Geography Data topic in the Related Topics section.

**Related Topics**

- Overview of Implementing Customer Data Management

**List of Available Countries with GBG | Loqate Geography Reference Data**

Oracle Applications Cloud provides third-party GBG | Loqate geography data for import. Here's the list of countries for which the GBG | Loqate geography data is available for import.

<table>
<thead>
<tr>
<th>Country Name</th>
<th>Country Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Andorra</td>
<td>AD</td>
</tr>
<tr>
<td>Angola</td>
<td>AO</td>
</tr>
<tr>
<td>Argentina</td>
<td>AR</td>
</tr>
<tr>
<td>Australia</td>
<td>AU</td>
</tr>
<tr>
<td>Austria</td>
<td>AT</td>
</tr>
<tr>
<td>Belgium</td>
<td>BE</td>
</tr>
<tr>
<td>Bolivia</td>
<td>BO</td>
</tr>
<tr>
<td>Bosnia and Herzegovina</td>
<td>BA</td>
</tr>
<tr>
<td>Brazil</td>
<td>BR</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Bulgaria</td>
<td>BG</td>
</tr>
<tr>
<td>Canada</td>
<td>CA</td>
</tr>
<tr>
<td>Cayman Islands</td>
<td>KY</td>
</tr>
<tr>
<td>Chile</td>
<td>CL</td>
</tr>
<tr>
<td>China</td>
<td>CN</td>
</tr>
<tr>
<td>Croatia</td>
<td>HR</td>
</tr>
<tr>
<td>Cuba</td>
<td>CU</td>
</tr>
<tr>
<td>Cyprus</td>
<td>CY</td>
</tr>
<tr>
<td>Czech Republic</td>
<td>CZ</td>
</tr>
<tr>
<td>Denmark</td>
<td>DK</td>
</tr>
<tr>
<td>Dominican Republic</td>
<td>DO</td>
</tr>
<tr>
<td>Ecuador</td>
<td>EC</td>
</tr>
<tr>
<td>Estonia</td>
<td>EE</td>
</tr>
<tr>
<td>Finland</td>
<td>FI</td>
</tr>
<tr>
<td>France</td>
<td>FR</td>
</tr>
<tr>
<td>Germany</td>
<td>DE</td>
</tr>
<tr>
<td>Great Britain</td>
<td>GB</td>
</tr>
<tr>
<td>Greece</td>
<td>GR</td>
</tr>
<tr>
<td>Guadelupe</td>
<td>GP</td>
</tr>
<tr>
<td>Guam</td>
<td>GU</td>
</tr>
</tbody>
</table>
## Geographies

<table>
<thead>
<tr>
<th>Country Name</th>
<th>Country Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guernsey</td>
<td>GG</td>
</tr>
<tr>
<td>Hungary</td>
<td>HU</td>
</tr>
<tr>
<td>Iceland</td>
<td>IS</td>
</tr>
<tr>
<td>India</td>
<td>IN</td>
</tr>
<tr>
<td>Indonesia</td>
<td>ID</td>
</tr>
<tr>
<td>Ireland</td>
<td>IE</td>
</tr>
<tr>
<td>Isles of Man</td>
<td>IM</td>
</tr>
<tr>
<td>Israel</td>
<td>IL</td>
</tr>
<tr>
<td>Italy</td>
<td>IT</td>
</tr>
<tr>
<td>Jamaica</td>
<td>JM</td>
</tr>
<tr>
<td>Japan</td>
<td>JP</td>
</tr>
<tr>
<td>Jordan</td>
<td>JO</td>
</tr>
<tr>
<td>Kenya</td>
<td>KE</td>
</tr>
<tr>
<td>Latvia</td>
<td>LV</td>
</tr>
<tr>
<td>Liechtenstein</td>
<td>LI</td>
</tr>
<tr>
<td>Lithuania</td>
<td>LT</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>LU</td>
</tr>
<tr>
<td>Malaysia</td>
<td>MY</td>
</tr>
<tr>
<td>Malta</td>
<td>MT</td>
</tr>
<tr>
<td>Martinique</td>
<td>MQ</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Mexico</td>
<td>MX</td>
</tr>
<tr>
<td>Netherlands</td>
<td>NL</td>
</tr>
<tr>
<td>New Zealand</td>
<td>NZ</td>
</tr>
<tr>
<td>Norway</td>
<td>NO</td>
</tr>
<tr>
<td>Oman</td>
<td>OM</td>
</tr>
<tr>
<td>Peru</td>
<td>PE</td>
</tr>
<tr>
<td>Poland</td>
<td>PL</td>
</tr>
<tr>
<td>Portugal</td>
<td>PT</td>
</tr>
<tr>
<td>Puerto Rico</td>
<td>PR</td>
</tr>
<tr>
<td>Qatar</td>
<td>QA</td>
</tr>
<tr>
<td>Reunion Island</td>
<td>RE</td>
</tr>
<tr>
<td>Romania</td>
<td>RO</td>
</tr>
<tr>
<td>Russia</td>
<td>RU</td>
</tr>
<tr>
<td>San Marino</td>
<td>SM</td>
</tr>
<tr>
<td>Singapore</td>
<td>SG</td>
</tr>
<tr>
<td>Slovakia</td>
<td>SK</td>
</tr>
<tr>
<td>Slovenia</td>
<td>SI</td>
</tr>
<tr>
<td>South Africa</td>
<td>ZA</td>
</tr>
<tr>
<td>South Korea</td>
<td>KR</td>
</tr>
<tr>
<td>Spain</td>
<td>ES</td>
</tr>
</tbody>
</table>
Replace Existing Master Geography Data with Revised Oracle-Licensed Geography Data

You must import and set up reference geography data for the countries where you do business. Using the Oracle-licensed geography reference data, you no longer have to source geography data from a third party. You can import Oracle-licensed data from GBG | Loqate, including the country structure and hierarchy information, either to create a new geography setup or replace your existing geography data.

You can use the information in this section to replace existing geography data with GBG | Loqate geography data. You can follow these steps if you’re using Nokia or any other geography data and now want to move to GBG | Loqate geography data.

Before you begin, perform the following steps:

• Backup existing geography data including customizations, if any.

<table>
<thead>
<tr>
<th>Country Name</th>
<th>Country Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sri Lanka</td>
<td>LK</td>
</tr>
<tr>
<td>Swaziland</td>
<td>SZ</td>
</tr>
<tr>
<td>Sweden</td>
<td>SE</td>
</tr>
<tr>
<td>Switzerland</td>
<td>CH</td>
</tr>
<tr>
<td>Taiwan</td>
<td>TW</td>
</tr>
<tr>
<td>Thailand</td>
<td>TH</td>
</tr>
<tr>
<td>Tunisia</td>
<td>TN</td>
</tr>
<tr>
<td>Turkey</td>
<td>TR</td>
</tr>
<tr>
<td>United Arab Emirates</td>
<td>AE</td>
</tr>
<tr>
<td>United States</td>
<td>US</td>
</tr>
<tr>
<td>Uruguay</td>
<td>UY</td>
</tr>
<tr>
<td>Vatican City</td>
<td>VA</td>
</tr>
<tr>
<td>Vietnam</td>
<td>VN</td>
</tr>
</tbody>
</table>
• Backup territory geographies.
• Perform impact analysis by contacting the support team to identify the use of geography IDs downstream.

Note: Before deleting the geography data, make sure that GEOGRAPHY_ID isn’t referenced in any downstream applications such as TAX, FIN, Legal, and so on. Geography data is used across Oracle Cloud applications such as Human Capital Management, TAX, and Legal. Global Single Instance POD users share the same geography data and before deleting geography data, the geography usage POD analysis is required. The Oracle Support team can help you identify the downstream impact.

Create an Export File of All Territories
In case you have implemented Customer Data Management along with the sales functionality, you must export all territories before deleting the master geography data because removing the master geography data invalidates the territory definitions that are based on the Geography dimension. You can either export the definitions of all territories to a file or make manual corrections. If there are a large number of territories, export the territories definition to a file for the territories import process. However, if there are very few affected territories, then you can choose to either export the territories definition to a file or make corrections manually.

This procedure is applicable only if there are territories defined using the Geography dimension.

Perform the following steps to create an export file of all territories.

1. From the Territories and Quotas work area, click View Active Territories in the Tasks pane.
2. In the View Active Territories page, select the territory at the highest level.
3. Click the Actions list, and select Export, and then Export Selected Territory Hierarchy.
4. In the Warning dialog box, click OK.
5. Click the Actions list and select Export, and then View Export Status.
6. Review the status of the export job and verify if it has completed successfully.
7. In the Exported Data File column, click the .zip file against your export job, and click Save. All the territories are exported to a compressed file on your system.
8. Click OK.
9. Click Done in the View Active Territories page.

Delete the Territory Geography Data
A territory definition has references to the territory geography data and master geography data. Territory geography data is based on the master geography data, in case you have implemented Customer Data Management along with the sales functionality, you must delete the territory geography data prior to deleting the master geography data. When you delete the territory geography data, all territories that are defined using geography dimension become invalid.

This procedure is applicable only if territory geographies are defined.

Perform the following steps to delete the territory geography data.

1. In the Setup and Maintenance work area, go to the following:
   • Offering: Sales
   • Functional Area: Territories
   • Task: Manage Territory Geographies
2. On the Manage Territory Geographies page, click View All Hierarchies.
3. Select the highest level node for the country for which you want to replace the master geography data and click the Delete icon.
4. In the Warning dialog box, click OK.
5. In the Confirmation dialog box, click OK. The parent node of the territory geography data and its children are deleted.
6. Repeat steps 3 to 5 to delete all the higher nodes in the territory geography data.
7. Click **Save and Close**.

The Territory Management application retains a copy of the dimension members referenced in the territory definitions. This copy is updated when you trigger the **Load and Activate** process from the **Enable Dimensions and Metrics** task. Therefore, although the territory geography data is deleted, the territory definitions may appear to remain valid.

### Delete the Master Geography Data

Delete the existing geography data one country at a time. Use the **Delete Master Geography Data for the Selected Country** scheduled process to delete master geography data. We recommend that you raise a service request for assistance in deleting the geography data. For more information about the **Delete Master Geography Data for the Selected Country** scheduled process, see the related topics section.

### Delete Geography Structure

If you have created a geography structure, it prevents the geography imports from working or working as desired. For example, if the geography structure exists, the **Import Geography** option may not be enabled for a country in **Manage Geographies** even if GBG | Loqate predefined geography data is available for that country and the geography hierarchy doesn’t exist yet.

**Note:** If any geography hierarchy was created manually, it must be deleted first using the **Delete Master Geography Data for the Selected Country** scheduled process. For more information about the **Delete Master Geography Data for the Selected Country** scheduled process, see the related topics section.

If the geography structure was created manually, you can follow these steps to delete it. However, we recommend that you raise a service request for assistance in deleting the geography structure.

1. In the Setup and Maintenance work area, go to the following:
   - **Offering:** Customer Data Management
   - **Functional Area:** Enterprise Profile
   - **Task:** Manage Geographies
2. On the **Manage Geographies** page, enter either the country name or the two-letter ISO code (for example, US), and click **Search**.
3. Select the country in the search results and click **Actions > Manage Geography Structure**.
4. In the **Manage Geography Structure** page, delete each level of the structure.
5. Click **Save and Close**.

You can now proceed to importing geography data.

**Note:** If other setup or transaction data exists that’s based on the geography data, replacement procedures for that setup must also be followed.

### Import Oracle-Licensed Geography Reference Data

Use this procedure to import GBG | Loqate geography data in **Manage Geographies** one country at a time. If the country data you want isn’t supported by GBG | Loqate geo seed data and point the GBG | Loqate supported country list here, then the **Import Geography Data** action is disabled.

The geography data is provided by GBG | Loqate and is third-party content. As per Oracle policy, this software and documentation may provide access to or information about content and services from third parties. Oracle and its affiliates aren’t responsible for and expressly disclaim all warranties of any kind with respect to third-party content and services. Oracle and its affiliates aren’t responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.
Perform the following steps to import Oracle-licensed geography reference data.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Enterprise Profile
   - Task: Manage Geographies
2. On the Manage Geographies page, enter either the country name or the two-letter ISO code (for example, US), and click Search.
3. Select the country in the search results.
4. Click the Actions list, and select Import Geography Data.
5. In the Warning dialog box, click OK.
6. In the Confirmation dialog box, click OK.

The import of larger countries may require several hours to complete.

You can track the progress of the import process by selecting Scheduled Processes from the Navigator.

Note: To access the Scheduled Processes work area, you must be signed in as a user with the Employee abstract role. The initial user doesn't have this role assigned, but the other users you created do.

After the import is complete, you can search for the country again in the Manage Geographies page. Check marks now appear in the Structure Defined and Hierarchy Defined columns indicating the import completed successfully.

Next, click the Validation Defined icon to define the validations, enable List of Values, and choose address style format for a country as set up before. For more information, see the Geography Validation topic.

The Geocoding Defined and Address Cleansing Defined columns are used for additional features which you must license from Oracle and set up separately.

- Geocoding makes it possible to display customers in the vicinity of a mobile address. You set up Geocoding Enabled for those countries where you're using Around Me functionality in CX Sales Cloud Mobile.
- Cleansing makes it possible to validate addresses down to the street level.

Add any geography customizations.

Run the Geography Name Referencing Process

The Geography Name Referencing (GNR) process validates address elements in location tables, such as HZ_LOCATIONS, against the master geography data.

Perform the following steps to run the GNR process.

1. Navigate to Tools > Scheduled Processes work area.
3. Click the Name list and search for Validate Geographies Against Master Geographies, and then click OK.
4. Click OK in the Schedule New Process dialog box.
5. In the Process Details dialog box, enter the following details:
   - Location Table Name: HZ_LOCATIONS
   - Run Type: ALL
   - Usage Code: GEOGRAPHY
6. Enter the country code in the Country Code field.
7. Click Submit.
8. In the Confirmation dialog box, click OK.
9. Click Close.
10. In the Scheduled Processes page, click the Refresh icon.
11. Verify if the status of the process has completed successfully.

Find the locations failing in Geography Name References using: https://cloudcustomerconnect.oracle.com/posts/b1e16b06ae. Fix Geography Name References failures by updating addresses with the latest geography data.

Recreate and Load the Territory Geography Data

In case you have implemented Customer Data Management along with the sales functionality, you can recreate the territory geography data, after the master geography data is imported, using either of the following methods:

- Import process: If you created the original territory geography data using the import process, then use the same import file to recreate the territory geography structure. For more information about importing the territory geography data using Import Management, see Import Your Sales Territory Data in the Oracle CX Understanding Import and Export Management for CX Sales and B2B Service guide.
- Manual creation process: You can manually recreate the territory geography data structures, as they existed before their deletion, using the Manage Territory Geographies task. For more information about creating zones and adding geographies to a zone, see Managing Territory Geographies in the Related Topics section.

After you have recreated the territory geography data, perform the following steps to load the data.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Sales
   - Functional Area: Territories
   - Task: Enable Dimensions and Metrics
2. On the Enable Dimensions and Metrics page, click the Actions list, and select Load and Activate. The process loads the territory geography data to make dimension members available for selection when defining territories.
3. In the Confirmation dialog box, click OK.
4. Click Done.

Restore the Invalid Territory Definitions

After recreating the territory geography hierarchies and running the Load and Activate option from the Enable Dimensions and Metrics task, the geography dimensions are populated with the new geography members. The geography members in the territory appear as invalid because your territories still reference the old copies of the dimension members that were deleted. The new members aren’t referenced automatically by the territories. You must re-reference the territory definitions from the old geography dimension members to the new ones.

You can restore the invalid territory definitions by either importing the previously created export file or making manual corrections to the territories.

To restore valid territory definitions using territories import:

1. Open the export file you saved in the Creating an Export File of All Territories step. The compressed file contains four CSV files.
2. Open TERR_HEADER.CSV file.
3. Enter REPLACE in the Action column for all territories that are based on geography dimension.
4. Save the file in CSV format and compress it together with three other CSV files.
5. From the Territories and Quotas work area, click View Active Territories in the Tasks pane.
6. Click the Actions list, and select Import to Proposal, and then Import Territories.
7. Select the newly created compressed file and click OK.
8. Click the Actions list and select Import to Proposal, and then View Import Status.
9. Review the status of the export job and verify if it has completed successfully.
10. Click OK.
11. From the Tasks pane, click **Manage Territory Proposals**.
12. In the Manage Territory Proposals page, on the Current Territory Proposals table, search for the proposal with your import file name.
13. Click the import file name to open the territory proposal.
14. Click **Edit Coverage** to verify that the territory definitions are valid.
15. Verify that there are no values listed as invalid in the Selected Dimension Members section.
16. Click **Save and Close**.
17. Click **Activate**. The territory proposal of your import file is activated.

To restore valid territory definitions through manual corrections:

1. From the Territories and Quotas work area, click **Manage Territory Proposals** in the Tasks pane.
2. In the Manage Territory Proposals page, click the **Create** icon.
3. In the Create Territory Proposals dialog box, enter a name and click **Save and View**.
4. In the Territory Proposals page, add all the territories with the Geography dimension value other than the value Any to the proposal.
5. Select a territory and click **Edit Coverage**.
6. In the Edit Coverage page, select **Geography** from the Dimensions list. The invalid dimension members are displayed in the Selected Dimension Members pane.
7. Expand the values in the Available Dimension Members section or search for the member that has the same name as the one marked invalid in the Selected Dimension Members pane.
8. Select one or more new geography dimension members from Available Dimension Members pane and click **Add** icon to the Selected Dimension Members pane.
9. Click the **Remove** icon to remove the invalid members from the Selected Dimension Members pane.
10. Click **Save and Close**.
11. Repeat steps 4 to 10 for all territories that were based on Geography dimension.
12. Click **Activate**. After the activation process is complete, your territory definitions are valid again and are referencing to the new geography data.

Although this method is always applicable, it's most appropriate when you have to restore territory definitions for a smaller number of territories.

To run the batch assignment process for opportunities:

1. From Navigator, click **Scheduled Processes**.
2. In the Schedule Processes page, click **Schedule New Process**.
3. In the Schedule New Process dialog box, search for the **Request Revenue Territory Assignment** process and select it.
4. Click **OK**.
5. In the Process Details dialog box, enter **OpenOpportunitiesByCreationDate** in the View Criteria Name field. This selects all revenue lines belonging to open opportunities that were created in the last 'X' days.
6. Enter **BindOptyCreationDateFrom** followed by the date.
   For example, if BindOptyCreationDateFrom=2014-01-01, then all open opportunities which were created between 1st January 2014 till the current date, are processed.
7. Click **Submit** to schedule the process.
8. In the Confirmation dialog box, make a note of the process identifier for monitoring the process, and click **OK**.
9. Click **Close**.
10. In the Schedule Processes page, click the **Refresh** icon.
11. Review the status of the process job and verify if it has completed successfully.

**Note:** Review a small subset of the open opportunities to confirm that the territory assignment is as expected.
To run the batch assignment process for sales accounts:

1. Ensure that the `ZCA_SA_AUTO_ASSIGN_ON_CREATE` and `ZCA_SA_AUTO_ASSIGN_ON_UPDATE` profile options are set to Yes in the Manage Customer Center Profile Options task.
2. From Navigator, click Customers.
3. In the Customers page, click Create Account.
4. In the Create Account page, enter a name and address of the sales account, and select the Address is sell to check box.
5. Click Save and Close.
6. From Navigator, click Customers.
7. In the Search pane, search for the name of the sales account you created and select it.
8. In the section Customer Information, select Sales Account Team. The details of the sales account and territories associated with the sales account are displayed.

   This indicates that the sales account was created successfully and the batch assignment was run automatically to assign the matching territories to the sales account.

To run the batch assignment process manually from the Scheduled Processes page, perform the following steps.

1. From Navigator, click Scheduled Processes.
2. In the Schedule Processes page, click Schedule New Process.
3. In the Schedule New Process dialog box, search for the Request Account Assignment process and select it.
4. Click OK.
5. Enter `SalesAccount_Work_Object` in the Work Object Code field and `SalesAccountTerritory_Candidate_Object` in the Candidate Object Code field.
6. Select Territory in the Assignment Mode list.
7. Enter `AllSalesAccountsVC` in the View Criteria Name field. This selects all sales accounts.
8. Click Submit to schedule the process.
9. In the Confirmation dialog box, make a note of the process identifier for monitoring the process, and click OK.
10. Click Close.
11. In the Schedule Processes page, click the Refresh icon.
12. Review the status of the process job and verify if it has completed successfully.

   Note: Review a small subset of the accounts to confirm that the territory assignment is as expected.

Verify that the downstream applications using geography data is working fine.

Related Topics

- Manage Territory Geographies
- Delete Master Geography Data for the Selected Country
- Validate Geographies of Addresses Against Master Geographies
- Request Revenue Territory Assignment
- Request Account Assignment

Create Countries

This procedure lists the steps to create countries in the application.

The countries are seeded in the application. If you're unable to find a specific country in the Manage Geographies page, then you can add it to the application.
Note: The application provides support for GBG | Loqate geography data for countries. For countries where GBG | Loqate geography data isn't available, you can purchase the geography data from a third-party data provider and load it into the application using Import Management. For more information, see the Import Your Data chapter in the Oracle CX Understanding Import and Export Management for CX Sales and Service guide. If countries aren't available in the application, then use the procedure outlined in this topic to create them.

Perform the following steps to create a new country.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Application Extensions
   - Task: Manage Territories
2. On the Manage Territories page, click the New icon.
3. Enter the following details:
   - Territory Code: Enter a unique code for the territory.
   - Territory Name: Enter a unique name for the territory.
   - Description: Enter a description for the territory.
4. Click Save and Close.

Note: After you have added a new country in the application, if you want to import the geography data for that country, then you must perform Step 5 to 10.

5. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Enterprise Profile
   - Task: Manage Geographies
7. In the Create Country dialog box, select the name of the country and click Save.
8. Click Done.

Note: You can now import the geography data for the newly created country using GBG | Loqate geography data available in the application. In case geography data for your country isn't available from GBG | Loqate, you can purchase the geography data from a third-party data provider and import it using Import Management.

Import Your Geography Data

You can use Import Management to create or update Geography records.

To import Geography records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.
How You Map Your Source Data to Object Attributes

To import your Geography data into Oracle Applications Cloud, you must populate a .csv file with your source data and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

- Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
- Ensure prerequisite setups are done, if applicable.
- Understand your options for uniquely identifying the records.
- Ensure parent records exist before importing child records.
- Identify the target object attributes that are required in the CSV file for a successful import.

Before You Start

You must do some basic checks before starting your import. For example, make sure that:

- You have completed all the prerequisites for importing each attribute in your source data.
- You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records

To import data into Oracle Applications Cloud, your CSV file must include some specific attributes that enable the import process to uniquely identify the records. The file import process uses the attribute values to automatically map your source data to the target object attributes in Oracle Applications Cloud.

The preferred options to uniquely identify an object record are as follows:

- Internal ID: If you're identifying a record that already exists in Oracle Applications Cloud, then you can use the internal ID of the record, a system-generated unique identifier Attributes with "id" in the attribute name are typically internal IDs. Use this option only if you're updating Geographies. You can determine the internal ID of a record by exporting Oracle Applications Cloud object data, or by doing a transactional database query. Using an internal ID typically provides better performance and reduces the import duration. For the Geography object, the attributes are Batch Id and Interface Row Id.

- Public unique identifiers: If you're creating new records, then you can provide a user-friendly public unique identifier (attributes denoted with 'Number' and usually visible in the business object's UI). If you update a record for which you have previously provided a Number attribute, or for which a Number attribute is visible in the object's UI, you can use the Number attribute to identify the record. For the Geography object, the attribute is Import Activity Identifier.

Required Attributes and Validations for the Geography Object

To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure that you provide valid values for the attributes. The following table lists the required attributes for importing new Geography records, prerequisite setup tasks for the attributes, and specific validations, if any, for Geography import:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task/ Import Validations</th>
<th>Creating a Geography Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>CountryCode</td>
<td>The code of the country to which the geography belongs.</td>
<td>This is validated against the country structure to check if the structure is defined for this country.</td>
<td>Required</td>
</tr>
</tbody>
</table>
Geographies

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task/Import Validations</th>
<th>Creating a Geography Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>PrimaryGeographyName</td>
<td>The primary name of the geography.</td>
<td>This is validated against the country structure to check if the structure is defined for this geography name.</td>
<td>Required</td>
</tr>
<tr>
<td>RecordTypeCode</td>
<td>Specifies the data that needs to be created</td>
<td>No Validation</td>
<td>Required</td>
</tr>
</tbody>
</table>

You can view the Geography object and attributes in the Manage Import Objects page of the Import Management flow. You can find attribute information like type, length, description, and so on, on this page.

You can enable high-volume import for the Geography import object in the Manage Import Objects page.

Create the Source CSV File

You include the data that you want to import into CX Sales and B2B Service in a source CSV file. You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator > Tools > Import Management > Import Objects.
2. Select the Geography object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

**Note:** For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity

After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Geography from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results

Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and unsuccessful imports. To check the status of the import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed. You can drill down on the import activity to go to the Import Status page which provides the status details of the import activity.
Note: Geography names aren’t translatable and are always displayed in the same language in which they were loaded irrespective of the language of the signed in user. If you need different options of display, you can use the alternative names option.

Related Topics
- How File-Based Data Import Works
- Import Data from a File
- File-Based Data Import for CX Sales and B2B Service
- Potential Issues When Opening CSV Files in Excel

Example of Importing Geography Data
This example demonstrates how to import data using Import Management. In this example, you have a source file containing geography data that you want to import into the application to make the geography data available for real time address validation and tax purposes. A geography is any region with a boundary around it, regardless of its size. It might be a state, a country, a city, a county, or a ward.

Summary of the Tasks
You perform the following steps to create an import activity and activate the import:
1. Determine what information is in the source file.
2. Create and schedule the import activity.

Before You Start
1. You use the country structure of a country to define which geography types are part of the country. For more information about an example of importing a country structure, see the topic "Example of Importing Country Structure Data".
2. Ensure that the combination of the Source ID and Parent Source ID values is unique for each row of data within a single import. However, your source data files don't need to have the same Source ID and Parent Source ID values as your previously imported geography data. If the geography structure levels and the parents for each geography value are the same, then the changed IDs will not affect the import.
3. Ensure that all the parents of a child geography are included in your data file so that the child geography can be added. For example, if you originally imported US, CA, and San Francisco, and now you want to import the city of San Jose in CA, then your data file must include US, CA, and San Jose.
4. Check that your source data file has the correct values for the geography data that you have already loaded. For example, if your initial import included the value US for country and CA as state, and in a subsequent import you have California as a state, then your geography import creates two state records (CA and California) in the application data, with the US as the country parent.

Determine the Information in the Source File
The source geography data files must include a unique Source ID value for each row of data and Parent Source ID value for the parent of that row of data. You include the data that you want to import into CX Sales and B2B Service in a source CSV file. A sample input CSV file is shown below.

<table>
<thead>
<tr>
<th>RecordTypeCode</th>
<th>PrimaryGeography</th>
<th>CountryCode</th>
<th>LevelNumber</th>
<th>SourceId</th>
<th>ParentSourceId</th>
<th>LanguageCode</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>United Statues</td>
<td>US</td>
<td>1</td>
<td>1</td>
<td></td>
<td>US</td>
</tr>
</tbody>
</table>
Oracle CX
Implementing Customer Data Management for CX Sales and B2B Service

Chapter 5
Geographies

<table>
<thead>
<tr>
<th>RecordTypeCode</th>
<th>PrimaryGeography</th>
<th>CountryCode</th>
<th>LevelNumber</th>
<th>SourceId</th>
<th>ParentSourceId</th>
<th>LanguageCode</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>California</td>
<td>US</td>
<td>2</td>
<td>11</td>
<td>1</td>
<td>US</td>
</tr>
<tr>
<td>1</td>
<td>San Mateo</td>
<td>US</td>
<td>3</td>
<td>111</td>
<td>11</td>
<td>US</td>
</tr>
<tr>
<td>1</td>
<td>Redwood City</td>
<td>US</td>
<td>4</td>
<td>1111</td>
<td>111</td>
<td>US</td>
</tr>
<tr>
<td>1</td>
<td>94065</td>
<td>US</td>
<td>5</td>
<td>11111</td>
<td>1111</td>
<td>US</td>
</tr>
<tr>
<td>2</td>
<td>United States</td>
<td>US</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>US</td>
</tr>
<tr>
<td>2</td>
<td>California</td>
<td>US</td>
<td>2</td>
<td>11</td>
<td>1</td>
<td>US</td>
</tr>
</tbody>
</table>

Import validation is triggered only when updating the address data. While inserting the address data, validation isn’t triggered even if the same address already exists.

**Note:** Note the following:
- The hierarchy is modeled in the CSV file using the SourceId and ParentSourceId. The ParentSourceId for the Country Record (level Number 1) is always null.
- If defining an alternate name (RecordTypeCode = 2) for the country, ensure that the ParentSourceId is the same as the SourceId for the Country record (RecordTypeCode=0) and the SourceId is a unique number.
- If defining an alternate name (RecordTypeCode = 2) for any level below the country (LevelNumber >1), ensure that the SourceId and ParentSourceId columns match the values for the original record respectively.

You must create a source file (CSV) file with the attributes and import it using import management as shown in this table.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RecordTypeCode</td>
<td>1</td>
<td>The record type code that represents the intent of the import data. The values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0 - indicates the geography that already exists in the base table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1 - indicates the intent to create a new geography.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2 - indicates the intent to add an alternate identifying name or code to an existing geography.</td>
</tr>
<tr>
<td>PrimaryGeographyName</td>
<td>California</td>
<td>This is the primary geography name. This will be marked as the primary name for the Geography and also displayed in the Manage Geographies Page.</td>
</tr>
</tbody>
</table>
You can create an import activity, enter the import details, and schedule the import.

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Geography from the Object drop-down list.
   
   Note: In the Advanced Options section, the option Enable High-Volume Import is selected by default. This mode is designed to import millions of records at once.

4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit.

Import Your Country Structure Data

You can use Import Management to create, update, or delete Country Structure records.

To import Country Structure records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes

To import your Country Structure data into Oracle Applications Cloud, you need to populate a CSV file with your source data and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

- Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
- Ensure prerequisite setups are done, if applicable.
- Understand your options for uniquely identifying the records.
- Ensure parent records exist before importing child records.
- Identify the target object attributes that are required in the CSV file for a successful import.
- Ensure that you don't insert duplicate addresses while importing, to avoid redundant data.

Before You Start

You must do some basic checks before starting your import. For example, make sure that:

- You have completed all the prerequisites for importing each attribute in your source data.
- You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records

All records must be unique in the application. You can use one of these to identify records:

- Public unique identifiers: If you're creating records, then you can provide an easily understandable public unique identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID attributes are usually named <object> Number. If you're updating a record with a Number attribute, then use the Number attribute to identify the record. For more information about public unique identifiers, see the topic "How You Use Alternate Keys to Import Records" in Related Topics section.
- Source system and source system reference: Source system is an identifier for the external system, and source system reference is a unique identifier within the external system. If you're importing new contacts or are updating contacts that have source system reference data, then provide the source system and source system reference values.

Required Attributes and Validations for Country Structure Object

To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure that you provide valid values for the attributes. This table lists the required attributes for importing new Country Structure records, required attributes for updating Country Structure records, required attributes for deleting Country Structure records, prerequisite setup tasks for the attributes, and specific validations, if any, for Country Structure import:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task/Import Validations</th>
<th>Creating a Country Structure Record</th>
<th>Updating a Country Structure Record</th>
<th>Deleting an Existing Country Structure Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>CountryCode</td>
<td>The country code to which the</td>
<td>The GeographyType</td>
<td>Yes</td>
<td>Not updatable</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Create the Source CSV File
You include the data that you want to import into CX Sales and B2B Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator > Tools > Import Management > Import Objects.
2. Select the Country Structure object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

**Note:** For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Country Structure from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review and edit the mappings if required.

---

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task/Import Validations</th>
<th>Creating a Country Structure Record</th>
<th>Updating a Country Structure Record</th>
<th>Deleting an Existing Country Structure Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>GeographyType</td>
<td>The different structure types of a geography for a country such as Region, City, County, and so on.</td>
<td>The country has to be present.</td>
<td>Yes</td>
<td>Optional</td>
<td>Yes</td>
</tr>
<tr>
<td>LevelNumber</td>
<td>The different structural levels of a country.</td>
<td>When defining a country, Level 1 has to be present.</td>
<td>Yes</td>
<td>Optional</td>
<td>Yes</td>
</tr>
</tbody>
</table>
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you’re ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and unsuccessful imports. To check the status of the import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of the import activity.

Related Topics
• How File-Based Data Import Works
• Import Data from a File
• File-Based Data Import for CX Sales and B2B Service
• Potential Issues When Opening CSV Files in Excel
• How You Use Alternate Keys to Import Records

Example of Importing Country Structure Data
You use the country structure of a country to define which geography types are part of the country and how the geography types are hierarchically related within the country. For example, you can create geography types called State, City, and Postal Code. Then you can rank the State geography type as the highest level within the country, the City as the second level, and the Postal Code as the lowest level within the country structure.

To add or update a country structure using import management, your source file must contain information about the country to which the country structure belongs. You also need to specify the level at which the geography types need to be placed. By default, all countries are at Level 1. You create the country structure by increasing the level number as you go down the country structure. You place the geography types such as states, provinces, and so on at Level 2, districts or counties at Level 3, and so on. To add or update a country structure, your source file must include the values that let the import process identify the existing records.

Sample Input CSV File
You include the data that you want to import into CX Sales and B2B Service in a source CSV file. A sample input CSV file is shown below.

<table>
<thead>
<tr>
<th>CountryCode</th>
<th>LevelNumber</th>
<th>GeographyType</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>1</td>
<td>COUNTRY</td>
</tr>
<tr>
<td>US</td>
<td>2</td>
<td>STATE</td>
</tr>
<tr>
<td>US</td>
<td>3</td>
<td>COUNTY</td>
</tr>
<tr>
<td>US</td>
<td>4</td>
<td>CITY</td>
</tr>
</tbody>
</table>
You must create a source file (CSV) file with the attributes and import it using import management as shown in this table.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CountryCode</td>
<td>US</td>
<td>This indicates the Country Code for the country for which you're importing data.</td>
</tr>
<tr>
<td>LevelNumber</td>
<td>2</td>
<td>The level number of the geography in the hierarchy. For example, Country is at Level 1 (Top level) and State (California) is at Level 2.</td>
</tr>
<tr>
<td>GeographyType</td>
<td>COUNTRY</td>
<td>A code used for internal reference at an administrative level. For example, this administrative code may be COUNTRY, STATE, COUNTY, CITY, and so on.</td>
</tr>
</tbody>
</table>

Create an import activity to import the information. To create an import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Country Structure from the Object drop-down list.
   - **Note:** In the Advanced Options section, the option Enable High-Volume Import is selected by default. This mode is designed to import millions of records at once.
4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit.

How You Import and Export Territory Geography Zones

Territory geography zones are geographical boundaries that you can set up to replicate your organization's regions, such as a Pacific Northwest sales region. You can set up territory geography zones in one application instance, and then after the territory geography zones are defined you can export the territory zones and import them into another application instance.

To define your territory geography zones and then import your territory zones into another application instance, you must complete the following steps:

1. Import the master reference geography data into the application.
2. Define your territory geography zones using the Manage Territory Geographies task.
3. Export the territory geography zones.
4. Import the territory geography zones into another application instance.

Import the Master Reference Geography Data
Firstly, you must import the master reference geography data. Master reference geography data includes geography elements, such as country, state, and city, and is required for any geographical information that you store in the application, such as address information used in customer and sales records. For more information, see the topic Geography Hierarchy. Master reference geography data can be imported into the application using the Import Management.

Define Your Territory Geography Zones
After the master reference geography data has been imported, you can then create your territory geography zones in the application using the Manage Territory Geographies task in Setup and Maintenance. For more information, see the Manage Territory Geographies topic in the Related Topics section.

Export the Territory Geography Zones
After you have completed importing the master reference geography data and defining your territory geography zone tasks, you can create a configuration package to export the territory zone data. For more information, refer to the Exporting Setup Data demo listed in the related topics section.

Import the Territory Geography Zones
After you have downloaded your configuration package for your territory geography zone setup, you can import the territory zones into another application instance.

Note: Ensure that you import your master reference geography data into the new application instance before you import the configuration package.

Related Topics
- Manage Territory Geographies

Set Up Geocoding

Geocoding

This topic explains geocoding and how to enable this option in the application.

Geocoding is the process of finding latitude and longitude coordinates from geographic data such as street addresses or postal codes. Once these coordinates are available, you can use the spatial services feature to identify points of interest, such as customer and contact addresses, in the vicinity. The application integrates the Geocoding feature with eLocation (http://elocation.oracle.com/maps_oracle_dot_com_main.html), which is a Geocoding service provided by Oracle.

By default, the Geocoding option is turned off in the application. You can enable the Geocoding option by going to the Setup and Maintenance work area and performing the following:

- Offering: Customer Data Management
- Functional Area: Enterprise Profile
If the Geocoding feature is enabled, the feature can be scheduled to run at regular time intervals. This ensures that newly created or updated locations are picked up and geocoded whenever you create or update an address using the user interface, web services, bulk import, or using import management.

### Set Up Geocoding

This procedure lists the steps to set up geocoding in Oracle Cloud applications.

Geocoding is a process that determines the latitude and longitude coordinates for a location. By default, geocoding is turned off in the application. You can use geocoding to display customers in the vicinity of a mobile address.

### Enable Geocoding for a Country

To enable geocoding for a country, complete these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Enterprise Profile
   - Task: Manage Geographies
2. On the Manage Geographies page, search for the country for which you want to enable geocoding. You can either search by the country name or country code.
3. Click Search. The search results for the matching country names are displayed.
4. Select the country for which you want to enable the geocoding option.
5. Select Geocoding Defined for the country.

### Populate Location Latitude and Longitude Information

Once geocoding is enabled, you can schedule this feature to run at regular time intervals so that newly created or updated locations are picked up and geocoded. To schedule the geocoding feature to run at regular intervals, complete these steps:

1. Navigate to Tools > Scheduled Processes work area.
3. Click the Name list and search for Populate Location Latitude and Longitude Information, and then click OK.
4. Enter the parameters such as Start Date and End Date, and click Submit.

### Use Web Services to Populate Location Attributes for the Around Me Feature

Use this procedure to populate location attributes using Web services for the Around Me feature in countries that aren't supported by the eLocation service. The Around Me feature enables you to quickly locate information about your surroundings. This feature uses your current location to run a proximity search on objects with location information, such as contacts, opportunities, and customers.
Create an Address with the Location Attributes Using the LocationService Web Service

Perform the following steps to create an address with location attributes, such as latitude and longitude, using the createLocation operation.

1. Extract the Web Services URL
   a. Sign in to the Oracle Enterprise Manager Applications Control using the WebLogic Server credentials.
   b. Select Oracle Fusion Customer Relationship Management from the navigation tree, and then select Fusion Applications.
   c. From the tree, select CrmCommonApp, and then select CrmCommonApp (CRMCommonServer_1).
   d. In the Web Services pane, click Test for the LocationServiceSoapHttpPort port.
   e. In the Test Web Service pane, copy the URL of a WSDL that appears in the WSDL field until "?wsdl", and then paste to a notepad.

2. Derive the Payload
   a. Launch the WSDL URL in a Web browser to open the LocationService endpoint page.
   b. In the LocationServiceSoapHttpPort pane, select createLocation from the Operation list.
   c. In the Location pane, complete the fields, as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>CN</td>
</tr>
<tr>
<td>Address1</td>
<td>Chaoyang District</td>
</tr>
<tr>
<td>City</td>
<td>Shanghai</td>
</tr>
<tr>
<td>Postal Code</td>
<td>200233</td>
</tr>
<tr>
<td>State</td>
<td>China</td>
</tr>
<tr>
<td>CreatedByModule</td>
<td>AMS</td>
</tr>
<tr>
<td>Latitude</td>
<td>20.36789</td>
</tr>
<tr>
<td>Longitude</td>
<td>-39.34444</td>
</tr>
</tbody>
</table>

*Note:* Deselect all the other parameters in this Location pane. Also, deselect LocationProfile, OriginalSystemReference, and LocationInformation options.

d. Click the XML Source option.

  *Note:* This option appears next to the Operation list.

e. Copy the XML source and paste to a notepad.
3. Call the Web Service
   a. Open the Oracle Fusion Service Tester page.
   b. In the WebService URL field, paste the WSDL URL that you derived from Step 5 of the Extracting the Web Services URL section.
   c. Enter the user name and password credentials.
   d. In the Payload pane, paste the XML source that you derived from Step 5 of the Deriving the Payload section.
   e. Click Invoke. The Output Payload pane displays the output payload.

4. Test the Web Service
   a. Sign in to the Oracle Fusion Applications Home Page.
   b. Navigate to the Customer Center work area.
   c. Search the address that you added.
   d. Click the Addresses section.
   e. From the Actions list, select the View Geography Information option.
   f. Verify the latitude and longitude details.

Update the Location Attributes of an Address Using the LocationService Web Service

Perform the following steps to update the location attributes of an address, such as latitude and longitude, using the updateLocation operation.

1. Extract the Web Services URL
   a. Sign in to the Oracle Enterprise Manager Applications Control using the WebLogic Server credentials.
   b. Select Oracle Fusion Customer Relationship Management from the navigation tree, and then select Oracle Fusion Applications.
   c. From the tree, select CrmCommonApp, and then select crmCommonApp (CRMCommonServer_1)
   d. In the Web Services pane, click Test for the LocationServiceSoapHttpPort port.
   e. In the Test Web Service pane, copy the URL of a WSDL that appears in the WSDL field until "?wsdl", and then paste to a notepad.

2. Derive the Payload
   a. Launch the WSDL URL in a Web browser to open the LocationService endpoint page.
   b. In the LocationServiceSoapHttpPort pane, select updateLocation from the Operation list.
   c. In the Location pane, complete the fields, as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LocationId</td>
<td>300100078489616</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Enter the location ID that was generated in Step 1 of the Testing the Results section.</td>
</tr>
<tr>
<td>Latitude</td>
<td>30.36789</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Longitude</td>
<td>-40.34444</td>
</tr>
</tbody>
</table>

**Note:** Deselect all the other parameters in this Location pane. Also, deselect LocationProfile, OriginalSystemReference, and LocationInformation options.

d. Click the **XML Source** option.

**Note:** This option appears next to the Operation list.

e. Copy the XML source and paste to a notepad.

3. **Call the Web Service**

a. Open the **Oracle Fusion Service Tester** page.

b. In the WebService URL field, paste the WSDL URL that you derived from Step 5 of the Extracting the Web Services URL section.

c. Enter the user name and password credentials.

d. In the **Payload** pane, paste the XML source that you derived from Step 5 of the Deriving the Payload section.

e. Click **Invoke**. The Output Payload pane displays the output payload.

4. **Test the Web Service**

a. Sign in to the **Oracle Fusion Applications Home** Page.

b. Navigate to the Customer Center work area.

c. Search the address that you updated.

d. Click the **Addresses** section.

e. From the **Actions** list, select the **View Geography Information** option.

f. Verify the latitude and longitude details.

---

## How You Set up Address Cleansing

Address cleansing validates, corrects, and standardizes address information that you enter in the application. Address cleansing, unlike geography validation, validates both the geography attributes and the address line attributes.

To use the address cleansing functionality, you need to have license for the customer data quality application, because the feature is delivered using data quality integration.

You can specify the real-time address cleansing level for each country by choosing either of these options:

- **None**: Specifies no real time address cleansing.
- **Optional**: Provides option to cleanse addresses.

Once you have enabled address cleansing for a country, a **Verify Address** icon appears at address entry points in the application. Click the icon to perform address cleansing and receive a corrected, standardized address. If the application doesn't find a matching address, then an alert message is displayed.
FAQs for GBG | Loqate Support

How to Import Nokia Geography Data

We recommend that you use GBG | Loqate geography data. However, if you need to use Nokia data for one or more countries for business reasons you can do so.

By default, Import Geography Data task invokes GBG | Loqate geography data.

**Note:** Oracle doesn't support any Nokia geography data fixes.

Perform these steps to import Nokia geography data:

1. Set the profile value of the ORA_HZ_ENABLE_DAAS_LOQATE profile option to No in the Setup and Maintenance work area by going to the following:
   - Offering: Sales
   - Functional Area: Sales Foundation
   - Task: Manage Administrator Profile Values

2. Import the Nokia geography data for a country as follows:
   a. Navigate to the Manage Geographies task in the Setup and Maintenance work area by going to the following:
      - Offering: Sales
      - Functional Area: Sales Foundation
      - Task: Manage Geographies
   b. On the Actions menu, Click Import Geography Data for a country.

   **Note:** The Import Geography Data action is disabled for a country if the geography data for that country isn't available from GBG | Loqate or if the country data is already imported using either GBG | Loqate, Nokia, or any third party geography data.

After the geography data is loaded, the data provider name (GBG | Loqate or Nokia) is displayed in the Hierarchy Defined section in Manage Geographies.

How many countries does GBG | Loqate support?

GBG | Loqate supports 82 countries. Any additional country support beyond the 82 must be logged as an enhancement request. To log the enhancement request, go to Idea Lab.

**Related Topics**
- Idea Lab
Will I be charged for GBG | Loqate data?

There’s no charge or licensing requirement for GBG | Loqate geography data.

I am an existing customer, how will I be impacted? Can I import both GBG | Loqate and Nokia geography data?

No. You can import either GBG | Loqate or Nokia geography data, but you can’t import from both providers for a single country. We recommend that you use GBG | Loqate geography data because GBG | Loqate supports 82 countries including existing 62 Nokia supported countries.

If you’re already using Nokia geography data, you can select one of these two options:

- **Option 1:** You need not do anything and continue to use Nokia geography data. Oracle doesn’t support any Nokia geography data fixes.
- **Option 2:** You can replace Nokia geography data with GBG | Loqate geography data. This is a manual process today. You must follow manual steps and work closely with the support team to import new GBG | Loqate geography data. For more information about this process, see Replace Existing Master Geography Data with Revised Oracle-Licensed Geography Data section in this chapter.

How often are updates to Oracle licensed geography reference data available? How will I be informed about new countries that are supported by Oracle-licensed geography reference data?

The geography data is updated on a quarterly basis but the update of the latest geography data refresh isn’t automated. You will be informed about the geography data refresh using release readiness documents.

How is the Geography Data updated? Are updates available for all countries at the same time or only some countries are updated at a time?

When you import the geography data for a country after Release 18C for the first time you would get the latest GBG | Loqate geography data. But if your GBG | Loqate geography data is more than three months old, you have to uptake the latest GBG | Loqate geography data by following Replace Existing Master Geography Data with Revised Oracle-Licensed Geography Data section in this chapter.
Can I import Vertex or other third-party geography data in Manage Geographies?

Yes, you can continue to import geography data of your choice. Oracle provides support for GBG | Loqate geography data out of the box.

Can I import geography data for multiple countries in one import job?

No. You can submit only one import job for a country. After submitting the import job, you can search for a different country and submit another import job for that country. Currently, you can only search and import GBG | Loqate data for one country at a time using the Manage Geographies task in Setup and Maintenance menu.

FAQs for Define Geographies

How You Search Geographies in the Language You Prefer

You must first define the profile option Filter Geographies Using User Language (HZ_GEO_FILTER_BY_USER_LANG) and specify the language you want to use.

1. Create the profile option as follows:
   a. Click Navigator > Setup and Maintenance > Search and search for Manage Profile Options.
   b. Click Create new profile option icon and enter the following:
      - Profile Option Code: HZ_GEO_FILTER_BY_USER_LANG
      - Profile Display Name: Filter Geographies Using User Language
      - Application: Trading Community Model
      - Module: Trading Community Model
      - Description: provide the description
      - Start Date: specify a date
   c. Click Save and close.
   d. In Profile Option Levels table, select Enabled and Updateable for the site level.
   e. Click Save and Close.

2. Set the default value for the profile option as follows:
   a. Click Navigator > Setup and Maintenance > Search and search for Manage Administrator Profile Values.
   b. Search HZ_GEO_FILTER_BY_USER_LANG as the profile option code.
   c. Add new Site level profile value.
   d. Specify the new profile in the following format:
Where Geography Level values start with value 1 for country and increment for each level that's defined in the country's geography structure setup.

For example, below are geography levels for United States:

Country - 1, State - 2, County - 3, City - 4, Postal Code - 5

Example 1: If you want to filter data for Canadian Cities, then the profile value is CA:3 where CA is the country code for Canada and 3 is geography level value for City.

Example 2: If you want to filter data for both State and Cities for United States, then value should be US:2,4

Example 3: If you want to filter data for multiple countries as given in both example 1 and example 2, then use semi colon as delimiter, like CA:3;US:2,4

e. Click Save and Close.

When do I define address cleansing?

When address data entered into the application must conform to a particular format, to achieve consistency in the representation of addresses. For example, making sure that the incoming data is stored following the correct postal address format.

Why can't I update a geography structure by copying an existing country structure?

You can only update a geography structure by adding existing geography types, or by creating new geography types and then adding them to the geography structure. You can only copy an existing country structure when you're defining a new country structure.

How many levels in a geography structure can I define?

We recommend that you add up to six levels, starting with country at level 1, while defining geography structures. If you add more than six levels containing list of values or validations, then the sixth level and above may not work as expected in the Address UI of accounts, contacts, suppliers, persons, and so on.

Why can't I delete a level of the country geography structure?

If a geography exists for a country geography structure level then you can't delete the level. For example, if a state geography has been created for the United States country geography structure, then the State level can't be deleted in the country geography structure.
Can I add any geography to the geography hierarchy?
Yes. However, the geography type for the geography that you want to add must be already added to the country geography structure.

Can I edit a specific geography in the geography hierarchy?
Yes. In the Manage Geography Hierarchy page you can edit details such as the geography’s date range, primary and alternate names and codes, and parent geographies.

Can I add alternative names and codes for an existing country?
Yes. You can add alternative names and codes. Click Actions > Add on the Edit Country page.

How can I add a geography that's at a lower level to any geography in a geography hierarchy?
Select the geography that you want to create a geography at lower level, and then click the Create icon. This lets you create a geography for a geography type that’s one level lower to the geography type you selected. The structure of the country’s geography types are defined in the Manage Geography Structure page.

How can I verify whether the third-party geography structure and hierarchy I imported are available in the application?
You can track the progress of the geography structure and hierarchy import process by navigating to the Scheduled Processes page and viewing the status of the third-party geography data import process. Once the process completes, the status changes to Succeeded. You can then verify the newly imported geography structure and hierarchy in the Setup and Maintenance work area by navigating to the following: offering: Customer Data Management; functional area: Enterprise Profile; task: Manage Geographies, where you first loaded the third-party geography data.

**Note:** Before you load geography data for a country from a third party provider, ensure that no geography structure or hierarchy is saved for that country. If geography structure or hierarchy data is already available, the load process fails.

How can I enable geocoding?
You can enable geocoding for a country by turning the Geocoding option for that country in the Setup and Maintenance work area by going to the following: offering: Customer Data Management; functional area: Enterprise Profile; task: Manage Geographies. Search for the country for which you want to enable geocoding and click the Geocoding Defined icon. If geocoding is enabled for a country, the Geocoding Defined icon displays a check mark.
Once you have enabled geocoding for a country, you must run the Run Geocode Generation ESS job on the Run Geocode Generation task. Before you run the job, however, ensure that you have specified the country code of the country for which you want to generate the geocodes.

Where can I view the geocode values of a location?

You can search for and view the geocode values of a party's location in the Party Center and the Customer Center pages. Navigate to the Addresses section of the party's profile and click either View, Columns, Latitude and View, Columns, Longitude, or View, Columns, Manage Columns, Latitude and Longitude. This displays the latitude and longitude, or geocode values, associated with the location of the party.

Note: Geocode information display is available only when geocoding is enabled for the country to which the address belongs.

What are Spatial Services?

Spatial services allow users to find points of interest such as customers, contacts, and so on using the latitude and longitude coordinates of an address.

The Oracle Fusion Mobile Sales application provides these services for sales representatives to discover accounts and contacts around their location.

Where can I update and view the geography name reference information for parties?

To view the geography name reference information associated with parties, you need to ensure that you have created an address for the party. You can create or update party addresses in the Organizations, Persons, and Groups work areas.

Once you have updated an address, you must either wait for the Run Geocode Generation ESS job to run automatically as scheduled or start geocode generation manually from the Setup and Maintenance work area by navigating as follows: offering: Customer Data Management; functional area: Enterprise Profile; task: Run Geocode Generation.

Once the Run Geocode Generation job has updated the geography information for the country associated with the party you updated, you can search for and view the geography name reference information associated with the party in the Organizations, Persons, and Groups work areas. Navigate to the person, organization, or group whose address you want to verify and click Actions, View Geography Information. This displays a dialog box that displays the updated geography information, complete with address values enhanced using geography name reference.

Note: Geography name reference enriched geography information display is available only when geography validation is enabled for the country to which the address belongs.

How can I save an address that didn't pass geography validation?

Search and select for the country name in the Manage Geographies page, and then click the Validation Defined option. In the Manage Geography Validation page, select No Validation in the Geography Validation Level for Country drop-
down list. This option saves addresses that don't pass the geography validation, including incomplete and invalid addresses.
How You Protect Personally Identifiable Information

The data or information that's used to uniquely identify a contact, or locate a person is called personally identifiable information (PII), such as social security number, addresses, bank account numbers, phone numbers, and so on. This information is considered confidential and sensitive, and must be protected to prevent unauthorized use of personal information for the purposes of legal regulation, financial liability, and personal reputation. For example, only authorized users must be allowed access to the social security numbers of people stored in a system.

In Oracle Applications Cloud, the PII data is secured and can be accessed only by the following job roles with the exception of mobile phone data:

- Sales Administrator
- Enterprise Scheduler Job Application Identity for CRM
- Oracle Data Integrator Application Identity for CRM
- Web Services Application Identity for CRM

Mobile phone data is accessible to all seeded job roles. However, if access to mobile phone data is needed for custom job roles, the IT Security Manager must assign the required PII data policies to the custom job role in the Security Console. The IT Security Manager can also add data policies for other PII data to seeded job roles.

The following table lists the PII attributes that are secured in Oracle Applications Cloud.

<table>
<thead>
<tr>
<th>PII Attribute</th>
<th>Table Name</th>
<th>Privilege Title</th>
<th>Privilege Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taxpayer Identification Number (Social Security Number)</td>
<td>HZ_PERSON_PROFILES</td>
<td>View Trading Community Person Social Security</td>
<td>HZ VIEW TRADING COMMUNITY PERSON SOCIAL SECURITY DATA</td>
</tr>
<tr>
<td>Taxpayer Identification Number (Social Security Number)</td>
<td>HZ_PERSON_PROFILES</td>
<td>Manage Trading Community Person Social Security</td>
<td>HZ MANAGE TRADING COMMUNITY PERSON SOCIAL SECURITY DATA</td>
</tr>
<tr>
<td>Citizenship Number</td>
<td>HZ_CITIZENSHIP</td>
<td>View Trading Community Person Citizenship Number</td>
<td>HZ VIEW TRADING COMMUNITY PERSON CITIZENSHIP NUMBER DATA</td>
</tr>
<tr>
<td>Citizenship Number</td>
<td>HZ_CITIZENSHIP</td>
<td>Manage Trading Community Person Citizenship Number</td>
<td>HZ MANAGE TRADING COMMUNITY PERSON CITIZENSHIP NUMBER DATA</td>
</tr>
<tr>
<td>Home Address</td>
<td>HOME Address is identified by party site use defined in</td>
<td>View Trading Community Person Address</td>
<td>HZ VIEW TRADING COMMUNITY PERSON ADDRESS DATA</td>
</tr>
<tr>
<td>PII Attribute</td>
<td>Table Name</td>
<td>Privilege Title</td>
<td>Privilege Name</td>
</tr>
<tr>
<td>--------------</td>
<td>------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td>SITE_USE_TYPE field of the HZ_PARTY_SITE_USES table</td>
<td>Manage Trading Community Person Address</td>
<td>HZ MANAGE TRADING COMMUNITY PERSON ADDRESS DATA</td>
</tr>
<tr>
<td>Home Address</td>
<td>HOME Address is identified by party site use defined in SITE_USE_TYPE field of the HZ_PARTY_SITE_USES table</td>
<td>View Trading Community Person Contact</td>
<td>HZ VIEW TRADING COMMUNITY PERSON CONTACT DATA</td>
</tr>
<tr>
<td>Home Phone</td>
<td>HZ_CONTACT_POINTS rows with contact_point_purpose value PERSONAL</td>
<td>Manage Trading Community Person Contact</td>
<td>HZ MANAGE TRADING COMMUNITY PERSON CONTACT DATA</td>
</tr>
<tr>
<td>Home Phone</td>
<td>HZ_CONTACT_POINTS rows with contact_point_purpose value PERSONAL</td>
<td>Manage Trading Community Person Contact</td>
<td>HZ MANAGE TRADING COMMUNITY PERSON CONTACT DATA</td>
</tr>
<tr>
<td>Mobile Phone</td>
<td>HZ_CONTACT_POINTS rows with phone_type or phone_line_type value MOBILE</td>
<td>View Trading Community Person Mobile Phone Number</td>
<td>HZ VIEW TRADING COMMUNITY PERSON MOBILE PHONE DATA</td>
</tr>
<tr>
<td>Mobile Phone</td>
<td>HZ_CONTACT_POINTS rows with phone_type or phone_line_type value MOBILE</td>
<td>Manage Trading Community Person Mobile Phone Number</td>
<td>HZ MANAGE TRADING COMMUNITY PERSON MOBILE PHONE DATA</td>
</tr>
<tr>
<td>Home Email</td>
<td>HZ_CONTACT_POINTS rows with contact_point_purpose value PERSONAL</td>
<td>View Trading Community Person Contact</td>
<td>HZ VIEW TRADING COMMUNITY PERSON CONTACT DATA</td>
</tr>
<tr>
<td>Home Email</td>
<td>HZ_CONTACT_POINTS rows with contact_point_purpose value PERSONAL</td>
<td>Manage Trading Community Person Contact</td>
<td>HZ MANAGE TRADING COMMUNITY PERSON CONTACT DATA</td>
</tr>
<tr>
<td>Additional Identifiers</td>
<td>All rows that belong to PERSON party in HZ_ADDTNL_PARTY_IDS</td>
<td>View Trading Community Person Additional Identifier</td>
<td>HZ VIEW TRADING COMMUNITY PERSON ADDITIONAL IDENTIFIER DATA</td>
</tr>
<tr>
<td>Additional Identifiers</td>
<td>All rows that belong to PERSON party in HZ_ADDTNL_PARTY_IDS</td>
<td>Manage Trading Community Person Additional Identifier</td>
<td>HZ MANAGE TRADING COMMUNITY PERSON ADDITIONAL IDENTIFIER DATA</td>
</tr>
</tbody>
</table>
How You Work with Protected Information

In Oracle Cloud applications, your access to protected information depends on your job role. In case you don’t have access to the information you need to work with, contact the IT security manager for the necessary privileges.

Securing and protecting customer information against data breaches, data theft, or unauthorized access is an increasing concern in any enterprise. To address this issue, Oracle Applications Cloud provides restricted access to information that’s considered private to an individual, also known as Personally Identifiable Information (PII).

PII is any information that uniquely identifies an individual, such as personal phone number, personal email address, personal address, citizenship number, or Social Security Number (SSN). You can use PII data to uniquely identify, contact, or locate an individual, or you can use it with other sources to uniquely identify a person. For example, a SSN uniquely and directly identifies an individual, whereas a telephone area code identifies a set of people.

The attributes that are identified as PII are as follows:

- Home Address
- Home Phone Number
- Personal Email Address
- Taxpayer Identification Number (Social Security Number)

In Oracle Applications Cloud, access to the PII data is restricted to a set of job roles. If you need to work with PII data for business purposes, then contact the IT security manager for the necessary privileges.

Related Topics

- Export Data

Manage Personally Identifiable Information

As a setup user, you can manage PII information in Oracle Applications Cloud.

In this example, you will add or update personally identifiable information (PII) data for your contacts. Before you can add or update the PII data, you must expose the PII attributes from Application Composer in an active sandbox.

Activate a Sandbox

1. Sign in as a setup user such as Sales Administrator.
2. From the Administration group in the Settings and Actions menu, select Manage Sandboxes.
3. Click Actions and then click New.
4. Enter a name in the Sandbox Name field.
5. Click Save and Close.
6. In the Confirmation dialog box, click OK.
7. In the Manage Sandboxes dialog box, select the sandbox you just created and click the Set as Active button.
Expose PII Attributes from Application Composer

The Taxpayer Identification Number and Home Phone PII attributes can be exposed from the Application Composer.

1. Navigate to Application Composer.
2. From the Objects View, select Standard Objects, Contact, and then Pages. Ensure Simplified Pages is selected.
3. To add the Taxpayer Identification Number and Home Phone PII attributes to the Create Contact page:
   a. In the Create Contact section, select Standard Layout and click the Edit icon.
   b. In the Create Contact region, click the Edit icon.
   c. Move the Taxpayer Identification Number and Home Phone PII attributes from the Available Fields list to the Selected Fields list to add to the Create Contact page.
   d. Click Save and Close.
   e. Click Done.
4. To add the Taxpayer Identification Number and Home Phone PII attributes to the Edit Contact page:
   a. In the Edit Contact section, select Standard Layout and click the Edit icon.
   b. Click the Profile tab to add the custom field.
   c. In the Summary region, click the Edit icon.
   d. Move the Taxpayer Identification Number and Home Phone PII attributes from the Available Fields list to the Selected Fields list to add to the Edit Contact page.
   e. Click Save and Close.
   f. Click Done.

Add and Update PII Data

1. Navigate to Contacts.
2. In the Contacts page, enter the name of the contact and click the Search icon.
3. In the Edit Contact page of the contact, click the Profile tab.
4. Enter the PII data such as the Taxpayer Identification Number and Home Phone, and click Save and Close.
5. In the Contacts page, click the Create Contact button.

| Note: You can proceed to create a contact or click Cancel to exit without saving. |

Publish the Sandbox

You can publish a sandbox after you have tested and verified that the modifications done in that sandbox are ready to be moved to the mainline metadata.

1. Select a sandbox link that appears on the page and click the More link.
2. In the Sandbox Details dialog box, click the Publish button.
3. Click Yes in the Publish confirmation message box.
4. Close the Manage Sandboxes dialog box.
5. From the Settings and Actions menu, click Sign Out.
Assign PII Privileges Using Security Console

As an IT Security Manager, you can create a custom job role and assign data policies required to access PII information. Perform the following steps to create a custom role and assign PII privileges to the custom role.

In this example, as an IT Security Manager, you will create a custom job role based on the existing Sales Representative role and assign PII privileges to access the Social Security data. After this, you must assign the custom job role to the users you want to assign PII privileges. For more information on assigning job roles to users, see the Oracle CX Securing CX Sales and B2B Service guide.

Assign Job Roles

1. From the Navigator, click Tools - Security Console.
2. On the Security Console, ensure that Expand Toward is set to Privileges.
3. Enter sales representative in the Search field and select the Job Role in the results.
4. In the Search Results, click the actions button and select Copy Role.
5. In the Copy Options window, select Copy top role and click Copy Role. The Copy Role page is displayed.
6. In the Basic Information page, enter the Role name and Role Code such as Sales Representative Custom PII and ZBS_SALES_REPRESENTATIVE_JOB_CUSTOM_PII.
7. Click Next.
8. Click Next.
9. In the Data Security Policies page, you must create four data security policies with the details provided in the following table. To create a data security policy, click Create Data Security Policy.

<table>
<thead>
<tr>
<th>Policy Name</th>
<th>Database Resource</th>
<th>Data Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grant on Trading Community Party.</td>
<td>Trading Community Party.</td>
<td>Select All Values from the Data Set list. In the Actions list, select View Trading Community Person Social Security.</td>
</tr>
<tr>
<td>This lets you view and read all Social Security information.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grant on Trading Community Party.</td>
<td>Trading Community Party.</td>
<td>Select All Values from the Data Set list. In the Actions list, select Manage Trading Community Person Social Security.</td>
</tr>
<tr>
<td>This lets you manage all Social Security information.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** You don’t have to create separate data security policies for View and Manage Trading Community Person Social Security privileges. You can create one data security policy for these two privileges or all PII privileges. You can’t combine these two PII privileges and add them to data security policies that were created for other privileges. You must create PII privileges as separate data security policies.

10. Click Next.
11. Click Next.
12. Click Next.
13. In the Summary and Impact Report page, click **Save and Close**.
7 Source Systems

How You Set up Source Systems

This topic explains source systems and how to set up a source system.

You can set up source systems to help users to identify the source of the import data. You can specify whether the source system is a spoke system, such as a legacy system, or a purchased system, such as data from a third party provider. You can also specify what types of entities the source system contains. For example, you can specify that a source system contains customer data.

You can configure the following for a source system:

- Source system code, name, and description
- Source system type
- Enable for Items, Trading Community Members, Order Orchestration and Planning, and Assets

Source System Code, Name, and Description

You can create a source system code to uniquely identify the source system. Source system codes are used by the application to create references between source IDs and the application database IDs.

| Note: Ensure you update the source system code before you create the source system.

Source System Type

You must set up a source system as either a spoke system or a purchased system.

Enable for Items, Trading Community Members, Order Orchestration and Planning, and Assets

You can select one or more of the following entity types to import from the source system into the application database:

- Items
- Trading Community Members
- Order Orchestration and Planning
- Assets

You must enable the correct entity types because each import UI filters source systems based on their entity type. For example, if you set up a source system for Trading Community Members, Items, and Assets, then the source system can be selected as a data source only in this UI and not in different UI.

Source System Entities

Source system entities are entities that you can import using a specified source system, such as addresses and parties.
When you import data from a source system, all the entities in the source system data are also imported. You can select multiple source references in the Manage Source System Entities task to allow multiple source system records to map to a single record.

Define Source System Confidence

A source system confidence level is used as criteria in survivorship rules for comparing information from different source systems. You can set the source confidence score per source system for attributes in the Person and Organization objects.

To define a source system confidence:

1. In the Setup and Maintenance work area, navigate to the following:
   - Offering: Customer Data Management
   - Functional Area: Customer Hub
   - Task: Manage Source System Confidence
2. From the Actions menu, click New.
3. On the Define Source System Confidence page, click the Object Type list and select an object type.
4. Select and move the attributes for which you want to set the source system confidence scores from the Available Attributes list to the Selected Attributes list.
5. Click the New icon to define the source confidence score for different systems.
6. Select a source system code from the Source System Code list.
7. Enter a value in the Source Confidence field. The value of the source system confidence can range from 0 to 100.
8. Click Save and Close.
9. On the Manage Source System Confidence page, click the Search button. The attribute for which you set the source system confidence appears along with the corresponding source system and their source confidence values.
10. Click Save and Close.

Related Topics
- Source System Confidence Levels

Manage Source System Confidence Levels

Source system confidence levels indicate the reliability of a particular source system for specific attributes. You can add and delete source system confidence levels in the Manage Source System Confidence page.

To add a source system:

1. Navigate to the Manage Source System Confidence page from Setup and Maintenance.
2. Click New in the Actions menu.
3. In the Define Source System Confidence page, select the object type for which you want to define source system confidence levels.
4. Select the attributes for which you want to define source system confidence level.
5. In the Source System Code table, select the source system code that you want to associate with the selected attributes.

6. Enter the confidence level for the source system. This confidence level is applied to selected attributes in the source system.

You can similarly associate other source systems with the attributes you selected and specify new confidence levels as required.

FAQs for Define Source Systems

What happens if I allow multiple source system references?

When you import data from a source system, you can merge multiple or duplicate source system records and create one record in the application. This is referred to as allowing multiple source system reference. If you don't allow multiple source system references, then for every source system record, a duplicate record is created in the application.
8 Party Usages

How You Define Party Usage

Party usages describe how a party is used by the implementing organization. For example, a person in the business community may be a consumer or contact. You can create rules to determine how a party usage can be associated with party.

You can define the following types of rules for a party usage:

- Assignment rules
- Exclusivity rules
- Incompatibility rules
- Transition rules

Assignment rules

Assignment rules define how the party usage can and can't be assigned to parties. You can allow unconditional party usage assignment, enable the assignment to be created manually, or be updated by an administrator.

Alternatively, you can also restrict the manual assignment and update of a party usage, which means that the party usage can only be created or updated by a business event. For example, the Customer party usage is assigned to a party when you create an account for the party.

You can also specify whether the party usage assignment can be created or updated when a relationship is assigned to a party. For example, when a contact has a relationship with an organization the party usage Organization Contact is assigned to the contact.

Exclusivity rules

Exclusivity rules restrict party usage assignment, so that the party usage can be assigned to a party only during a specified time period. For example, you can set up an exclusivity rule that the party usage Manufacturer can be assigned to parties only between January 1, 2011 and February 1, 2011.

Incompatibility rules

Incompatibility rules specify which party usages can't be assigned concurrently to a party during a specific time period. For example, an incompatibility rule can specify that the party usage Sales Account usage can't be assigned to a party with a Sales Prospect usage, during January 1, 2011 and December 31, 2030.

Transition rules

Transition rules specify which party usages can transition to the party usage you're creating or editing. Once a party transitions to the current party usage, the previous party usage is set with an end date. For example, when a party with the Prospective Partner party usage is assigned the Partner party usage, the Prospective Partner usage is set with an end date.
Manage Party Usages

Party Usages describe how parties can be used across the application in business flows. Use this procedure to create and edit party usages.

Create Party Usages

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Party Usages
2. Click Actions > Create.
3. Specify the following information in the Overview section of the page:
   - Specify the code for the party usage. You can't change the code of an existing party usage.
   - Specify a name.
   - Select the type of party usage.
   - (Optional) Provide a description.
4. Specify the following information in the Assignment section of the page:
   - If you have identified business events that can create an assignment to a party, select Restrict Manual Assignment.
   - If the bulk import or manual assignment can create an assignment, select Unconditional Assignment.
   - If you want to restrict only business events that you identified to update an assignment to a party, select Restrict Manual Update.
   - Select Relationship Causes Assignment to allow an assignment to a party if a party relationship is created.
   - (Optional) Provide descriptions.
5. In the Exclusivity Rules section, specify the from and to dates during which the party usage is assigned exclusively.
6. In the Incompatibility Rules section, select the party usages which can't be assigned along with the selected party usage. For example, you can specify for a prospect party usage that a party couldn't have a prospect usage and customer usage at the same time. You can also specify the time period during which the selected party usages can't be assigned.
7. In the Transition Rules section, specify the party usage which the selected party usage transitions to. You can also specify the time period when the transition starts and, optionally, ends. For example, when a party that currently has the applicant party usage is assigned the student party usage, the applicant usage is set with an end date.
8. Click Save and Close.
Edit Party Usages

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Party Usages

2. Click Actions > Edit.

3. Change the following information in the Overview section of the page:
   - Edit the name.
   - Edit the description as needed.

4. Select or clear the selection for the following information in the Assignment section of the page:
   - If you have identified business events that can create an assignment to a party, select Restrict Manual Assignment.
   - If the bulk import or manual assignment can create an assignment, select Unconditional Assignment.
   - If you want to restrict only business events that you identified to update an assignment to a party, select Restrict Manual Update.
   - Select Relationship Causes Assignment to allow an assignment to a party if a party relationship is created.
   - Edit or provide the descriptions.

5. Add or update from and to dates during which the party usage is assigned exclusively in the Exclusivity Rules section. Or, change or delete the existing dates.

6. Modify the party usages which can't be assigned along with the selected party usage in the Incompatibility Rules section. For example, you can specify for a prospect party usage that a party couldn't have a prospect usage and customer usage at the same time. You can also specify the time period during which the selected party usages can't be assigned. Or, change or delete the existing rules.

7. In the Transition Rules section, update the party usage which the selected party usage transitions to. You can also specify the time period when the transition starts and, optionally, ends. For example, when a party that currently has the applicant party usage is assigned the student party usage, the applicant usage is set with an end date. Or, change or delete existing transition rules.

8. Click Save and Close.

Party Usage Filter Rules

Party usage filter rule is a grouping of party usages and is used to search and filter parties in the user interface. In a party usage filter rule, you can specify the party usages to include and exclude in the rule. You can also specify if the party usage assignments should be active or inactive.

For example, an Eligible Customers filter rule can include the Sales Prospect party usage, Sales Account, Legal Entity, and Customer party usages. The Eligible Customers filter rule can then be used in the user interface to view only eligible customers from the list of parties.

**Note:** You must compile a new filter rule before you can use it in the user interface.
Manage Party Usage Filter Rules

Party usage filter rules are a grouping of related party usages and are used within the application to filter parties. Use this procedure to create and edit party usage filter rules.

Create Party Usage Filter Rules

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Party Usage Filter Rule

2. Click **Actions > Create**.

3. Specify the following information in the Overview section of the page:
   - Specify the code for the party usage filter rule.
   - Specify a name.
   - Provide a description.

4. In the Inclusion Rules section, select the active or inactive party usage assignments you want to be included. For example, a party usage filter rule called contacts would include the active assignments for the customer contact party usage, and the sales contact party usage.

5. In the Exclusion Rules section, select the active or inactive party usage assignments you want to be excluded. For example, a party usage filter rule for external parties would exclude the employee party usage active assignments. You can also specify party usage codes for soft exclusion.

6. Click **Save and Close**.

Edit Party Usage Filter Rules

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Party Usage Filter Rule

2. Click **Actions > Edit**.

3. Edit the following information, as required, in the Overview section of the page:
   - Change the name of the Party Usage Filter Rule.
   - Modify the description of the Party Usage Filter Rule.

4. In the Inclusion Rules section, update the active or inactive party usage assignments you want to be included. For example, a party usage filter rule called contacts would include the active assignments for the customer contact party usage, and the sales contact party usage. Or, change the Selection Criteria field of existing inclusion rules. You can also delete inclusion rules that are no longer valid.

5. In the Exclusion Rules section, update the active or inactive party usage assignments you want to be excluded. For example, a party usage filter rule for external parties would exclude the employee party usage active
assignments. You can also specify party usage codes for soft exclusion. Or, change the Selection Criteria field of existing exclusion rules. You can also delete exclusion rules that are no longer valid.

6. Specify or modify the effective date, the date from which the party usage filter rule must come into effect.
7. Click Run Tests to find out the number of parties that match the party usage filter rule.
8. Click **Save and Close**.

**FAQs for Define Party Usages**

**How can I compile a party usage filter rule?**

In the Party Usage Filter Rule page click **Actions** in the header section, and then click **Compile Filter Rule**.
9 Names and Identifiers

Additional Name Types

Define additional name types to capture alternative names for parties. For example, create an additional name type, NICK_NAME, to capture the nicknames of parties of the Person type.

While creating an additional name type, specify the party type to which it applies. Then, the additional name type is available as a naming option for all parties of that party type within the deploying company. You can use additional name types to capture language-specific names as well.

Manage Additional Name Types

Use this procedure to create and edit additional name types.

Create Additional Names

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Additional Name Types
2. Click Actions > Create.
3. Specify or change the following fields:
   a. Select the Party Type, such as Person, which can have this additional name type.
   b. Type a short name for the additional name type, for example MAIDEN. This name type must be unique.
   c. Specify a descriptive name such as Maiden Name in the Additional Name field.
   d. (Optional) Specify a description for the additional name, for example, A Health Level Seven International name type for maiden name.
   e. Specify if this name is unique with the type. Define whether you can add multiple entries of the name type to a party. For example, select No to allow multiple nick names to be added to a person.
4. Click Save and Close.

Edit Additional Names

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Additional Name Types
2. Search and select the additional name type that you want to edit. For example, you could try editing the MAIDEN additional name type that you created just now.
3. Click Actions > Edit.
4. Edit the following fields as required:
   - Additional Name
   - Description
5. Click Save and Close.

Identifier Types

You can create additional identifier types to provide extensions to party attributes. For example, you can create an additional identifier type to record a person’s passport number.

You can select which party types can use the additional identifier type. These party types can be account or contact, or both. You can also specify whether the value of an identifier type must be unique. For example, the passport number listed under each person’s profile must be unique.

Additional identifier types don’t automatically appear in the UI. To use identifier types in the application, you must call the Trading Community Member Name and Identifier Setup web service.

Manage Identifier Types

Use this procedure to create and edit additional identifier types.

Create Additional Identifier Types

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Additional Identifier Types
2. Click Actions > Create.
3. Specify the following fields:
   - Select the Party Type, such as Organization, which can have this additional identifier type.
   - Type a short name for the additional identifier type, for example INDUSTRIAL_REFERENCE. This short name is used by the application to reference the additional identifier type and must be unique.
   - Specify a descriptive name such as Industrial Reference in the Additional Identifier field.
   - (Optional) Specify a description for the additional identifier type, for example, Industrial Reference Number.
   - Specify if this name is unique. Define whether you can add multiple entries of the identifier type to a party. For example, select No to allow multiple visa numbers to be added to a person.
4. Click Save and Close.
Edit Additional Identifier Types

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Additional Identifier Types

2. Click **Actions > Edit**.

3. Edit the following fields as required:
   - Additional Identifier: Specify a descriptive name such as Industrial Reference.
   - Description: Specify a description for the additional identifier type, for example, Industrial Reference Number.

4. Click **Save and Close**.
10 Relationships

Relationships Types

A relationship type categorizes relationship phrases and roles that determine the nature and purpose of a relationship. A relationship type defines the aspects of a relationship, such as the roles of the subject and object, business rules, and phrases that describe the relationship. A relationship uses the relationship type to define how a party is related to another party. You can manage relationship types from the Manage Relationship Types task.

The components of a relationship type are:

- Relationship phrase pair and role pair
- Relationship characteristics

Relationship Phrase Pair and Role Pair

A relationship type contains a relationship phrase pair and a role pair. These pairs define the mutual roles that the two parties play in a relationship, as shown in the following table.

<table>
<thead>
<tr>
<th>Pair</th>
<th>Purpose</th>
<th>Direction of Relationship Matters</th>
<th>Example for Employment Relationship Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role Pair</td>
<td>Describes the roles of the entities.</td>
<td>No</td>
<td>Employee and Employer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For example, Bill has the role of an employee, and Oracle has the role of an employer.</td>
</tr>
<tr>
<td>Relationship Phrase Pair</td>
<td>Describes the roles of the entities in the relationship.</td>
<td>Yes</td>
<td>Employee of and Employer of.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For example, Bill is employee of Oracle.</td>
</tr>
</tbody>
</table>

Relationship Characteristics

Relationship types include rules that define how you can use the relationship type.

When defining a relationship type, you can define the relationship to be one of the following:

- Circular
- Related to self

The following table explains these characteristics.
### Relationship Characteristic

<table>
<thead>
<tr>
<th>Relationship Characteristic</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circular</td>
<td>The relationships between two parties forms a loop.</td>
<td>A competitor relationship type links two organization parties. In this scenario, ABC Corp is a competitor of XYZ Corp, and XYZ Corp is also a competitor of ABC Corp.</td>
</tr>
<tr>
<td>Related to self</td>
<td>The subject and the object of the relationship are the same.</td>
<td>A subsidiary relationship type links a subsidiary organization ABC to a parent organization XYZ. The parent organization XYZ, in turn, is linked to itself as a subsidiary using the same relationship type.</td>
</tr>
</tbody>
</table>

### Relationship Groups

Relationship groups categorize relationship phrase and role pairs for functional purpose. For example, you can assign the relationship phrase Subsidiary Of to a group, and assign the phrase Headquarters Of to a different group.

### Uses of Relationship Groups

Relationship groups are used to determine which relationship roles and phrases are displayed in specific user interfaces of the Oracle applications. A relationship group can correspond to one or more Oracle Applications user interfaces. For example, you can configure an Oracle application to display only the relationship types that pertain to the Party Contacts information.

### Manage Relationship Types

### Create Relationship Types

You create a relationship type to define the aspects of a relationship, such as the roles of the subject and object, business rules, and phrases that describe the relationship.

In this example, you will create a relationship type, and add relationship roles and phrases to the relationship type. The following table lists the key decisions you must consider before creating a relationship.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>What are the subject and object party types for the relationship?</td>
<td>The subject type and object type is organization.</td>
</tr>
<tr>
<td>Is the relationship circular?</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Decisions to Consider | In This Example
--- | ---
Can the subject related to self in this relationship? | No

You must search for the relationship type to make sure it doesn't already exist, before you create a relationship type.

Search for a relationship type

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Relationship Types

2. On the Manage Relationship Types page, in the Search region, complete the fields, as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationship Type</td>
<td>Equals</td>
<td>Supplier</td>
</tr>
<tr>
<td>Subject Type</td>
<td>Equals</td>
<td>Organization</td>
</tr>
<tr>
<td>Object Type</td>
<td>Equals</td>
<td>Organization</td>
</tr>
</tbody>
</table>

3. Click **Search**.

Review the search results to ensure that there is no existing relationship types for the criteria.

Create a relationship type

1. In the Search Results region, click the **Create** icon to open the Create Relationship Type page.
2. On the Create Relationship Type page, in the Overview region, enter Supplier in the **Relationship Type** field.
3. Select the **Circular** check box.
4. In the Relationship Roles and Phrases region, click the **Create** icon to open the Create Relationship Role and Phrase Pair dialog box. When you create a relationship with a relationship phrase or role, the reverse direction is automatically created with the other phrase or role in the pair.
5. Complete the fields, in the Create Relationship Role and Phrase Pair dialog box, as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject Type</td>
<td>Organization</td>
</tr>
<tr>
<td>Subject Phrase</td>
<td>Supplier of</td>
</tr>
<tr>
<td>Subject Role Singular</td>
<td>Supplier</td>
</tr>
</tbody>
</table>
Edit Relationship Types

You can manage relationship types from the Manage Relationship Types task. You update a relationship type, by adding relationship roles and phrases to the relationship type, or assigning the relationship to a group.

In this example, you will add a role and phrase pair to the relationship type Employment. You will also add the Employment relationship type to the Party Contacts group.

Edit a relationship type

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Relationship Types
2. On the Manage Relationship Types page, in the Search region, enter Employment in the Relationship Type field.
3. Click Search.
4. In the Search Results region, select the Employment relationship type and Edit icon to open the Edit Relationship Type page.
5. On the Edit Relationship Type page, in the Relationship Roles and Phrases region, click the Create icon.
6. In the Create Relationship Role and Phrase Pair, complete the fields, as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject Type</td>
<td>Organization</td>
</tr>
<tr>
<td>Subject Phrase</td>
<td>Has contract employees</td>
</tr>
<tr>
<td>Subject Role Singular</td>
<td>Contractor</td>
</tr>
</tbody>
</table>
Manage Relationship Groups

Manage Relationship Groups

Relationship groups are used to categorize relationship roles and phrases, based on the user interfaces that they appear in.

In this example, you will create a group for relationship types that link an organization to an external organization.

Create a relationship group

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Relationship Groups

2. On the Manage Relationship Groups page, in the Search Results region, click the Create icon to open the Create Relationship Group page.

3. Complete the fields, as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Related External Organizations</td>
</tr>
<tr>
<td>Code</td>
<td>REL_EXT_ORGS</td>
</tr>
</tbody>
</table>

7. Click OK.
8. In the Relationship Groups region, click the Add Row icon.
9. In the Name list, select Party Contacts.
10. Click Save and Close.
4. In the Relationship Roles and Phrases region, click the Add Row icon to add a relationship role and phrase pair.
5. For each relationship role and phrase pair, complete the fields, as shown in the following table.

<table>
<thead>
<tr>
<th>Subject Type</th>
<th>Subject Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>Supplier</td>
</tr>
<tr>
<td>Organization</td>
<td>Competitor</td>
</tr>
</tbody>
</table>

6. Click Save and Close.

**Edit Relationship Group**

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Relationship Groups
2. On the Manage Relationship Groups page, in the Search Results region, select a relationship group.
3. Modify the required values.
4. Click Save and Close.
11 Classifications

Classification Components

The classifications model provides a flexible tool to categorize entities such as parties, projects, tasks, and orders. Classifications enable you to classify an entity, such as a party, the way it’s referenced within your organization.

The major components of classifications are:

- Classification categories
- Classification rules
- Classification codes
- Classification code hierarchy
- Entity assignment

Classification Categories

Classification categories provide the ability to classify entities under a broad subject area. For example, you can classify organizations based on the industries in which they operate. Classification categories are a logical grouping of one or more classification codes that define classification code rules.

Classification Rules

Classification categories can have rules that define how classifications are assigned to entities. When you set up classification categories, you can create specific rules. For example, allowing the parent classification code to be assigned to a party, and allowing multiple classification codes to be assigned to an entity.

Classification Codes

The individual values within the classification category are called classification codes. For example, the 1987 SIC classification category has a classification code of software that you can assign to a party in the software industry. You can organize classification codes into a hierarchical tree. The parent classification code appears as the highest level node of the tree and child classification codes branches off from the parent code or other classification codes.

Classification Code Hierarchy

You can create hierarchies of classification codes within a classification category. For example, you can set up IT as the classification category with hardware, keyboards, and printers as the classification codes. Then, you can set up hardware as the parent classification code at the highest level on the tree, with keyboards and printers as the child classification codes. You can create additional child classification codes, such as dot matrix, ink-jet, and laser under the printer classification code.

How You Manage Classification Codes and Classification Code Hierarchy

You can use the Manage Classification Categories task to create or update classification codes and to modify classification hierarchy.
Note: We recommend that you don't use the Manage Trees and Tree Versions or Manage Standard Lookups tasks to update the classification information. This may result in invalid classification data. Classification based trees would have only one tree version with Active status. Using the Manage Trees and Tree Versions could result in tree to be in Draft status. And this would prevent it from being used correctly by applications like Territory Management. Therefore, you must use Manage Classification Categories for managing classifications hierarchy.

FAQs for Define Classifications

What happens if I allow parent code assignment?
You can assign the parent classification code and its child classification codes to an object. The parent classification code is the highest level of the classification code tree.
If you don't allow parent classification codes to be assigned to an object, then you can only assign child classification codes, or codes that are under another classification code, to an object.

How can I delete classification codes?
You can delete classification codes using the Manage Classification Categories task. We recommend that you don't delete the classification categories using the Manage Standard Lookups task.

What happens if I allow multiple class code assignment?
You can assign more than one classification code from the classification category to an object.
If you don't allow multiple classification codes to be assigned to an object, then you can assign only one classification code from the classification category to an object.

Can I update an existing entity assignment rule?
No. You can delete the entity assignment rule and create a new one.

Why can't I see some classification information in Customer Center?
Customer Center displays the classification and classification group information of a customer in the Classifications node. All classifications are categorized under classification categories. For example, the 1987 SIC classification category has a classification code of software that you can assign to a party in the software industry.
Customer Center displays the classification information based on the classification categories configured in the Manage Classification Group task. You must configure all classification categories, and their codes, that you want to use in the task so that they can be displayed in the Customer Center. For example, you have imported a customer with a
classification code that belongs to the category Major Industry Codes. However, if you don't add the classification category Major Industry Codes in the Manage Classification Group page then the classification code isn't displayed in the Customer Center.
12 Data Formats

Data Styles and Data Formats

Data Formats help you define address formats and name formats within your organization, and assign them to specific geographies. The application uses these formats to capture and validate party name and address information.

You must set up geography data, in addition to the address formats, to use geography-based validations for addresses.

Data Styles

You can define new styles for name and address to categorize a name and address style formats. A Data Style, such as Mailing Address or Concatenated Name, categorizes name and address style formats. The application uses Data Styles to identify a particular manner or situation for which an entity is formatted. For example, you can configure the application to display only certain name and address styles in the user interface.

Data Formats

You use Data Formats to ensure party address and party name data quality. The address formats are used to present the address elements in the country specific formatting, and help users during address entry. This also specifies the scope of address validation. Address formats are linked to the geographic data for address verification, at the data-import level. For example, when creating or editing an address for a party, selecting a country displays the address format for that country.

The use of Name formats ensures that name components are stored in a decomposed manner. You can use Name formats to construct name representations from components in a variety of different styles. You can also store phonetic names that are required for certain geographies.

Data Formats simplify the storage of party address and party name, by storing them as components. You can use formats to validate addresses and name data, after setting up address and name format for a geography.

Types of Data Formats

Data Formats determine how names and addresses are displayed in the application.

There are two types of data formats.

- Address format: Address formats specify the layout of an address, such as the components in the address and their position in the layout. For example, an address format for US postal address can include address, city, state, and postal code in that order.

- Name format: Name formats specify how a name is displayed in the application, based on the usage, language, and country. A name format includes name elements, their position, and formatting. You can create a name style format for either an organization name or a person name.
Name and address formats vary depending on usage, country, and language. You can create name formats and address formats, modify them, and assign them to specific locales. This lets you create data formats for various countries, languages, and usages.

Additionally, you can create variations of the formats, with each variation having its own layout. For example, an address format may have variations such as general address, rural address, and military address.

Create an Address Style Format

This example shows how to create an address style format for a specified address style.

To create an address style format:

- Specify the address style format and address style
- Create the format variation layout
- Assign a locale

In this example, we will create an address style to format Canadian postal addresses.

Create the Address Style Format Name and Specify the Address Style

To create an address style format and specify the address style:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Address Formats
2. On the Manage Address Formats page, click Create from the actions menu.
3. On the Create Address Style Format page, complete the fields in the Overview section, as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>CA_POSTAL_ADDR</td>
</tr>
<tr>
<td>Name</td>
<td>Canadian Postal Address Format</td>
</tr>
<tr>
<td>Address Style</td>
<td>Postal Address</td>
</tr>
<tr>
<td>Default</td>
<td>No</td>
</tr>
</tbody>
</table>

4. Click Save.
Create the Format Variation Layout

To create a format variation layout:

1. In the Format section on the Create Address Style Format page, click the Format Layout tab.
2. In the Format Variation section, select Add from the Actions menu.
3. Enter a variation rank in the Variation field.

**Note:** You can't change the Variation Number. If you're specifying Create and Edit address forms, always use variation value as 1 irrespective of rank. If you're specifying Read Only formatted address (either single line or more than one line), always use variation with lower rank value.

4. In the Format Variation Layout section, select Add from the Action menu.
5. Complete the fields as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>1</td>
</tr>
<tr>
<td>Position</td>
<td>1</td>
</tr>
<tr>
<td>Prompt</td>
<td>Address line 1</td>
</tr>
<tr>
<td>Address Element</td>
<td>Address line 1</td>
</tr>
<tr>
<td>Required</td>
<td>Yes</td>
</tr>
<tr>
<td>Uppercase</td>
<td>No</td>
</tr>
</tbody>
</table>

6. Create another address line as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>2</td>
</tr>
<tr>
<td>Position</td>
<td>2</td>
</tr>
<tr>
<td>Prompt</td>
<td>City</td>
</tr>
<tr>
<td>Address Element</td>
<td>City</td>
</tr>
<tr>
<td>Required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
7. Click Expand on the City address line, then enter the value 1 in Blank Lines Before.
8. You can create as many address lines as you require. Click Expand if you want to enter blank lines and delimiters before, or after, an address line. In this section, you can also use the Attribute Transform Function to specify how the country attribute value must be displayed. The Attribute Transform Function supports two functions:
   - hz_format_pub.get_tl_territory_name(COUNTRY)
   - hz_format_pub.get_neu_country_code(COUNTRY)

These functions are used only in display formats or read-only formats where the address data is formatted in a single field. Examples for such formats are overview pages and multiple addresses section in a list. Let's look at these functions in detail:
   - hz_format_pub.get_tl_territory_name(COUNTRY): Converts a country code of a country into its name. For example, MX is converted to Mexico. The country is displayed in the language that's set in the user profile. If the profile value of the ORA_HZ_INCLUDE_REGIONAL_COUNTRY profile option is set to yes and the country name set in the user profile is the same as the country attribute value, then the country name is displayed. If the profile value of the ORA_HZ_INCLUDE_REGIONAL_COUNTRY profile option is set to no and the country name set in the user profile is the same as the country attribute value, the country name isn't displayed. To change the profile value, navigate to the following in the Setup and Maintenance work area:
     - Offering: Sales
     - Functional Area: Sales Foundation
     - Task: Manage Administrator Profile Values
   - hz_format_pub.get_neu_country_code(COUNTRY): Converts a country code for North European countries into a code that's placed before the postal code in a formatted address. For example, for France F is placed before the postal code. B is used for Belgium, D for Germany, and so on.

   **Note:** For more information about territory codes and their prefix for North European postal codes, see Seeded Address Formats for Countries topic.

   **Note:** While creating a new address style format, make sure that the transform function is present for each component as in predefined address style formats. The transform function may impact translation.

### Assign a Locale

To assign an address style format to a locale:

1. In the Format section on the Create Address Style Format page, click the **Locale Assignment** tab.
2. Select **New** from the Actions menu.
3. Select the country for the address style format. You can assign multiple countries to the format.
Update Address Formats

This procedure lists the steps to update address formats.

Address formats specify the layout of an address, such as the components in the address and their position in the layout. For example, an address format for Canada postal address can include Address, City, Province, Postal Code, and Country in that order.

To update an address format, complete these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Address Formats

   The Manage Address Formats page opens.

2. Select the country whose address format you want to update. For example, select Canada to update its address format.

3. Click Search to display the address formats for the country.

4. Select the address format you want to update to display the Edit Address Style Format page.

5. Click Edit to view the page in edit mode.

   You can update the address components in the Format region.

6. To update the address components, expand the address component to view options for each address component.

   **Note:** The sell-to address for accounts isn't displayed if it contains only the country information. To display the sell-to address with only the country information, you must remove the Attribute Transform Function for the Country address component. To remove the function, delete the entry in the Attribute Transform Function field for the Country address component.

7. Click Save and Close.

Seeded Address Formats for Countries

The following table lists the countries for which seeded address formats are available.

This table contains the style format codes, territory codes, and attribute codes for these countries. The geographical attribute codes vary for each country.

<table>
<thead>
<tr>
<th>TERRITORY_SHORT_NAME</th>
<th>STYLE_FORMAT_CODE</th>
<th>TERRITORY_CODE</th>
<th>ATTRIBUTE_CODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argentina</td>
<td>POSTAL_ADDR_AR</td>
<td>AR</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------</td>
<td>---------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Australia</td>
<td>POSTAL_ADDR_AU</td>
<td>AU</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STATE</td>
</tr>
<tr>
<td>Austria</td>
<td>POSTAL_ADDR_AT</td>
<td>AT</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Belgium</td>
<td>POSTAL_ADDR_BE</td>
<td>BE</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Brazil</td>
<td>POSTAL_ADDR_BR</td>
<td>BR</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STATE</td>
</tr>
<tr>
<td>Canada</td>
<td>POSTAL_ADDR_CA</td>
<td>CA</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PROVINCE</td>
</tr>
<tr>
<td>Chile</td>
<td>POSTAL_ADDR_CL</td>
<td>CL</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>China</td>
<td>POSTAL_ADDR_CN</td>
<td>CN</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDR_ELEMENT_ATTRIBUTE2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------</td>
<td>---------------</td>
<td>-----------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PROVINCE</td>
</tr>
<tr>
<td>Colombia</td>
<td>POSTAL_ADDR_CO</td>
<td>CO</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STATE</td>
</tr>
<tr>
<td>Cuba</td>
<td>POSTAL_ADDR_CU</td>
<td>CU</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PROVINCE</td>
</tr>
<tr>
<td>Estonia</td>
<td>POSTAL_ADDR_EE</td>
<td>EE</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STATE</td>
</tr>
<tr>
<td>Finland</td>
<td>POSTAL_ADDR_N_EUR</td>
<td>FI</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>France</td>
<td>POSTAL_ADDR_FR</td>
<td>FR</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Germany</td>
<td>POSTAL_ADDR_DE</td>
<td>DE</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>POSTAL_ADDR_HK</td>
<td>HK</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STATE</td>
</tr>
<tr>
<td>Hungary</td>
<td>POSTAL_ADDR_HU</td>
<td>HU</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>India</td>
<td>POSTAL_ADDR_IN</td>
<td>IN</td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Ireland</td>
<td>POSTAL_ADDR_IE</td>
<td>IE</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STATE</td>
</tr>
<tr>
<td>Italy</td>
<td>POSTAL_ADDR_IT</td>
<td>IT</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------</td>
<td>----------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Japan</td>
<td>POSTAL_ADDR_JP</td>
<td>JP</td>
<td>распространенность провинции</td>
</tr>
<tr>
<td>Korea, Democratic People's Republic of</td>
<td>POSTAL_ADDR_KP</td>
<td>KP</td>
<td>распространение адреса1</td>
</tr>
<tr>
<td>Korea, Republic of</td>
<td>POSTAL_ADDR_KR</td>
<td>KR</td>
<td>распространение адреса2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Province Name</th>
<th>Style Format Code</th>
<th>Territory Code</th>
<th>Attribute Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Japan</td>
<td>POSTAL_ADDR_JP</td>
<td>JP</td>
<td>распространенность провинции</td>
</tr>
<tr>
<td>Korea, Democratic People's Republic of</td>
<td>POSTAL_ADDR_KP</td>
<td>KP</td>
<td>распространение адреса1</td>
</tr>
<tr>
<td>Korea, Republic of</td>
<td>POSTAL_ADDR_KR</td>
<td>KR</td>
<td>распространение адреса2</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>POSTAL_ADDR_N_EUR</td>
<td>LU</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, CITY, COUNTRY, POSTAL_CODE</td>
</tr>
<tr>
<td>Malaysia</td>
<td>POSTAL_ADDR_MY</td>
<td>MY</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, CITY, COUNTRY, POSTAL_CODE, STATE</td>
</tr>
<tr>
<td>Mexico</td>
<td>POSTAL_ADDR_MX</td>
<td>MX</td>
<td>ADDRESS1, ADDRESS2, ADDR_ELEMENT_ATTRIBUTE2, ADDR_ELEMENT_ATTRIBUTE3, CITY, COUNTRY, POSTAL_CODE, STATE</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Netherlands</td>
<td>POSTAL_ADDR_NL</td>
<td>NL</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, CITY, COUNTRY, POSTAL_CODE</td>
</tr>
<tr>
<td>New Zealand</td>
<td>POSTAL_ADDR_NZ</td>
<td>NZ</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, CITY, COUNTRY, POSTAL_CODE</td>
</tr>
<tr>
<td>Norway</td>
<td>POSTAL_ADDR_N_EUR</td>
<td>NO</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, CITY, COUNTRY, POSTAL_CODE</td>
</tr>
<tr>
<td>Poland</td>
<td>POSTAL_ADDR_EUR</td>
<td>PL</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, CITY, COUNTRY</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Romania</td>
<td>POSTAL_ADDR_N_EUR</td>
<td>RO</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, CITY, COUNTRY, POSTAL_CODE</td>
</tr>
<tr>
<td>Saudi Arabia</td>
<td>POSTAL_ADDR_SA</td>
<td>SA</td>
<td>ADDRESS1, ADDRESS2, CITY, COUNTRY, POSTAL_CODE</td>
</tr>
<tr>
<td>Singapore</td>
<td>POSTAL_ADDR_SG</td>
<td>SG</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, BUILDING, COUNTRY, POSTAL_CODE</td>
</tr>
<tr>
<td>South Africa</td>
<td>POSTAL_ADDR_ZA</td>
<td>ZA</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, ADD_ELEMENT_ATTRIBUTE2, COUNTRY, POSTAL_CODE</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------</td>
<td>---------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Spain</td>
<td>POSTAL_ADDR_ES</td>
<td>ES</td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Sweden</td>
<td>POSTAL_ADDR_SE</td>
<td>SE</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Switzerland</td>
<td>POSTAL_ADDR_CH</td>
<td>CH</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>United Arab Emirates</td>
<td>POSTAL_ADDR_AE</td>
<td>AE</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>POSTAL_ADDR_GB</td>
<td>GB</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, CITY, COUNTRY, POSTAL_CODE, STATE</td>
</tr>
<tr>
<td>United States</td>
<td>POSTAL_ADDR_US</td>
<td>US</td>
<td>ADDRESS1, ADDRESS2, CITY, COUNTRY, POSTAL_CODE, STATE</td>
</tr>
<tr>
<td>Uruguay</td>
<td>POSTAL_ADDR_S_AM</td>
<td>UY</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, CITY, COUNTRY, POSTAL_CODE, PROVINCE</td>
</tr>
</tbody>
</table>

The following table lists North European countries and their prefixes for postal codes:
<table>
<thead>
<tr>
<th>Territory Short Name</th>
<th>Territory Code</th>
<th>Prefix for North European Postal Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austria</td>
<td>AT</td>
<td>A</td>
</tr>
<tr>
<td>Belgium</td>
<td>BE</td>
<td>B</td>
</tr>
<tr>
<td>Germany</td>
<td>DE</td>
<td>D</td>
</tr>
<tr>
<td>Finland</td>
<td>FI</td>
<td>FIN</td>
</tr>
<tr>
<td>Faroe Islands</td>
<td>FO</td>
<td>FR</td>
</tr>
<tr>
<td>France</td>
<td>FR</td>
<td>F</td>
</tr>
<tr>
<td>Italy</td>
<td>IT</td>
<td>I</td>
</tr>
<tr>
<td>Liechtenstein</td>
<td>LI</td>
<td>FL</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>LU</td>
<td>L</td>
</tr>
<tr>
<td>Norway</td>
<td>NO</td>
<td>N</td>
</tr>
<tr>
<td>Portugal</td>
<td>PT</td>
<td>P</td>
</tr>
<tr>
<td>Romania</td>
<td>RO</td>
<td>R</td>
</tr>
<tr>
<td>Sweden</td>
<td>SE</td>
<td>S</td>
</tr>
<tr>
<td>Holy See (Vatican City State)</td>
<td>VA</td>
<td>I</td>
</tr>
</tbody>
</table>

Create a Name Style Format

In this example, we create a name style format, define its format variation layout, and assign United States to it.

Note that the application selects a name style format to display name components based on your Locale Assignment preferences. You can set either Country or both Country and Language as locale. However, you can't set only Language as locale.
When both Country and Language are set as locale, the application displays name components based on the language settings of your current session. For example, suppose you have the following two name style codes created under the Concatenated Name format:

- **Style Code 1:**
  - Country: China
  - Language: Simplified Chinese

- **Style Code 2:**
  - Country: China
  - Language: English

When you set your country preference to China and session language to English, you get the contact name formatted with Style Code 2. However, when you set your country preference to China and session language to Simplified Chinese, you get the contact name formatted with Style Code 1.

If no locale exists for a country and language setting, the default name style code (the name style code with Default Format for Style option set to Yes) is used.

Note that the name format takes effect only when you create a new contact or when you update the name of an existing contact. The application doesn't translate contact names.

### Create the name style format

To create a name style format:

1. On the Manage Name Formats page, click **Create** from the Actions menu. The Create Name Style Format page is displayed.
2. In the Overview region, complete the fields as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>CONCAT_NAME_US</td>
</tr>
<tr>
<td>Name</td>
<td>United States Concatenated Name Format</td>
</tr>
<tr>
<td>Name Style</td>
<td>Concatenated Name</td>
</tr>
<tr>
<td>Default Format for Style</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note:** Set the **Default Format for Style** option to Yes to specify the name style format that you're creating as the default format for the selected name style, Concatenated format.

3. In the Format Variation region, click **Add Row** from the Actions menu. A blank row is added to the Format Variation table.
4. Enter 1 in the Variation Rank field of the blank row.
5. In the Format Variation Layout region, click **Create** from the Actions menu. A blank row is added to the Format Variation Layout table.

6. Complete the fields as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>1</td>
</tr>
<tr>
<td>Position</td>
<td>1</td>
</tr>
<tr>
<td>Prompt</td>
<td>Person First Name</td>
</tr>
<tr>
<td>Name Element</td>
<td>First Name</td>
</tr>
<tr>
<td>Required</td>
<td>No</td>
</tr>
<tr>
<td>Uppercase</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note:** You can create as many name parts as you require. Click **Expand** to enter blank lines and delimiters before or after a name part. In this section, you can use Attribute Transform Function to specify how the country attribute value must be displayed. Use the following one of the following functions:

- `hz_format_pub.get_tl_territory_name(COUNTRY)`: Converts a country code of a country into its name. For example, MX is converted to Mexico. The country is displayed in the language that's set in the user profile. If the country set in the user profile is the same as the country attribute value, the country name isn't displayed.
- `hz_format_pub.get_neu_country_code(COUNTRY)`: Converts a country code for North European countries into a code that's placed before the postal code in a formatted address. For example, for France F is placed before the postal code. B is used for Belgium, D for Germany, and so on.

For more information about territory codes and their prefix for North European postal codes, see Seeded Address Formats for Countries topic.

7. Click **Create** from the Actions menu to create another variation layout as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>2</td>
</tr>
<tr>
<td>Position</td>
<td>2</td>
</tr>
<tr>
<td>Prompt</td>
<td>Person Last Name</td>
</tr>
<tr>
<td>Name Element</td>
<td>Last Name</td>
</tr>
</tbody>
</table>
8. On the Locale Assignments tab, click Actions > Create, and complete the fields as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>United States</td>
</tr>
<tr>
<td>Language</td>
<td>American English</td>
</tr>
</tbody>
</table>

Note: The application selects a name style format to display name components based on your Locale Assignment preferences. You can set either Country or both Country and Language as locale. However, you can’t set only Language as locale. If no locale exists for a country and language setting, the default name style code (the name style code with the Default Format for Style option set to Yes) is used.

9. Click Save and Close.

FAQs for Define Data Formats

How can I create an address style format layout?

Click New in the Manage Address Formats page and add address lines in the Format Variation Layout section. If you require more than one address style format layout, then you can create a format variation and add a different address format layout.

How can I create a variation of an Address Style Format?

You can create different variations of an address style format, with each variation having its own layout. For example, a country’s postal address may have variations such as general postal address, rural address, and military address. When you create an address style format, the layout defined for the format is assigned as the default variation. Click Add in the Format Variation region of the Edit Address Style Format page, for the address style format, to add a variation of the Address style. For each address style format variation, you can enter a variation rank to define the priority of the variation.
How can I create a name style format layout?

Click **New** in the Manage Name Formats page and add line entries for each part of the full name in the Format Variation Layout section, within the Create Name Style Format page. If you require more than one name style format layout, then you can create a format variation and add a different name format layout.

How can I create another variation of a Name Style Format?

You can create different variations of a *name style format*, with each variation having its own layout. For example, different regions in a country may have different name style formats. Click **Add** in the Format Variation region in the Edit Name Style Format page, for the name style format, to add a variation of the name style. For each name style format variation, you can enter a variation rank to define the priority of the variation.
13 Contact Points

Telephone Numbering Plan

A telephone numbering plan defines the pattern of digits for a country phone number. It defines the country-specific components of phone numbers, display format styles, and codes. The codes include country codes, international prefixes, area codes within a country, and mobile prefixes. You can specify country-specific mobile prefixes to determine if a phone number is mobile or not.

You can also create multiple telephone number display formats for a country. For example, for the US phone format, you define the phone country code as 01, fixed area code as three numbers in length, and subscriber number as seven digits in length. You can create a telephone format for domestic display, such as (999) 999-9999, and a format for international display, such as 999-999-9999.

Update Telephone Numbering Plans

You can update telephone number plans from the Manage Phone Numbering Plans page. You can’t edit the country information if the country has area codes, mobile prefixes, or phone formats defined.

To update telephone number plans:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Phone Numbering Plans

   The Manage Phone Numbering Plans page opens.
2. Search for the country whose telephone number plan you want to update. For example, to search for the United States, select United States in the Country Code list or enter 1 in the Phone Country Code field.
3. Select the country and click Edit to view the Edit Phone Numbering Plan page.
4. You can edit the following country-specific phone information in the Scheme section:
   - Trunk Prefix: The code to dial before long distance numbers within the country, for example 1 for the US.
   - International Prefix: The code to dial before international numbers when calling from the country that you’re setting up, for example 011 for the US.
   - Subscriber Number Length: The length of the subscriber number for countries where the subscriber length is fixed.
   - Area Code Length: The length of the area code for countries where the area code length is fixed.
5. You can edit the following regional phone number information for the country in the Regional Information section:
   - Area Codes: Lets you define area codes that you want to use for the country.
Mobile Prefixes: Lets you define mobile prefixes that you want to use for this country. Mobile prefixes contain the area code and possible prefixes of the subscriber number. For example, the mobile prefix of 650506 consists of the 650 area code and the 506 subscriber number prefix.

- Telephone Number Formats: Lets you define multiple telephone number display formats for a country.

6. Click **Save and Close** to save your updates.

### How Telephone Number Plans Setup Fits in with other Setup Tasks

Telephone Numbering Plans define the telephone number format for a country. You can define multiple formats for a country depending on the requirements.

Phone number format, along with the other country-specific location information such as address and name formats, defines geographic-specific data formats. You can manage telephone number plans in the Manage Telephone Numbering Plans page.

The application uses the telephone number formats to display phone number in the appropriate style, and to validate phone numbers. You can define country-specific components of phone numbers, display format styles, and area codes. The application uses the phone formats to correctly parse phone numbers and determine the correct format style for displaying phone numbers in user interfaces.

The application validates phone numbers for a country, based on the format defined for the country. The phone numbers are also validated against a common set of rules that apply to all countries. You can also enter time zone information for a country, at the country code and area code level. The time zone information is validated against the time information defined for the country.

### FAQs for Define Contact Points

**Why can't I update the country information section in the Edit Telephone Numbering page?**

You can't update the country information if regional information such as area codes, mobile prefixes, and phone formats are defined for the country.

**How can I assign relationships when creating a contact point for a contact or an account?**

When you create a contact point either for a contact in the Contact's Profile page or for an account in the Account's Contacts page, you can select the associated relationships using the Customer Relationship LOV.
14 Data Import

Data Import Options

You can import your data from an external application into Oracle Applications Cloud in several different ways, including using public web services. Which import method you use depends on the type of data you're importing, the volume of data, and technical requirements. If you're integrating one cloud service with other cloud services, then you must use additional import methods as described in the appropriate guides.

When you're importing data for a particular object, you must make sure that any prerequisite objects already exist in the application. For example, if you're importing contacts for an account, then the account must already exist in the application. If one import job depends on the contents of another import job, then complete the prerequisite job before starting the dependent job. For example, if you're importing both accounts and opportunities, then import accounts before importing opportunities.

The following table lists the import methods and references to further information.

<table>
<thead>
<tr>
<th>Import Method</th>
<th>Description</th>
<th>When to Use</th>
<th>How to Access</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Import Excel</td>
<td>You can use the import macros to speed up and simplify the import of up to 5000 records at a time for some objects. They validate your data entries, provide list of values, and automatically populate constant values. The macros create data files that are automatically imported using Import Management. You can import the following objects using import macros:</td>
<td>These are best to import data in your initial deployment. The macros are targeted to the simple proof of concept sales automation use case covered in the Importing Sales Users chapter of the Getting Started with Your Sales Implementation guide. For example, the import macros assume that you're importing account, contact, and lead records for one country at a time. The macros generate log files with information about the File Import job, and these log files can also serve as a learning tool for more complex import.</td>
<td>You can download the Excel macros and any required mapping files from the Getting Started with Your Implementation: Quick Import Macros (Document ID 2229503.1) article on My Oracle Support.</td>
<td>The chapters in the Getting Started with Your Sales Implementation guide provide detailed instructions and video tutorials for using the macros. For instructions on how to add your own fields to the macros, see. How to Configure Quick Import Macro for Importing Employee Resources (Doc ID 2364229.1) article on My Oracle Support.</td>
</tr>
<tr>
<td>Import Method</td>
<td>Description</td>
<td>When to Use</td>
<td>How to Access</td>
<td>For More Information</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Import Management</td>
<td>Import Management improves definition, error handling, and performance for importing flat files (.CSV). For example, Import Management has drag and drop mapping capabilities and validates the first ten records in your data file before you import to ensure the data meets the import constraints of the various attributes.</td>
<td>Use Import Management for importing outside the scope of the Getting Started with Your Implementation guide.</td>
<td>Click <strong>Import Management</strong> in the Navigator.</td>
<td>See the Understanding Import and Export Management guide for instructions on using the import.</td>
</tr>
</tbody>
</table>

Import Management is available for importing data for the following application objects and their child objects:

- Access Groups
- Account
- Action
- Action Plan
- Activity
- Address
- Asset
- Attachment
- Business Plan
- Campaign
- Case
- Classification
- Classification Code
- Competitor
- Consumer
- Contact
- Contract
- Contests
- Country Structure
- Deal Registration
- Hierarchy
- Hierarchy Member
- Household
- Hub Source System Reference
- Incentive Rule Assignments
<table>
<thead>
<tr>
<th>Import Method</th>
<th>Description</th>
<th>When to Use</th>
<th>How to Access</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>File-Based Data Import</td>
<td>File-Based Data Import supports the import of data files with up to 100,000 records each for the broadest range</td>
<td>Use File-Based Data Import only for any objects not yet covered by Import Management.</td>
<td>You can access File-Based Data Import tasks by navigating to the following in the Setup and</td>
<td>You can learn how to import in the Understanding File-Based Data Import and Export guide.</td>
</tr>
<tr>
<td>Import Method</td>
<td>Description</td>
<td>When to Use</td>
<td>How to Access</td>
<td>For More Information</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>External Data Loader</td>
<td>Command-line tool that's used to import high-volume flat source data files</td>
<td>Use this import method for importing very large data files for the objects</td>
<td>You can download the client from Oracle Support Document 23252491 (External</td>
<td>Instructions for using the client are available in the document and in the client itself.</td>
</tr>
<tr>
<td>Client</td>
<td>into CX Sales and B2B Service. This tool splits a large data file into</td>
<td>supported by Import Management.</td>
<td>Data Loader Client) on My Oracle Support.</td>
<td>The chapter Import Data Using External Data Loader Client in the guide Understanding Import and Export Management for CX Sales and B2B Service provides information about using the External Data Loader Client.</td>
</tr>
<tr>
<td></td>
<td>multiple smaller files to adhere to import volume limits, and enables the</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>tracking of import status.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The client supports the same objects as Import Management.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web Services</td>
<td>Web services are available for external client applications to start and</td>
<td>Use web services to manage import jobs to import directly from an external</td>
<td>Public APIs are available for both the Import Management/REST services and</td>
<td>For REST API documentation, see the REST API for CX Sales and B2B Service guide.</td>
</tr>
<tr>
<td></td>
<td>monitor import jobs. You can manage Import Management jobs using REST web</td>
<td>application.</td>
<td>the File Import/REST services.</td>
<td>For SOAP API documentation, see the SOAP Web Services for CX Sales and B2B Service guide.</td>
</tr>
<tr>
<td></td>
<td>services, and File Import jobs using SOAP web services.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High-Volume Import</td>
<td>The high-volume import mode is designed to import millions of records at</td>
<td>Use this import mode for importing very large number of records for the</td>
<td>You can access High-Volume Import either using REST services or using</td>
<td>For REST API documentation, see the REST API for CX Sales and B2B Service guide.</td>
</tr>
<tr>
<td></td>
<td>once. This mode doesn't trigger any custom logic</td>
<td>the objects supported.</td>
<td>External Data Loader Client.</td>
<td></td>
</tr>
<tr>
<td>Import Method</td>
<td>Description</td>
<td>When to Use</td>
<td>How to Access</td>
<td>For More Information</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td></td>
<td>configured through the application composer. This option is available for</td>
<td></td>
<td>When importing using REST, set the “High-volume” attribute to enable this mode</td>
<td>The chapter Import</td>
</tr>
<tr>
<td></td>
<td>the following objects and their child objects:</td>
<td></td>
<td>of import.</td>
<td>Data Using External</td>
</tr>
<tr>
<td></td>
<td>• Account</td>
<td></td>
<td>When importing using the External Data Loader Client, set the command-line</td>
<td>Data Loader Client in</td>
</tr>
<tr>
<td></td>
<td>• Asset</td>
<td></td>
<td>parameter “-high-volume” to enable this mode of import.</td>
<td>the guide</td>
</tr>
<tr>
<td></td>
<td>• Classification Code</td>
<td></td>
<td></td>
<td>Understanding</td>
</tr>
<tr>
<td></td>
<td>• Contact</td>
<td></td>
<td></td>
<td>Import and Export</td>
</tr>
<tr>
<td></td>
<td>• Contract</td>
<td></td>
<td></td>
<td>Management for CX</td>
</tr>
<tr>
<td></td>
<td>• Contract Line</td>
<td></td>
<td></td>
<td>Sales and B2B Service</td>
</tr>
<tr>
<td></td>
<td>• Country Structure</td>
<td></td>
<td></td>
<td>provides information</td>
</tr>
<tr>
<td></td>
<td>• Custom Object (custom top level objects and custom child objects)</td>
<td></td>
<td>about using the External Data Loader Client.</td>
<td>about using the</td>
</tr>
<tr>
<td></td>
<td>• Geography</td>
<td></td>
<td></td>
<td>External Data Loader</td>
</tr>
<tr>
<td></td>
<td>• Hierarchy</td>
<td></td>
<td></td>
<td>Client.</td>
</tr>
<tr>
<td></td>
<td>• Hierarchy Member</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Hub Source System Reference</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Incentive Transaction</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Organization</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Person</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Sales Territory Quota</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Territory Geographies</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following figure provides an architectural overview of the different import methods:

- **File Import** uses the SOA architecture to import data into Oracle CX Sales.
- **Quick Import** uses the REST Web services to import data into Oracle CX Sales. When you import data using the quick import Excel macros, you’re creating an import activity in Import Management using the REST web services. The macro import creates the same import activity and uses the same mapping as you do when you initiate the import from the application. You can monitor each import in the macro or in the application itself.
- **Both Import Management and the External Data Loader Client** use the same scheduled processes for import. When you import very large files using the client, the REST APIs create multiple processes to respect the Import Management file size limit.
Oracle CX
Implementing Customer Data Management for CX Sales
and B2B Service

Chapter 14
Data Import

- To import from an external application, use the SOAP and REST web services directly.

Import Options and Flow

- SOAP Web Services
- File Import
- Quick Import Macros
- Import Management
- External Data Loader Client
- SOA
- REST Web Services
- Oracle ESS
- REST Web Services

Related Topics

- Understanding File-Based Data Import and Export guide
- Understanding Import and Export Management guide
- REST API for CX Sales and B2B Service guide
- SOAP Web Services for CX Sales and B2B Service guide
- Import Data
FAQs for Data Import

What determines the list of File-Based Data Import objects displayed?

A single import object can have multiple associated components that are considered objects by themselves. Whether or not an associated object can be grouped as a component of another object for the purpose of file import is determined by the complexity of the object structure and how the object is stored in the data model. Sales and B2B Service provides import objects predefined to meet the file processing import requirements. Consequently, in some cases, more than one source file may be required to capture all associated components of an object.

What happens if I inactivate an Import Activity?

The Import Activity will not stop the currently running process. However, it will cause the next scheduled process plus any future repeating file import activities not to start. You can always activate the process at a later stage.

What happens if I add a marketing list in the Import Activity definition?

File-based data import enables you to record consumers and organization contacts in a marketing list when importing consumer, lead, and response import objects. Select an existing list or create a new one. A marketing list is assigned the list type value of Imported if created while defining an import activity. After the objects are imported successfully, the consumers and contacts are added as members of the marketing list.

Why can't I retrieve duplicates using the options in the Customer Data Management Duplicates LOV when importing accounts or legal entities?

When importing accounts or legal entities, you can retrieve duplicates using the Customer Data Management Duplicates LOV only if you have licensed the data quality functionality. Once licensed, you must rebuild the keys for your matching configuration using the Manage Enterprise Data Quality Matching Configurations task. After the keys are rebuilt, the matching functionality uses the settings in the match configuration to identify duplicates.
15 Export Management

Overview of Export Management

You can use Export Management to move data out of Oracle Applications Cloud in the form of CSV files. To export data, you start by creating an export activity. As part of the export activity, you select a parent object and its relevant child objects. You also must define filters on these objects to specify the records you want to export.

Scenarios for Export

You may want to export data in the following scenarios:

- You might want to move data out of Oracle Applications Cloud into another application. To perform this activity you have to export the data into a ZIP file and import the exported data into the target application.
- You might want to format the data as per your requirements.
- You may want to identify the unique identifiers of an object such as Party ID or Party Number. You can use this information to update an object record.

You can schedule an export either immediately or at a future date. If you schedule it for a future date, then provide the start date and time while defining the export activity.

Using Export Filters

You can define the conditions for the records to export in the export filter. The exported data sets contain only those records that match the specified filter criteria on the parent/child object. It is recommended that you use multiple filters to reduce the number of records to export.

You can create a filter by navigating to Tools > Export Management > Export Objects and clicking on the Display Name link for the export object. On the Manage Filters page, click the Create Filter button to create a filter. On the Script Edit page, enter the filter name, filter parameters, and the order by clause if required. You can reuse an existing filter by selecting a value from the Existing Filters drop-down list. Once you're done with your changes, click Validate Script and then click Save and Close to save your new filter. You can also create a filter while creating an export activity, on the Map Fields page.

You can delete a filter on the Manage Filters page, by clicking the delete icon for your filter under the Delete Filter column. Note that you can delete only the filters created by you and those that aren't used in an active export job.

Export Data

This topic shows you how to export data using the Export Management option from the Tools work area.

To export data:

1. Click Tools > Export Management.
2. On the Manage Exports page, click the Create Export Activity button.
3. On the Enter Export Options page, enter values for each of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description of the value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the export activity.</td>
</tr>
<tr>
<td>Object</td>
<td>The object to export. You must select the parent or child object from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>If you can't find an object in the drop-down list, then click the Search link. In the Search and Select dialog box, enter the object name in the Object text box and click the Search button. Select your object from the result list and click OK. You can also use the advanced search option by clicking the Advanced button. Here you can search based on various filter criteria such as object name, attachment supported, creation date, and so on. Note: If the object you’re exporting isn’t listed then verify if you have the roles and privileges required to export the object. For information on the roles, see the topic Roles Required for Import and Export Management referenced in the Related Topics section.</td>
</tr>
<tr>
<td>Description</td>
<td>The optional description of the export activity.</td>
</tr>
<tr>
<td>File Name</td>
<td>The name of the export file to generate in ZIP format. This field is populated based on the object and date time stamp.</td>
</tr>
<tr>
<td>Export Attachments</td>
<td>Select to export the attachments related to the object. This option is enabled only if the selected object supports attachments.</td>
</tr>
</tbody>
</table>

4. Optionally to set additional export configurations, click the Advanced Options section. Here you can configure settings in the Output File, Export Options, or Create Schedule sections.
   - Following are the options in the Output File and Export Options regions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
</table>
   | Delimiter| If your file doesn't use a comma to separate values, then select the correct delimiter in the Delimiter drop-down list. Possible values are:  
   - Caret Symbol  
   - Closing Curly Bracket  
   - Closing Parenthesis  
   - Closing Square Bracket  
   - Colon  
   - Comma  
   - Exclamatory Mark  
   - Minus  
   - Opening Curly Bracket | Comma |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escape Special Characters</td>
<td>If selected, then RFC4180 format is used, and quotes are escaped with another set of quotes.</td>
<td>Deselected</td>
</tr>
<tr>
<td>Decimal Separator</td>
<td>The decimal separator used in your export file. Possible values are Comma and Period.</td>
<td>Period</td>
</tr>
<tr>
<td>Date Format</td>
<td>The format of the date fields in your file. Possible values are:</td>
<td>US - MM/DD/YYYY</td>
</tr>
<tr>
<td>Time Stamp Format</td>
<td>The format of time fields in your file. Possible values are:</td>
<td>US - MM/DD/YYYY hh:mm:ss PM</td>
</tr>
<tr>
<td>File Encoding</td>
<td>The format in which the characters within your source file are encoded. Possible values are:</td>
<td>Unicode - UTF - 8</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Default Value</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>End of Line</td>
<td>The character used to indicate end of line in the export file. Possible values are:</td>
<td>Line Feed</td>
</tr>
<tr>
<td></td>
<td>• Carriage Return</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Carriage Return and Line Feed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Line Feed</td>
<td></td>
</tr>
<tr>
<td>Quote Character</td>
<td>The character used to indicate a quote. This field is read-only.</td>
<td>N/A</td>
</tr>
<tr>
<td>Language Independent Header</td>
<td>Select to export column headers. If you're modifying the exported data manually, then exporting column headers help in automatic mapping during the reimport process.</td>
<td>N/A</td>
</tr>
<tr>
<td>Notification Email</td>
<td>The email to send export-processing notifications. The user submitting the export receives an email notification automatically. You use this field to specify any additional recipients. If you want to have more than one email recipient, separate the email addresses with a comma or semicolon. You can also specify a mailing list address so that a large number of recipients can be notified.</td>
<td>N/A</td>
</tr>
<tr>
<td>Enable Split</td>
<td>Select to split the export data set based on a specified record count.</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>On selecting this check box, you can see the Split Size drop-down list, with a default value of 100k. You can specify the split size in multiples of 100k records, ranging from 100k to 1000k.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The exported data is split into multiple CSV files, and each file has a maximum of 50K records. You can further split the exported data into multiple ZIP files, based on the specified split size. For example, if your export job retrieves 300k records and split is enabled with a split size of 200k, then 2 export ZIP files are generated. The first ZIP file contains 200k records which is divided into 4 CSV files each with 50k records. The second ZIP file contains 100k records</td>
<td></td>
</tr>
</tbody>
</table>
Option | Description | Default Value
--- | --- | ---

|  |  | which is then divided into 2 CSV files each with 50k records. |

In the **Create Schedule** region, you can schedule the export to run either immediately or at a future date. If you select a future date, then provide the date and time to start the export.

5. Click **Next**. On the **Map Fields** page you can see the exportable object, its child objects, and the associated attributes. The **Export Mapping** drop-down list shows the maps that were used in earlier export jobs. You can select an existing mapping from the drop-down list and click **Apply**.

6. You can select the child objects to export by selecting the **Enabled** check box. Selecting the **Enabled** check box for a child object displays the associated attributes in the **Available Fields** section. You can select the attributes to export by double-clicking the attribute in the Available Fields list. Alternatively, you can move the attribute from Available Fields list to the **Selected Fields** list. If you select any formula fields for export, it might impact your export performance.

7. You must provide a filter criterion for at least the top-level object. To filter the records to export using conditions, click the **Filter Name** icon. On the **Filter Name** dialog box, you can create the filter for the export attributes using the operators AND, OR, >, <, =, and !=. On the **Fields** tab select the attribute and click the **Insert** button. In the Script Edit window, provide the filter conditions for the selected attribute. After creating the filter criteria script, click **Validate Script**. Click **Save and Close** to save the filter.

8. Click **Next**. On the **Review and Submit** page, review the export activity configuration. If you want to change any configuration, then click the **Back** button. Submit to activate the export activity. After the export activity completes, clicking the **My Completed Exports** infotile shows your export status. Click the ZIP file link in the **Exported Data File** column to download the exported file.

**Note:** By default, you can't view the Personally Identifiable Information (PII) such as mobile numbers in the exported data. To view this information, follow these steps:

1. Navigate to **Tools > Security Console**.
2. Search for the role **ORA_MOT_QUOTA_EXPORT_MANAGEMENT_DUTY**.
3. Edit role and click the **Data Security Policies** link.
4. Click the **Create Data Security Policy** button, and add a new data security policy on the database resource **Trading Community Contact Point** with the following details.
   - **Policy Name:** Custom Grant on Person Contact and Mobile Phone Data (you can provide any name)
   - **Database Resource:** HZ_CONTACT_POINTS
   - **Data Set:** All Values
   - **Actions:** View Trading Community Person Contact, View Trading Community Mobile Phone Number
5. Click OK to save and navigate to **Summary** step to review and save changes.

**Related Topics**

- Roles Required for Import and Export Management
Export Queues

This topic describes the different infotiles displayed on the **Manage Exports** page of the **Export Queue** tab.

**Export Queue**

The following infotiles are displayed on the **Manage Exports** page:

- **All Exports**: This infotile displays the count of active, completed, and unsuccessful exports submitted by all users. Click to see the exports created by all the users and in all possible statuses.
- **Active Exports**: This infotile displays the count of exports submitted by all users that are either in progress or in queued status. Click to see the active exports created by all the users.
- **My Completed Exports**: This infotile displays the count of exports submitted by the current user that are either successful or failed with warnings or errors. Click to see the completed exports created by the current user.
- **Unsuccessful Exports**: This infotile displays the count of unsuccessful exports submitted by all users. Click to see the unsuccessful exports created by all users.

**Note**: The export activity records appear in the queue for thirty days, after which they’re removed. The exported ZIP files and diagnostic files are removed from the server on the 7th day of the export.

**Export Details**

You can view more details about the exports on clicking the infotiles. The following details about the export are displayed:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the export job. Click to go to the <strong>Export Status</strong> page.</td>
</tr>
<tr>
<td>Object</td>
<td>The object exported.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the export job. For more information about the statuses, see the topic How You Monitor Export Activity in the related topics section.</td>
</tr>
<tr>
<td>Start Time</td>
<td>The start date and time of the export.</td>
</tr>
<tr>
<td>End Time</td>
<td>The end date and time of the export.</td>
</tr>
<tr>
<td>Submitted By</td>
<td>The user who submitted the export.</td>
</tr>
<tr>
<td>Exported data file</td>
<td>The link to download the exported data file in ZIP format.</td>
</tr>
</tbody>
</table>
You can filter the export using any of the columns in the preceding table. You must select the filter value from the Search drop-down list and enter the criteria in the adjacent text box.

How You Monitor Export Activity

This topic explains how to monitor export activities and view their statuses.

View the Export Status

On the Manage Exports page, click the export activity name link to see additional information about the export activity. The Export Status page contains the following sections:

- Status Bar
- Details
- Export Attachments

The Export Status Bar

The status bar shows the progress of the export activity in a graphical format. It shows the following stages during the export process:

1. Queued for Export: The export request is queued for processing, and is waiting to begin execution.
2. Preparing data for Export: The data are loaded in the temporary staging table for further processing.
3. Exporting data: The data from the target objects are loaded into the export files (CSV).
4. Completing export activity: The export data have been loaded in the source files, and cleanup tasks, such as the generation of log files, are in progress.
5. Completed with errors: The export activity has completed with errors.
6. Completed with warnings: The export activity has completed with warnings.
7. Unsuccessful: The export activity was unsuccessful.

Activity and Record Details

The Activity Details section shows the name of the export activity, export job identifier, object exported, and the name of user who submitted the export. The section on date and time displays the start and end times, and the time taken to complete the export activity.

The Record Details section displays the number of records estimated, number of records exported, and the number of records with errors.

Export Attachments

You can generate the diagnostics and log files from the Action menu. The Export Attachments section displays the list of files associated with this export activity in tabular format. The Actions column in this section lets you either download the file or view more details. These files include the diagnostics and log files generated.
16 Bulk Data Export

Overview of Bulk Data Export

You can extract large volumes of data using bulk export. You can either extract a full set of records for an object, or perform incremental extracts. For example, you can extract complete set of account data or extract updated set of records every week. Bulk export creates comma separated or tab delimited files, which are attached to the export process.
Perform Bulk Export

You can extract large volumes of data using bulk export. You can either extract full set or records for an object, or perform incremental extracts. Bulk export creates comma separated or tab delimited files, which are attached to the export process after exporting the data.
To perform bulk data export:

1. Create the export process definition. The export process definition is made up of the export map and the processing schedule.
2. In the export map of the export process definition:
   a. Select attributes for the export
   b. Filter data for the export
3. Schedule the export job.
4. Activate the export job.

Define Bulk Export

After defining the mapping files, you create an export process to export an object's data using the mapping files created.

To define a bulk export process:

1. Navigate to the following in the Setup and Maintenance work area:
   o Offerings: Sales
   o Functional Area: Data Import and Export
   o Task: Schedule Export Processes
2. Select Create from the Actions menu to view the Create Export Process Definition: Enter Basic Information page.
3. Enter basic information about the export process, such as name and export map.
4. Click Next to view the Create Export Process Definition: Configure Export Objects page.
   In this page, you define the export object you want to export and the mapping you want use for the export process.
5. Optionally, you can enter a name for the mapping if you would like to reuse this mapping for other export processes. An object's mapping file determines what data is exported every time an object is exported. You can have multiple mapping files for an export object for various object details you want to export.

   **Note:** The export mapping is optional. You don't need to select an existing mapping to perform an export.

6. Select Create from the Actions menu to view the Manage Export Objects dialog box.
7. Select objects from the Available Objects list and move them to the Selected Objects list and click Done.
8. Define the attributes you want to export in the Detail region of the page. You can define:
   o Attributes you want to export. Select Enabled for the attributes you want to export.
   o Header text of the attributes. Edit the header text in the Header text column. This value is used as the column header in the files generated by the export process
9. Define the filters to determine the data you want to export by clicking the button in the Edit Filter Criteria column.

   **Note:** For the incremental extracts, you can create filters using time stamps to determine which rows to export.
10. Click Next to view Create Export Process Definition: Create Schedule page.
11. Select if you want to run the export process immediately or at a later time. Two types of scheduled exports are supported:
   a. Incremental Export
   b. Normal Export
12. Click Next to view the Create Export Process Definition: Review page.
13. Review the export process details and click Activate.

After each export process executes and completes, a comma or tab delimited data file is created and stored as an attachment to the data export process. If the number of records matching the view criteria exceeds one million records, or if the generated export file size exceeds 100 MB, then the data export process generates multiple files. The generated export files are numbered using the extension "_NNN" starting at "_001".

You can also use web services to schedule and start an export process. In this case, you can use the getAttachment web service to download the data file.

### How Bulk Export Process Components Work Together

You use bulk data export to export data, by leveraging export maps. To export files using bulk export, you create a process definition, map files for full and incremental extract processes, and then schedule the data export process.

### Bulk Data Export Process Components

This image shows the bulk data export process components comprising the process name, export process ID, and the export map ID.
Bulk data export process includes these three components:

- **Process name**: A name for the export process that lets you easily refer the export process rather than using the computer generated ID such as 100000019897192.
- **Export process ID**: A unique, application generated identifier for the export process definition for the export process. The process ID ties the export map with its export objects, filters, and the export schedule.
- **Export map ID**: A unique identifier for the export map. You can reuse the export map in different process definitions. For example, you create a process definition to export all the data from the Customer export object. You can then reuse that export map and apply a new filter on the data to create an incremental export, such as data accrued since the last export date.

FAQs for Manage Bulk Data Export

**Which data objects do I need to select for successful data export?**

Review the requirements for the data to be exported and determine the source view objects that hold the attributes you want.

**How can I create a subset of data for export?**

Full sets of data aren’t always required for export. To create a subset of data, use filter criteria to determine the time frame or scope of data, based on values of the attributes. To find activities for a specific date range, for example 1/1/11 through 3/31/11, navigate to the Export Objects Detail Sub Page and click the filter icon. Fill in the filter criteria dialog for the project start dates to select the data to be exported. You run the export by navigating to the following in the Setup and Maintenance work area:

- Offerings: Sales
- Functional Area: Data Import and Export
- Task: Schedule Export Processes

**How can I see my exported data?**

You can view the Schedule Export Processes, Overview page to see the History subpage. The column Exported Data File shows a hyperlink to your output file This file will be a comma separated variable or a tab delimited file. Click that link to open the file and see the exported data.

**What happens if I change the sequence number or header text in an exported data file?**

Changing the sequence number changes the order of the attributes in the exported data file. Changing the header text enables you to give a more intuitive meaning to the attribute and the associated data.
What happens if I need data from multiple export view objects?

Select as many view objects as required for the export process. Select the individual attributes required from every export object.
17 Configure Oracle DaaS and Oracle DataFox for Data Enrichment

Overview of Configuring Data Enrichment

You can use Oracle Data as a Service (DaaS) for Sales (also known as Social Data and Insight Cloud Service) to enrich your account and contact data. DaaS for Sales partners with Dun and Bradstreet to get the most up-to-date data for over 300 million companies and over 100 million contacts worldwide. You can also use Oracle DataFox for data enrichment. For more information about DataFox, see Oracle DataFox documentation.

Data enrichment improves the quality of your existing account and contact data, and it also enriches the data with additional information. Sales representatives can enrich accounts and contacts in real-time in Sales, and data stewards can enrich data in bulk in CDM, using either batch data enrichment in the Data Enrichment work area or manually using bulk import and export. Additionally, you can download new account and contact data from DaaS for Sales.

How you Configure Batch Data Enrichment

The batch data enrichment option lets you enrich data in bulk by creating and submitting batch-processing jobs in the Data Enrichment work area. Configuring this enrichment process flow requires the completion of the following set-up steps:

1. Create a DaaS user and assign appropriate privileges.
2. Configure Oracle CX Sales and B2B Service to DaaS integration.

For more information on the setup process, see Batch Data Enrichment Setup in the Related Topics section.

How you Configure Manual Data Enrichment

CDM comes with preconfigured mappings of data attributes to import account and contact data from DaaS for Sales. If you require additional attributes not in these mappings, you must create a custom mapping and manually import the data using that mapping.

For more information on creating a new mapping in DaaS, see Create a New Mapping in the Related Topics section.

For more information on manual data enrichment from DaaS, see Manual Data Enrichment in the Related Topics section.

Related Topics

- Batch Data Enrichment Setup
- Create a New Mapping
- Manual Data Enrichment
Specify the Industry Classification for Accounts

Use the following procedure to specify which industry classification category you want to use for accounts. The classifications for the category you select appear in the list of values for the Industry field in the Account user interface. By default, the profile is set to CUSTOMER_CATEGORY.

1. Sign in as a setup user.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Sales
   - Functional Area: Sales Foundation
   - Task: Manage Administrator Profile Values
3. On the Manage Administrator Profile Values page, search for the Profile Option Code MOT_INDUSTRY_CLASS_CATEGORY.
4. Select the classification category from the Profile Value list. The available values are:
   - 1972 SIC
   - 1977 SIC
   - 1987 SIC
   - CUSTOMER_CATEGORY
   - NACE
   - NAF
   - NAICS_1997
   - NAICS_2002
   - NAICS_2017
5. Click Save and Close.

Manual Data Enrichment

For more information on manual data enrichment from DaaS, see Manual Data Enrichment in the Related Topics section.

Related Topics
- Manual Data Enrichment
Customer Hub Profile Options

Customer Hub profile options configure data access and processing for data governance, duplicate identification processes, data cleansing processes, and duplicate resolution requests.

You can set the Hub profile option values only at the site level using the predefined profile option definitions. The following table lists the Customer Hub profile options that you can configure in the Setup and Maintenance work area using the following:

- Offering: Customer Data Management
- Functional Area: Customer Hub
- Task: Manage Customer Hub Profile Options

<table>
<thead>
<tr>
<th>Profile Option Name</th>
<th>Profile Option Name</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZCH_CLNS_PROC_BT_SIZE</td>
<td>Data Cleansing Process Batch Size</td>
<td>The transaction batch size for the data cleansing process. Set this value based on available system resources.</td>
<td>10000</td>
</tr>
<tr>
<td>ZCH_DEDUP_REQUEST_TYPE_DEFAULT</td>
<td>Resolution Request Type Default</td>
<td>The default request type for the duplicate resolution requests.</td>
<td>Merge</td>
</tr>
<tr>
<td>ZCH_DI_PROC_BT_SIZE</td>
<td>Duplicate Identification Process Batch Size</td>
<td>The transaction batch size for the duplicate identification process. It’s used to group records in the batch and process each group in a loop as a separate transaction.</td>
<td>100</td>
</tr>
<tr>
<td>ZCH_USER_MERGE_REQUESTS</td>
<td>User Merge Requests</td>
<td>The processing options for merge requests.</td>
<td>Unspecified (NULL)</td>
</tr>
<tr>
<td>ZCH_ENABLE_SURVIVORSHIP</td>
<td>Survivorship Enabled</td>
<td>The option to enable survivorship rules for duplicate resolution.</td>
<td>Yes</td>
</tr>
<tr>
<td>ZCH_AUTO_LINK_THRESHOLD</td>
<td>Auto Link Threshold</td>
<td>The threshold for auto link. Data stewards review link requests with lower scores.</td>
<td>0</td>
</tr>
<tr>
<td>ZCH_AUTO_MERGE_THRESHOLD</td>
<td>Auto Merge Threshold</td>
<td>The threshold for auto merge. Data stewards review merge requests with lower scores.</td>
<td>100</td>
</tr>
</tbody>
</table>
You can set the following values for the User Merge Requests profile option:

- Allow Processing Without Approval: Merge requests are processed immediately without approval by data steward.
- Process Subject to Approval: Merge requests are reviewed by data steward, who can decide to approve or not.
- Unspecified (NULL): Merge requests are processed immediately without data steward approval. This indicates that the Customer Hub isn’t configured. The option is enabled only if the user has the Submit Trading Community Merge Request and Enter Trading Community Merge Request privileges.

**Note:** Data stewards must review merges initiated from the Accounts and Contacts UI pages, Automerge web service, or the Duplicate Resolution Request service. Data stewards can review merge requests only if the User Merge Requests profile option is set to Process Subject to Approval, else the merge requests will error.

### Additional Profile Options

The following table lists customer hub profile options that require careful consideration before their profile values are changed.

To view the details of these profile options:

1. Click **Navigator > Setup and Maintenance** work area.
2. Click the Tasks menu and click **Search**. Search for **Manage Profile Options** task and open it.
3. Search using the profile option code.

To change the default values of these profile options:

1. Click **Navigator > Setup and Maintenance** work area.
2. Click the Tasks menu and click **Search**. Search for **Manage Administrator Profile Values** task and open it.
3. Search using the profile option code.
4. Change the profile value.

<table>
<thead>
<tr>
<th>Profile Option Code</th>
<th>Profile Option Definition</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_ZCH_AGREEMENT_EVALUATION</td>
<td>Evaluate Agreement Rules</td>
<td>No default value provided</td>
<td>This profile option controls whether agreement rules are honored during merge processing. Setting this option to N enables agreement rule checking. We recommend that you don’t disable agreement rules. Disabling agreement rules can lead to orphan data and may cause issues for different application flows.</td>
</tr>
<tr>
<td>Profile Option Code</td>
<td>Profile Option Definition</td>
<td>Default Value</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ORA_ZCH_DEBUG</td>
<td>Customer Hub Debug Mode</td>
<td>No default value provided</td>
<td>You can add a new profile value row and specify Y or N. This profile option enables detailed internal logging of the duplicate resolution processes. We recommend that you don't enable this option unless specifically requested to do so by the Oracle support team. You can add a new profile value row and specify Y or N.</td>
</tr>
<tr>
<td>ORA_ZCH_ENABLE_DEFAULT_SO</td>
<td>Calculate Default Source System for Survivorship Rules</td>
<td>No default value provided</td>
<td>This profile option enables the calculation of default attribute source systems based on the earliest source system reference assignment for records that were created before attribute source history tracking was enabled. You can add a new profile value row and specify Y to enable this feature.</td>
</tr>
<tr>
<td>ORA_ZCH_SETATTRIBUTE_OPTIO</td>
<td>Attribute Survivorship Null Value Options</td>
<td>IGNORE_NULL_VALUE</td>
<td>This profile option controls whether a selected attribute survivorship rule can update the master record with a null value. For example, a record within a merge set has the highest source confidence level for a given field and also has a null value in that field, you can decide if a non-null value on the master record be replaced by the null value from the highest confidence source record. By default, survivorship processes don't replace a non-null with a null even if the source of the null has the highest source confidence. If you would like a null value to propagate to the master record in this scenario, you should set this profile option to RETURN_NULL_VALUE.</td>
</tr>
<tr>
<td>ORA_ZCH_ALLOW_REMOVE_FEAT</td>
<td>Remove Records From Merge Processing</td>
<td>N</td>
<td>This profile option is used to enable the Remove button in the duplicate resolution override flow. The Remove</td>
</tr>
</tbody>
</table>
Data Quality Profile Options

Data quality profile options configure data access and processing for duplicate identification processes and data cleansing processes.

The following table lists data quality profile options, descriptions, and default values.

To view the details of these profile options:

1. Click Navigator > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for Manage Profile Options task and open it.
3. Search using the profile option code.

To change the default values of these profile options

1. Click Navigator > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for Manage Administrator Profile Values task and open it.
3. Search using the profile option code.
4. Change the profile value.

<table>
<thead>
<tr>
<th>Profile Option Code</th>
<th>Profile Option Name</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_ZCQ_MAX_CANDIDATES</td>
<td>Interactive Duplicate Identification List Size</td>
<td>20</td>
<td>This profile option lets you limit the number of possible duplicates which may be returned by the interactive duplicate identification interface.</td>
</tr>
<tr>
<td>ORA_ZCQ_BATCHMATCH_DEBUG</td>
<td>Batch Duplicate Identification Debug Level</td>
<td>INFO</td>
<td>This profile option controls the level of diagnostic logging for batch duplicate identification processes.</td>
</tr>
<tr>
<td>ORA_ZCQ_LEVEL_OF_INDIRECTION</td>
<td>Indirect Duplicate Candidates Level</td>
<td>0</td>
<td>This profile option controls the extent to which indirect duplicate candidates are considered during duplicate identification.</td>
</tr>
<tr>
<td>Profile Option Code</td>
<td>Profile Option Name</td>
<td>Default Value</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ORA_ZCQ_CONVERTER_FINEST_LOGGING</td>
<td>Data Quality Match Value Conversion Logging</td>
<td>N</td>
<td>This profile option controls the logging on the data quality match value conversion process. When this profile option is set to Y, data quality logs are written in the log file.</td>
</tr>
<tr>
<td>ORA_ZCQ_CS_DATA_REFRESH_TIME_HRS</td>
<td>Refresh Duplicate Identification Custom Scoring Dictionary Cache</td>
<td>12</td>
<td>This profile option controls the frequency in hours for refreshing the custom scoring data dictionary cache.</td>
</tr>
<tr>
<td>ORA_ZCQ_CHUNK_SIZE_FOR_CLEANSING</td>
<td>Address Cleansing Batch Transaction Size</td>
<td>200</td>
<td>This profile option controls the number of records that are saved per transaction during batch address cleansing.</td>
</tr>
<tr>
<td>ORA_ZCQ_ENABLE_ADDR_MATCH_ENABLED</td>
<td>Address Duplicate Identification Match Configuration Enabled</td>
<td>No</td>
<td>This profile option enables the display of inactive Address Duplicate Identification configuration in Manage Enterprise Data Quality Matching Configurations UI page. This profile option works with the Data Quality Caching and Refresh Enabled (ORA_ZCQ_ENABLE_CACHE) profile option.</td>
</tr>
<tr>
<td>ORA_ZCQ_ENABLE_CACHE</td>
<td>Data Quality Caching and Refresh Enabled</td>
<td>500</td>
<td>This profile option enables the caching and refresh of frequently used data, such as server address, in the data quality matching processes.</td>
</tr>
</tbody>
</table>

### Trading Community Model Profile Options

Trading community profile options configure various features such as geographies, DaaS, address formats, and so on. The following table lists trading community profile options, descriptions, default values, and the impact these profile options have on different parts of the application.

To view the details of these profile options:

1. Click **Navigator > Setup and Maintenance** work area.
2. Click the Tasks menu and click **Search**. Search for **Manage Administrative Profile Values** task and open it.
3. Search using the profile option code.

To change the default values of these profile options:

1. Click **Navigator > Setup and Maintenance** work area.
2. Click the Tasks menu and click **Search**. Search for **Manage Administrative Profile Values** task and open it.
3. Search using the profile option code.
4. Change the profile value.

<table>
<thead>
<tr>
<th>Profile Option Code</th>
<th>Profile Option Name</th>
<th>Default Value</th>
<th>Description</th>
<th>Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>HZ_UPDATE_STD_ADDRESS</td>
<td>Update Standardized Addresses Enabled</td>
<td>No</td>
<td>Enable to allow the update addresses that are already standardized using postal information.</td>
<td>Application UI and REST</td>
</tr>
<tr>
<td>HZ_POST_IMPORT_GNR_IRR</td>
<td>Address Validation After Import</td>
<td>Y</td>
<td>Runs the Geography Name Referencing process after import.</td>
<td>File-based Import (used in high volume import)</td>
</tr>
<tr>
<td>HZ_ORGANIZATION_PROFILE_INDEX_THRES</td>
<td>Organization Profile Index Threshold</td>
<td>10</td>
<td>Specify the number of profile history records above which organization profile history information will be automatically denormalized into a secondary table for improved performance.</td>
<td>REST</td>
</tr>
<tr>
<td>HZ_INVOKE_OBJ_WF_ONTRACK</td>
<td>Child Entity Rollup Enabled</td>
<td>Yes</td>
<td>Enable rollup of the child entity changes to the root object during event tracking. This invokes the root object workflow whenever the child entities change.</td>
<td>Scheduled Process, Application UI, REST</td>
</tr>
<tr>
<td>HZ_GENERATE_PARTY_NUM</td>
<td>Party Number Generation</td>
<td>Auto numbering, update allowed</td>
<td>Select how a party number will be generated, and if you can update the number when creating or editing a person or organization party.</td>
<td>Application UI, REST</td>
</tr>
<tr>
<td>HZ_ENABLE_EVENT_TRACING</td>
<td>Composite Event Tracking Enabled</td>
<td>Yes</td>
<td>Enable composite event tracking for customer and contact entities. This tracks changes to the entities, and raises an event whenever there is a change to the entities.</td>
<td>Scheduled Process, Application UI, and REST</td>
</tr>
<tr>
<td>HZ_AUTO_SITE_NUMBERING</td>
<td>Site Use Identifier Generation</td>
<td>Auto numbering, update not allowed</td>
<td>Select how the site use identifier will be generated, and if you can update it when</td>
<td>Application UI and REST</td>
</tr>
<tr>
<td>Profile Option Code</td>
<td>Profile Option Name</td>
<td>Default Value</td>
<td>Description</td>
<td>Impact</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>HZ_AUTO_LOG_INTERACT</td>
<td>Call Interaction Logging Enabled</td>
<td>No</td>
<td>Enable adding phone calls to the interactions log when the call action is used.</td>
<td>Application UI and REST</td>
</tr>
<tr>
<td>ORA_HZ_RES_ENABLE_MNG</td>
<td>Enable End Dating Resource Manager Unconditionally</td>
<td>N</td>
<td>Allows organization membership end date for resource with managerial role without any validation. You need not move out all reports before moving manager out. Set the value to Y to enable this option.</td>
<td>Application UI, REST, and Import Management (only Resource object)</td>
</tr>
<tr>
<td>ORA_HZ_PURGE_MIN_AGE</td>
<td>Minimum Threshold Value for Purge of Inactive Data</td>
<td>30</td>
<td>Specify the minimum number of days after which inactive records are to be purged.</td>
<td>Application UI</td>
</tr>
<tr>
<td>ORA_HZ_INCLUDE_REGIONAL_COUNTRY</td>
<td>Regional Country in Address Formats Included</td>
<td>No</td>
<td>Enable address format functions to include regional country. You must set the value to Yes to include regional country.</td>
<td>Application UI</td>
</tr>
<tr>
<td>ORA_HZ_GEO_HIERARCHY</td>
<td>Maximum Number of Nodes that Each Parent Node Can Handle for Any Geography Element</td>
<td>100000</td>
<td>Specify the maximum number of nodes that each parent node can handle for any geography element.</td>
<td>Application UI and Import Management (only for geography object)</td>
</tr>
<tr>
<td>ORA_HZ_ENABLE_PURGE</td>
<td>Purging of Inactive Data Enabled</td>
<td>N</td>
<td>Enables the purging of data that are in inactive state using the Manage Party Purge Activities task. You must specify filter criteria to purge inactive data using Manage Party Purge Activities task.</td>
<td>Application UI</td>
</tr>
<tr>
<td>ORA_HZ_ENABLE_MPLCRI_ACTIVE_WORKER</td>
<td>Enable Current Active Worker Sync For MPLCRI Job</td>
<td>No</td>
<td>Enable current active worker sync for Maintain Party and Location Current Record Information batch job. If set to N, then current active</td>
<td>Scheduled Process</td>
</tr>
</tbody>
</table>
### Manage Profile Options

<table>
<thead>
<tr>
<th>Profile Option Code</th>
<th>Profile Option Name</th>
<th>Default Value</th>
<th>Description</th>
<th>Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_HZ_ENABLE_DAAS_GBGEGB</td>
<td>DaaS GBG</td>
<td>Yes</td>
<td>Enable the import of DaaS GBG geography information.</td>
<td>Scheduled Process, Application UI, and Import Management</td>
</tr>
<tr>
<td>ORA_HZ_DAAS_GEO_ENDPOINT</td>
<td>DaaS Geography Server Endpoint Information</td>
<td><a href="https://geo.daas.us-phoenix-1.ocs.oraclecloud.com">https://geo.daas.us-phoenix-1.ocs.oraclecloud.com</a></td>
<td>Specify the endpoint information, such as the host name and the port number, of the DaaS geography server.</td>
<td>Application UI and REST</td>
</tr>
<tr>
<td>HZ_TIMEZONE_POPULATION_ENABLED</td>
<td>Time Zone Population Enabled</td>
<td>No</td>
<td>Enable update of contact records with time zone details from the Populate Location Latitude and Longitude Information scheduled process.</td>
<td>Scheduled Process</td>
</tr>
<tr>
<td>HZ_SHARE_LOCATIONS</td>
<td>Location Sharing Mode</td>
<td>Share among all parties</td>
<td>Select if location can be shared among different persons and organizations.</td>
<td>File-based Import</td>
</tr>
<tr>
<td>HZ_RS_DEF_START_DATE</td>
<td>Resource Start Date Default</td>
<td>Current date</td>
<td>Select if the default start date will be the date when the resource is created, or the employment start date of the resource.</td>
<td>Application UI, Import Management, REST</td>
</tr>
<tr>
<td>HZ_RESOURCE_ALLOW_CUSTOMIZATION</td>
<td>Application Composer for Resource Desktop Pages Enabled</td>
<td>No</td>
<td>Enable access to Oracle CX Sales Resource desktop pages in the Application Composer.</td>
<td>Application UI</td>
</tr>
<tr>
<td>HZ_LANG_FOR_COUNTRY</td>
<td>Language for Country Display</td>
<td></td>
<td>Specify the default language used to translate the country name for international addresses. This is typically the language of the country where an item is mailed from.</td>
<td>Application UI and REST</td>
</tr>
<tr>
<td>HZ_GEOCODING_BATCH_SIZE</td>
<td>Geocoding Subprocess Batch Size</td>
<td>1000</td>
<td>Specify the maximum number of locations that each batch subprocess can handle for geocoding.</td>
<td>Scheduled Process</td>
</tr>
<tr>
<td>Profile Option Code</td>
<td>Profile Option Name</td>
<td>Default Value</td>
<td>Description</td>
<td>Impact</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------------</td>
<td>------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>HZ_GENERATE_PARTY_SITE</td>
<td>Party Site Number Generation</td>
<td>Auto numbering, update not allowed</td>
<td>Select how a party site number will be generated, and if you can update the site number when creating or editing a party site address.</td>
<td>Application UI, and REST</td>
</tr>
<tr>
<td>HZ_GENERATE_CUSTOMER</td>
<td>Customer Account Number Generation</td>
<td>Auto numbering, update not allowed</td>
<td>Select how a customer account number will be generated, and if you can update the number when creating or editing a customer account.</td>
<td>Application UI, and REST</td>
</tr>
<tr>
<td>HZ_GENERATE_CONTACT</td>
<td>Contact Number Generation</td>
<td>Auto numbering, update not allowed</td>
<td>Select how the contact number will be generated, and if you can update the number when creating or editing a contact.</td>
<td>Application UI, and REST</td>
</tr>
<tr>
<td>HZ_ENABLE_VO_SECURITY</td>
<td>Enable VO-Based Security</td>
<td>No</td>
<td>Enable VO-based security and override the default EO based security for all objects that use the secured PartyEO.</td>
<td>Application UI and REST</td>
</tr>
<tr>
<td>HZ_ENABLE_MULTIPLE_BUI</td>
<td>Multiple Business Units Enabled</td>
<td>Yes</td>
<td>Enable the multiple business units feature for Oracle Fusion Customer Relationship Management.</td>
<td>Application UI</td>
</tr>
<tr>
<td>HZ_ENABLE_ENTITY_EVENTS</td>
<td>Entity Level Events Enabled</td>
<td>Yes</td>
<td>Enable entity level events for account, contact, and household entities.</td>
<td>Scheduled Process, Application UI, and REST</td>
</tr>
<tr>
<td>HZ_ENABLE_CLICK_TO_DIAL</td>
<td>Click to Dial Enabled</td>
<td>Yes</td>
<td>Enable automated dialing by clicking on a phone number.</td>
<td>Application UI</td>
</tr>
<tr>
<td>HZ_ENABLE_BUSI_VALID</td>
<td>Business Key Validation Enabled</td>
<td>No</td>
<td>Enable the business key validation rule to check for duplicate contact points, such as mobile, URL, and Email.</td>
<td>REST</td>
</tr>
<tr>
<td>Profile Option Code</td>
<td>Profile Option Name</td>
<td>Default Value</td>
<td>Description</td>
<td>Impact</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>----------------------------------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>HZ_DEFAULT_NAME_STYLE</td>
<td>Name Style Default</td>
<td>Concatenated Name</td>
<td>Specify a default style for name formatting.</td>
<td>Scheduled Process, Application UI, and REST</td>
</tr>
<tr>
<td>HZ_DEFAULT_BU_CRM</td>
<td>Customer Relationship Management Business Unit Default</td>
<td>Vision Operations</td>
<td>Specify the default business unit for Oracle Fusion Customer Relationship Management.</td>
<td>REST</td>
</tr>
<tr>
<td>HZ_DEFAULT_ADDR_STYLE</td>
<td>Address Style Default</td>
<td>Postal Address</td>
<td>Specify a default style for address formatting.</td>
<td>Application UI and REST</td>
</tr>
<tr>
<td>HZ_AUTO_RES_HIERARCHY</td>
<td>Automated Resource Hierarchy Generation Enabled</td>
<td>Yes</td>
<td>Enable automated resource hierarchy generation when importing employee resources. If the option is set to No, then you have to run the ESS job to generate employee resource hierarchy.</td>
<td>File-based Import</td>
</tr>
<tr>
<td>HZ AUTOMATE_RESOURCE</td>
<td>Automated Resource Creation Enabled</td>
<td>No</td>
<td>Enable automatic creation of resource from employee creation process without user intervention.</td>
<td>Application UI</td>
</tr>
<tr>
<td>HZ_ALLOW_MULTIPLE_SE</td>
<td>Multiple Sell-to Addresses Enabled</td>
<td>No</td>
<td>Enable multiple sell-to address creation for a party, using the Data Import program. This profile option should not be used by customers.</td>
<td>Application UI, and REST</td>
</tr>
<tr>
<td>HZ_ADDRESS_DISABLE_ALTERNATE</td>
<td>Hide Alternate Address Names</td>
<td>No</td>
<td>Hide alternate names in the Address list of values. This option, when enabled, displays only the primary geography names for the address.</td>
<td>Application UI</td>
</tr>
<tr>
<td>HZ_GNR_NUM_OF_WORKERS</td>
<td>Number of workers for a given Geography Name Referencing request</td>
<td>1</td>
<td>Determines the number of sub-processes for Validate Geographies of Addresses Against Master Geographies scheduled process.</td>
<td>Scheduled Process</td>
</tr>
</tbody>
</table>
### Manage Profile Options

<table>
<thead>
<tr>
<th>Profile Option Code</th>
<th>Profile Option Name</th>
<th>Default Value</th>
<th>Description</th>
<th>Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZCA_SA_AUTO_ASSIGN_O</td>
<td>Sales Account Automatic Assignment on Update Enabled</td>
<td>No</td>
<td>Enable automatic territory based assignment processing after a sales account is updated.</td>
<td>Scheduled Process, Application UI, and REST</td>
</tr>
</tbody>
</table>
19 Duplicate Identification Setup

Overview of Duplicate Identification

Matching is a process that identifies the potential duplicates for account, contact, and address. You can identify the potential duplicate records in real-time when you create a customer record, and in batch mode for existing records.

Oracle provides the data matching solution for Oracle Cloud applications through integration of Oracle Enterprise Data Quality (EDQ). EDQ is a complete data quality product with capabilities such as profiling, standardization, matching and merging, which is also available as a standalone product.

Defining data matching involves setting up two components, matching and address cleansing. As part of implementing these components, you must perform the following related setup tasks in the Setup and Maintenance work area from the Data Quality Foundation functional area of the Customer Data Management offering:

- Manage Server Configurations
- Manage Enterprise Data Quality Matching Configurations

**Note:** You must set up the server configurations prior to implementing EDQ matching.

Enterprise Data Quality Server Configurations

Enterprise Data Quality (EDQ) server configurations are predefined configurations for EDQ integration. You can enable and disable a data quality management operation by selecting or deselecting the related EDQ server configuration.

EDQ Real-Time and Batch Basic Match Server is the predefined server configuration available for EDQ.

**EDQ Real-Time and Batch Basic Match Server**

Enable this configuration if you want to use the matching capabilities. Enabling this configuration lets you benefit from both real-time and batch matching features. Real-time matching is used to prevent entry of duplicate records. Batch data matching is used for identifying duplicates of existing records.

Enterprise Data Quality Matching Configurations

Enterprise Data Quality (EDQ) matching configurations comprise attributes and parameters for real-time and batch matching of entities to prevent duplicate entries and identify existing duplicates. EDQ real-time and batch matching are available for account and contact entities. You have the option of using either the predefined ready-to-use configuration or copying and adapting it to your address matching requirements.

The predefined EDQ matching configurations applicable for both real-time and batch matching are:

- Account Duplicate Identification
- Contact Duplicate Identification
These configurations are used to identify the duplicate account and contact entries. You can review and edit these predefined matching configurations to optimize the matching functionality to meet your needs.

**EDQ Matching Process**

In EDQ matching process, the record added or updated to the application for comparison is called a driver record. And, the records that are compared with the driver record are called the candidate records. Driver records are compared with each other, but candidate records are never compared with other candidates. The EDQ real-time matching process compares a single driver record against many candidates and returns possible duplicate records based on matching attributes and threshold. The batch matching process compares all driver records of the same type, such as account and contact, and identifies all possible matches within these sets of records.

The batch matching process runs in two modes, full batch and incremental batch. While the full batch mode matches all records against each other, the incremental mode matches a subset of records against all of their selected candidates.

In batch matching, separate matching templates are provided that lets you specify different match rules. For example, you may want to minimize user intervention of adding customers in front end applications, and perform an exhaustive match on a regular basis.

The EDQ matching process for real-time and batch matching runs the EDQ Cluster Key Generation service and EDQ matching service for duplicate identification. The EDQ Cluster Key Generation service is called whenever a record is added or updated in an application. This service generates keys for records added as well as for the records that are updated in the application. These generated keys are stored in the application, which are then used to select the candidate records that may match to the data in the application.

The selected candidate records along with the driver record are returned to the EDQ matching service. Then, this service examines the records and decides which of the candidate records are a good match with the driving record. Once EDQ matching service arrives at the best match, it assigns a score to every duplicate record identified based on the strength of the match.

For more information about the EDQ matching process, see the Oracle Enterprise Data Quality Customer Data Services Pack Matching Guide at

http://docs.oracle.com/cd/E48549_01/doc.11117/e40737/toc.htm

**Match Attributes**

Match attributes define the attributes that are used for real-time and batch matching of the account and contact entities to identify duplicate entries. You use two types of attributes for matching:

- **Match Identifier**: Specifies the EDQ attribute that you want to use for matching
- **Application Attributes**: Specifies the application attribute that you want to use for matching

You can map the attributes in application with the corresponding EDQ attributes to create an attribute mapping. For example, for the Name EDQ attribute, you can select the Org.OrganizationName as the corresponding Organization attribute to create a mapping. You can define such attribute mappings for real-time matching, batch-data matching, or both.

When you map the attributes in the application with the corresponding EDQ attributes, you create a matching configuration setting for identifying duplicate entries. These settings are stored as matching keys in the application. Whenever you change the attribute mappings, you must regenerate matching key values for the new or updated accounts and contacts. You can regenerate matching key values using the **Rebuild Keys** option in the Edit Matching Configuration page.
**Match Configuration Parameters**

Matching configuration parameters are system-level parameters that control aspects of the data quality matching services.

The following parameters control matching operations for identification of duplicate entries such as account and contact in the database, between database and sets of data, such as import batches, or within sets of data to resolve them from merging or linking.

**Score Threshold**
- **Parameter Value**: Between 0 and 100. Default Value: 90
- **Parameter Description**: Specifies the score above which the matched records are returned by the matching service. Records equal to or greater than the score are considered as matches and the records with scores less than the threshold are rejected.

**Match Results Display Threshold**
- **Note**: This match configuration parameter is enabled only for real-time matching.
  - **Parameter Value**: Between 0 and 100. Default Value: 10
  - **Parameter Description**: Controls the number of matched records that are returned by the real-time matching.

**Preview Configuration**
The Preview Configuration option lets you enter the following parameters to identify and view the duplicate matching records in real-time without rebuilding the keys.
  - **Cluster Key Level**: Returns records based on the cluster key level.
  - **Score Threshold**: Returns records based on score threshold.
  - **Maximum Candidates**: Returns records based on maximum candidates.
  - **Match Results Display Threshold**: Returns records based on the match results display threshold value.

**Review Configuration Results**
The Review Configuration Results option lets you check if the input account or contact entered for matching in the Edit Matching Configuration page returns the expected matched account or contact after the rebuilding of keys. Alternatively, in the Review Configuration Results page, you can enter the attribute information for one or more of the following matching configuration parameters that you want to match:
  - **Cluster Key Level**: Returns records based on the cluster key level.
  - **Score Threshold**: Returns records based on score threshold.
  - **Maximum Candidates**: Returns records based on maximum candidates.
  - **Match Results Display Threshold**: Returns records based on the match results display threshold value.

**How You Manage Level of Indirection**
You can control the level and number of indirect duplicates for a driver record using a user defined profile option ORA_ZCQ_LEVEL_OF_INDIRECTION. This profile option lets you include indirect duplicates. For example, look at a duplicate set having possible drivers A, C and candidates B, D as follows:
Here, we delete duplicate pair C-D because its winner C is a matched record of A-C. Hence, we lose D as a potential duplicate. This would possibly be identified as a duplicate only in the next batch run. However, we know that D is an indirect duplicate of A. If we set up the value of the profile option ORA_ZCQ_LEVEL_OF_INDIRECTION as 1, you can consider D as a matched record in the first batch run itself. Therefore, the duplicate sets would be as follows:

A - B
A - C
A - D (because D is now an indirect duplicate of A).

Let's understand how the profile option ORA_ZCQ_LEVEL_OF_INDIRECTION controls the level of indirect duplicates with another example where we have the duplicate pairs as A-B, A-C, C-D, D-E, and E-F. In this case, setting the profile option value as 1 would mean that only the first level of indirect duplicates which is C-D is considered as part of A's duplicate set, causing the A-D pair to be formed. However, if we set the profile option value as 2, it would also extend to second level of indirection. Therefore, A-D and also A-E would be the duplicate pairs identified because of the A-C, C-D, and D-E indirection sequence.

To control the level and thereby number of indirect duplicates for a driver record using the profile option ORA_ZCQ_LEVEL_OF_INDIRECTION, perform the following steps:

1. In the Setup and Maintenance work area, go to the Manage Administrator Profile Values task.
2. On the Manage Administrator Profile Values page, search for and select the profile option.
3. In the Profile Values section, click Add. A new row is added for you to specify the following conditions:
   - **Profile Level**: Specify the level at which the profile value is to be set. Select Site.
   - **Profile Value**: Select or enter the value, such as 1 or 2, depending on the required level of indirection.
4. Click Save and Close.

**Note:** Changes in the profile values take effect for a user on the next sign in.

Manage Enterprise Data Quality Matching Configurations

You can perform the following tasks as part of managing Enterprise Data Quality (EDQ) matching configurations.

- Copying a predefined Enterprise Data Quality matching configuration
- Editing a copy of the predefined Enterprise Data Quality matching configuration
Copy a Predefined Enterprise Data Quality Matching Configuration

To copy or make a duplicate of a predefined Enterprise Data Quality matching configuration, complete these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Manage Enterprise Data Quality Matching Configurations
2. On the Manage Enterprise Data Quality Matching Configurations page, select the Account Duplicate Identification match configuration, and click Duplicate.
3. Click Yes in the Warning dialog box.
4. Click Save to save the copy of the predefined configuration.

   **Note:** You must save the copy of the predefined configuration, if you want to edit it.
5. Repeat Steps 2 to 4 to create copies of the predefined configuration for the Contact Duplicate Identification match configurations.

Edit a Copy of the Predefined Enterprise Data Quality Matching Configuration

To edit a copy of the predefined Enterprise Data Quality matching configuration, complete these steps:

**Note:** You can’t edit the predefined Enterprise Data Quality configuration. You can only make a copy of it and edit it by following this procedure.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Manage Enterprise Data Quality Matching Configurations
2. On the Manage Enterprise Data Quality Matching Configurations page, select the copy of Account Duplicate Identification match configuration that you created in Copying a Predefined Enterprise Data Quality Matching Configuration section, and click Edit.
3. Select the Active check box to set the Account Duplicate Identification match configuration as the active configuration.

   **Note:** By default, the predefined configurations are always set to active. If there are one or more copies of the predefined configurations, then you can set any of them to active by selecting the Active check box. At any given point in time, only one configuration can be active.

   **Note:** Also, note that the Usage option is set to Both, which indicates that the configuration is for both real-time and batch matching.

   **Note:** You must rebuild keys before activating a new or copied configuration. For more information about Rebuilding Keys, see the Managing Key Generation section in this chapter.
4. Click Yes in the Warning dialog box to set this configuration as active.

5. In the Match Attributes section, perform the following steps:
   a. Select a row to edit the mapping, and click the drop-down button for the selected row.
   b. Select the relevant attribute from the list.
   c. If the list doesn't display the attribute that you want for the mapping, then click Search to search for the attribute.
   d. Select the relevant option and click OK.

6. Select a Cluster Key Level option. For example, select Typical.

7. In the Score Threshold field, enter a value between 0 and 100, such as 85. In the Match Results Display Limit field, enter a value between 0 and 100, such as 20.

   | Note: The Match Results Display Limit option isn't available for Batch.

8. Click Save.

   | Note: You can see the Automerge Threshold and Autolink Threshold values in the Batch tab. You can change these values in the Manage Customer Hub Profile Options page or override these values while creating the duplicate identification batch criteria rules.

**Related Topics**
- Create Duplicate Identification Batches and Define Subset Rules
- Customer Hub Profile Options
- Automerger

**Unique Identifiers and Elimination Identifiers**

The duplicate identification setup process lets you configure up to three unique identifiers and three elimination identifiers as part of your matching configuration. Unique identifiers and elimination identifiers are special match tokens that you can use for cases where the value of a single attribute conclusively determines whether a set of records are duplicates, without needing to consider any other attribute values. The meanings of these Unique identifiers and elimination identifiers fields are as follows:

- **Unique Identifiers** - any records that have the same non-null value for an attribute that has been defined as a unique identifier are automatically identified as duplicates, regardless of any other attribute values.
- **Elimination Identifiers** - any records that have different non-null values for an attribute that has been defined as an elimination identifier are never identified as duplicates, regardless of any other attribute values.

Both unique identifiers and elimination identifiers only evaluate non-null values, and matching is still possible between records that have a mixture of populated and null elimination identifier or unique identifier values. For example, two records may be identified as duplicates when one record has a value in an elimination identifier field, the other record has no value (null) for the elimination identifier field, and the records also match on other attributes such as name and address.

To better understand the difference between unique identifiers and elimination identifiers, consider the following requirements:

- We will always consider contacts that have the same email address to be duplicates. (This requirement could be handled with a unique identifier field)
• We will never consider contacts that have different email addresses to be duplicates. (This requirement could be handled with an elimination identifier field)

If you choose to use Custom Scoring as part of your duplicate identification configuration, keep the following in mind:

• Records with different non-null elimination identifier values are never identified as duplicates, regardless of any scoring rules. Elimination identifier fields should not be included in custom scoring rules, and adding elimination identifier fields to your custom scoring rules may lead to unpredictable or inconsistent matching results.

• The custom scoring rules for unique identifier fields must always be defined as a single-value exact match rule with a score of 100. The standard matching configuration comes seeded with default custom scoring rules for the three available unique identifier fields, and these default custom scoring rules should not be modified. Unique identifier fields are specifically designed for their function and adding unique identifier fields to any other custom scoring rules may lead to unpredictable or inconsistent matching results.

Manage Custom Match Rules and Scoring

This topic describes how to enable the custom match rules and scoring functionality.

Use the following procedure to enable custom match rules for account and contact. Note that custom match rules are available only for account and contact.

1. In the Setup and Maintenance work area, go to the following:
   o Offering: Customer Data Management
   o Functional Area: Data Quality Foundation
   o Task: Manage Enterprise Data Quality Matching Configurations

2. On the Manage Enterprise Data Quality Matching Configurations page, drill down on the predefined or the user-defined matching configuration, for which you want to enable or disable custom match rules and scoring.

3. Scroll down to the Scoring Type drop-down list and select Custom from the Real-Time or Batch tabs on the Edit Match Configuration page.

4. Click Save or Save and Close

Create Custom Match Rules

You can use the custom match rule and scoring functionality to create your own match rules and scores based on your business requirements.

Use the following procedure to create custom match rules.

1. In the Setup and Maintenance work area, go to the following:
   o Offering: Customer Data Management
   o Functional Area: Data Quality Foundation
   o Task: Manage Enterprise Data Quality Matching Configurations

2. On the Manage Enterprise Data Quality Matching Configurations page, drill down on the predefined or the user-defined matching configuration for which you want to create or update predefined rules.

3. Click Manage Match Rules on the Edit Match configuration page.
4. On the Manage Match Rules page click New. Alternatively, you can click Duplicate to create a new rule based on an existing predefined or user-defined match rule.

5. Enter the following values for the newly created or copied match rule:
   - **Rule Name**: The name of the new rule.
   - **Match Rule Score**: The score that you assign to the rule. The value must be between 1 and 100.
   - **Rule Attribute**: The standard or predefined attributes that must be used in the custom match rules. Ensure that the syntax and spelling are exact.

6. Click **Save** or **Save and Close**.

Considerations for Selecting Sources of Match Rules and Scoring

The Customer Data Quality application comes with two options for match rules and scoring, predefined match rules (EDQ match rules) and custom match rules (Customer Data Management match rules). You can use a drop-down button on the Enterprise Data Quality Matching Configuration page to select the match rules and scoring option best suited for your business requirements.

The predefined EDQ match rules include a single, view-only matching rule for each object such as account and contact. These match rules can't be edited, scores can't be changed, and no new rules can be added.

In case the predefined match rules aren't suitable for your business requirements, you should enable custom match rules and scoring. You should be able to turn on custom scoring by selecting Custom from the Scoring Type drop-down list on the Manage Enterprise Data Quality Matching Configurations UI page. You can use this functionality to create your own match rules and scores.

How You Configure Synonyms and Skip-words Dictionary

You can use synonyms and skip-words to improve the quality of match results. Synonyms help you to map words that are used interchangeably in your industry. For example, Tech maybe mapped to Technology. Skip-words help reduce noise words such as titles like Mr or Ms in names. These synonyms and skip-words dictionaries are pre-defined as lookup types. You can configure these dictionaries by modifying the lookup types. These lookup types let you tailor the match results by word replacement patterns that may be unique to your application.

You can add, edit, or remove words or patterns in the following out of the box lookup types:

- **ORA_ZCQ_CS_ACC_MAPPING_DATA**: Modify this lookup type to update the mapping of account data. For example, `Tech` indicates Technology.
- **ORA_ZCQ_CS_CON_MAPPING_DATA**: Modify this lookup type to update the mapping of contact data. For example, `Abbi` indicates Abigail.
- **ORA_ZCQ_CS_ADD_MAPPING_DATA**: Modify this lookup type to update the mapping of address data. For example, `Rd` indicates Road.
- **ORA_ZCQ_CS_ACC_STRIP_DATA**: Modify this lookup type to update the list of strip words for account data. For example, add `org` to the list to remove it during data matches.
• **ORA_ZCQ_CS_ADD_STRIP_DATA**: Modify this lookup type to update the list of strip words for address data.

• **ORA_ZCQ_CS_CON_STRIP_DATA**: Modify this lookup type to update the list of strip words for contact data. For example, add Mr. or Ms. to the list to remove them during data matches.

**Note:** These lookups don’t support these special characters: ! $ % ’ * - : ; @

You can access the lookup types by following these steps:

1. Sign in as a setup user such as, Sales Administrator, Master Data Management Application Administrator, or Application Implementation Consultant.
2. Click **Navigator > Setup and Maintenance** work area.
3. Click the Tasks menu and click Search. Search for **Manage Standard Lookups** task and open it.
4. Type **ORA_ZCQ_CS%** in the Lookup Type field and click Search.
   A list of lookup types is displayed.
5. Click to select a lookup type.
   The details of the lookup are displayed. You can add, delete, or modify the lookup values as per your requirement.

### Key Generation

The EDQ matching process for real-time and batch matching makes use of the EDQ Cluster Key Generation service and the EDQ matching service for duplicate identification. Successful key generation is critical to duplicate identification. Key generation identifies similar parties and assigns a key to each. When a matching configuration is made active, the application passes a set of keys (subset of parties) to the EDQ matching service to process for duplicate identification.

The EDQ Cluster Key Generation service must be run whenever a record is added or updated in the application. This service generates keys for records added as well as for the records that are updated in the application. If keys aren't generated, duplicate identification fails.

### How You Configure Key Generation

The duplicate identification process uses matching keys, which must be maintained through a key generation process. You need to set up a recurring, incremental key generation job for each active data quality matching configuration for batch duplicate identification. You also may want to configure real-time key generation for immediate matching of new data as soon as new data is entered.

### How You Setup Recurring Incremental Key Generation (Required)

You can schedule incremental key generation for an active matching configuration using the schedule key generation option on the Edit Matching Configuration page. This generates keys for records that don’t have a key or if the key time stamp is older than that of the records. You must incrementally generate matching key values for the new or updated accounts and contacts.

To assure your duplicate identification processes use up-to-date matching keys, check if the following setup tasks have been completed.

1. In the Setup and Maintenance work area, go to the following:
   - **Offering: Customer Data Management**
Chapter 19
Duplicate Identification Setup

1. Click the name of the required active match configuration.
2. Click Scheduled Key Generation.
3. Click Advanced.
4. Select Using a schedule option in the Advanced Options section.
5. Specify the frequency, the start date, and end date to run the scheduled process.
   - You may want to select a distant end-date to reduce how often you must run this task and to help assure that the recurring schedule doesn't lapse.
6. You may want to select a distant end-date to reduce how often you must run this task and to help assure that the recurring schedule doesn't lapse.
7. You may want to select a distant end-date to reduce how often you must run this task and to help assure that the recurring schedule doesn't lapse.

How You Specify Real-time Key Generation (Optional)
You may want to configure keys to be generated for immediate matching of new data as soon as new data is entered. For example, different users may be entering duplicate records at nearly the same time and you may want the keys to be generated immediately. Real-Time key generation process is available to handle such scenarios.

Follow these steps to enable real-time key generation:
1. Search and navigate to the Manage Administrator Profile Values task.
2. Search for the ORA_ZCQ_ENABLE_REALTIME_KEYGEN profile option.
3. Set the Site level profile option value to Yes.
4. Click Save and Close.

Best Practices for Real-Time Key generation
Here are guidelines to help you decide if real-time key generation is right for your business needs:

- Use Real-Time key generation only if an appropriately scheduled incremental key generation process doesn't support your business process needs.
- Certain processes, such as file import and batch address cleansing, don't trigger real-time key generation events. Real-time key generation isn't sufficient to replace recurring incremental key generation, but it may be used as a complement for certain business scenarios.
- If possible, disable update events for higher-volume data creation and update processes, such as web service-based data integration flows.

To disable high-volume user accounts from generating update events:
1. Search and navigate to the Manage Administrator Profile Values task.
2. Search for the ZCA_PUBLIC_BUSINESS_EVENTS profile option.
3. Click Actions > New in the Profile Values section.
4. Specify the following values:
   - Set the Profile Level to User.
   - Select the User Name for which you want to suppress business events.
   - Set the Profile Value to No.
5. Click Save and Close.
How You Rebuild Keys
You must rebuild keys before activating a new configuration. You must rebuild keys if you change match configuration mappings or if you think that the keys are no longer valid because of updates to the records. You can regenerate matching key values using the Rebuild Keys option in the Edit Matching Configuration page.

How You Specify Real-time and Batch Key Generation Options
You can specify different key generation options for batch matching and real-time matching. Take for example the cluster key level parameter that has the values, limited, typical, or exhaustive. It's possible to select one value of this parameter, say limited, for batch matching and another, say exhaustive, for real-time matching, depending on how tightly you want the data quality engine to match records.

How You Review Key Generations Status
You can search for key generation jobs and review the status of each key generation job on the Manage Key Generation page. The following table describes the various possible key generation statuses for a matching configuration.

<table>
<thead>
<tr>
<th>Key Generation Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>Key generation for the configuration is required.</td>
</tr>
<tr>
<td>Processing</td>
<td>Key generation for the configuration is in progress.</td>
</tr>
<tr>
<td>Review Required</td>
<td>Key generation for this configuration needs review.</td>
</tr>
<tr>
<td>Ready</td>
<td>Key generation for this configuration is complete.</td>
</tr>
</tbody>
</table>

Identify Duplicates in Real-Time Using REST APIs and SOAP Web Services
This topic describes how to identify duplicates using REST APIs and SOAP Web services leveraging the Enterprise Data Quality (EDQ) engine.

Before you begin, perform these steps:
1. Enable **EDQ Real time and Batch Basic Match Server** in the Manage Data Quality Server Configurations page.
2. Identify the configuration code for the EDQ match configuration that you want to perform from the Setup and Maintenance work area by going to the following:
   - Offering: Customer Data Management
How You Identify Duplicates Using REST APIs

To identify duplicates for accounts (organizations) in real-time using REST API, use the following URL:

```
crmRestAPI/resouces/latest/accounts/action/findDuplicates
```

To identify duplicates for contacts (persons) in real-time using REST API, use the following URL:

```
crmRestAPI/resouces/latest/contacts/action/findDuplicates
```

For more information on findDuplicates, see the Identify Duplicate Accounts and Contacts section in the REST API for CX Sales and B2B Service guide. You can use your proprietary, or a third party, REST API client to use the findDuplicates custom action to identify duplicates.

For more information on working with REST API client, see the Work with your REST Client topic in the REST API for CX Sales and B2B Service guide.

How You Identify Duplicates Using SOAP Web Services (Deprecated)

To identify duplicates in real-time using SOAP Web services (deprecated), use the following URL:

```
https://servername/crmService/DQRealTimeService?WSDL
```

For more information on DQRealTimeService, see the Trading Community Real Time Data Quality section in the Oracle CX SOAP Web Services for CX Sales and B2B Service guide.

You can use your proprietary, or a third party, SOAP Web services client to use the DQRealTimeService to identify duplicates. Enter the URL and run the relevant operations listed here with appropriate payloads:

- matchPerson: Use this operation to identify duplicate persons.
- matchLocation: Use this operation to identify duplicate locations.
- matchOrganization: Use this operation to identify duplicate organizations.

For more information on Invoking SOAP Web Services, see the Invoking SOAP Web Services chapter in the Oracle CX SOAP Web Services for CX Sales and B2B Service guide.

FAQs for Duplicate Identification

What's the difference between matching configurations and matching server configurations?

Matching configurations include parameters that can be set at the matching configuration level and modified depending on cleansing strategy, data, and result requirements. You can use these configurations during real-time matching to prevent duplicate entries and during batch matching to identify existing duplicates.
Matching server configurations provide the address and port of the data quality server used to process match requests. These configurations show both matching configuration and server configuration level parameters along with their type and cardinality. The parameters set at the server level are applicable to all the matching configurations.

What's the difference between real-time duplicate prevention and duplicate identification?

Real-time duplicate prevention identifies all possible duplicate records that may exist in the database for an entered record. This prevents entering of duplicate entities, such as organization, person, or location, into the database. Duplicate identification identifies potential duplicate entities already existing in the database using batch matching, and resolves the actual duplicates by merging or linking.
20 Address Cleansing Setup

Overview of Address Cleansing

Address cleansing is a process that corrects and validates address data, based on postal requirements. Address cleansing is a process that corrects and enhances an address. For example, you can correct misspelled city or street names; add missing elements, like full postal code or state. Likewise, if you enter valid values for city, state, and country, the data quality functionality automatically supplies a postal code value.

Note that for address verification you require a separate license for the Oracle Address Verification Cloud Service. The address verification functionality is available:

- Real-time, on the Create Organization (Create Account) or Create Person (Create Contact) UIs
- In batch mode in the Address Cleansing work area
- During the import of address data

Address Cleansing Configurations

Address cleansing configurations comprise attributes and parameters for real-time and batch cleansing of addresses. You have the option of using either the predefined configuration shipped out-of-the-box or copying and adapting it to your address cleansing requirements. The predefined real-time address cleansing configuration is named as Address Verification and when done in bulk it's named as Address Cleansing. As part of defining and managing cleansing configurations, you can review and edit the predefined cleansing configuration.

Address verification includes an online, interactive service to cleanse and validate addresses during the data entry process either through a UI or any other service creating address data into the registry. The real-time address cleansing service parses the input address and validates it against the country-specific postal address reference databases, such as United States Postal Service (USPS), Canada Post, and so on. The real-time address cleansing service runs in two modes:

- Verify: The verify mode lets you parse, verify, cleanse, transliterate, and format the input address data. This mode checks the reference data and returns the best match (1 to 1).
- Search: The search mode lets you search all installed data and return multiple results (1 to Many).

Address cleansing of bulk records performs address cleansing, verification, and standardization for a subset or entirety of the address records in the registry, or as part of a data import process. Batch address cleansing service can only be run in the Verify mode that parses and cleanses the input address data and enables output to be displayed in either native or Latin characters.

Note: For more information on address verification, see the Overview of the Address Verification Setup Process topic in the Related Topics section.
Cleansing Attributes Mapping

The mapping of the DaaS cleansing attributes with the corresponding application data attributes to create cleansing configurations is called cleansing attributes mapping. This product provides the following attributes for address cleansing:

- **Address Attribute:** The application attribute used to describe the address submitted for address cleansing.
- **DaaS Attribute:** The DaaS attribute that's mapped with the application address attribute for cleansing.

You can determine what input address attribute you want to map to the DaaS attribute for address cleansing. A DaaS attribute is used to describe a distinct item of information that relates to a record. For example, a City attribute might describe the city details of a Customer record. Once the mapping is established, the input address is verified, validated, and corrected.

In this example, the sample input data contains a part of the postal address and lacks the complete street address and state information as shown in the following table.

<table>
<thead>
<tr>
<th>Input Address Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address1</td>
<td>8500 Normandale Lake Suite 710</td>
</tr>
<tr>
<td>City</td>
<td>Bloomington</td>
</tr>
<tr>
<td>Postal Code</td>
<td>55437</td>
</tr>
</tbody>
</table>

After the mapping, the input address is verified, validated, and corrected. The cleansed output address data is shown in the following table.

<table>
<thead>
<tr>
<th>Output Address Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address1</td>
<td>8500 NORMANDALE LAKE BLVD</td>
</tr>
<tr>
<td>Address2</td>
<td>STE 710</td>
</tr>
<tr>
<td>City</td>
<td>BLOOMINGTON</td>
</tr>
<tr>
<td>State</td>
<td>MN</td>
</tr>
<tr>
<td>Postal Code</td>
<td>55437-3813</td>
</tr>
</tbody>
</table>
Cleansing Configuration Parameters

Cleansing configuration parameters are system-level parameters that control aspects of the cleansing services. The address cleansing configuration includes real-time and batch cleansing configuration parameters.

The following parameters control real-time and batch address cleansing, standardization, and validation operations for a subset or entirety of the address records in the database, or as part of a data import process.

**Default Country**
- Parameter Description: Used to specify the country to cleanse the address, if no identifiable country can be found in an input address.

**Output Casing**
- Parameter Value: Upper case, Lower case, Mixed case. Default Value: Mixed
- Parameter Description: Used to specify the letter case for an output address.

**Minimum Verification Level**
- Parameter Value: Between 1 and 5. Default Value: 4
- Parameter Description: Used to specify the level of verification to which the input data matches the available reference data during the verification process.

**Minimum Verification Score**
- Parameter Value: Between 0 and 100. Default Value: 80
- Parameter Description: Used to specify the similarity between the address entry and closest reference data match as a percentage between 0 (no match) and 100 (perfect match).

**Processing Mode**
- Parameter Value: Search, Verify. Default: Search
- Parameter Description: Used to specify if the returned cleansed address is the best match (verify) or a set of close matches (search). This option is available only for real-time processing.

**Correct Partially Verified Addresses**: Determines if you want to correct the addresses entry that are partially verified.

**Correct Ambiguous Addresses**: Determines if you want to correct the unclear addresses entry and resolve it to the correct address.

**Return Verified Address in Native Script**: Displays verified addresses in the native script of the country selected in the Default Country field.

**Review Configuration Results**

The Review Configuration Results option lets you check if the input address entered for cleansing in the Edit Cleansing Configuration page returns the expected cleansed address. Alternatively, in the Review Configuration Results page, you can enter the attribute information for one or more of the following cleansing configuration parameters that you want to cleanse:

- Minimum Verification Level: Returns records based on the minimum verification level.
- Minimum Verification Score: Returns records based on the minimum verification score.
- Processing Mode: Returns records based on the processing mode.
Managing Address Cleansing Configurations

You can perform the following tasks as part of managing address cleansing configurations:

- Copying a predefined address cleansing configuration
- Editing a copy of the predefined address cleansing configuration

**Copy a Predefined Address Cleansing Configuration**

To copy or make a duplicate of a predefined address cleansing configuration, complete these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Manage Address Cleansing Configurations
2. On the Manage Address Cleansing Configurations page, select the **Address Cleansing** configuration, and click **Duplicate**.
3. Enter a name in the Name field and click **Save** to save your changes.

**Edit a Copy of the Predefined Address Cleansing Configuration**

To edit a copy of the predefined address cleansing configuration, complete these steps:

**Note:** You can't edit the predefined address cleansing configuration. You can only make a copy of it and edit it by following this procedure.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Manage Address Cleansing Configurations
2. On the Manage Address Cleansing Configurations page, select the **Address Cleansing** configuration and click **Edit**.
3. Select the **Active** check box to set the address cleansing configuration as the active configuration.
Note: By default, the predefined configurations are always set to active. If there are one or more copies of the predefined configurations, then you can set any of them to active by selecting the Active check box. At any given point in time, only one configuration can be active.

Note: Also, note that the Usage option is set to Both, which indicates that the configuration is for both real-time and batch matching.

4. Click Yes in the Warning dialog box to set this configuration as active.
5. In the Cleansing Attributes Mapping section, select an attribute in the Address column, enter a corresponding attribute in the Attributes column, and then map it with the corresponding attributes in the Attributes column to create an attribute mapping.
6. In the Cleansing Configuration Parameters section, perform the following tasks:
   a. In the Default Country list, select the relevant country name.
   b. In the Output Casing list, select Upper Case to print the address in upper case.
   c. In the Minimum Verification Level list, select 3-Verified to Thoroughfare Level.
   d. In the Minimum Verification Score list, select 80.
   e. If you’re configuring real-time processing, select Search or Verify for Processing Mode. This option isn’t available for batch processing.
   f. Select the Correct Partially Verified Addresses.
   g. Select the Correct Ambiguous Addresses.
   h. Select Return Verified Address in Native Script to display verified addresses in the language native to the country selected in sub step a.
7. Click Save to save your changes.

How You Cleanse Addresses in Real-Time Using Web Services

This topic describes how to cleanse addresses using Web services leveraging the Address Verification Cloud Service. Before you start, perform these steps:

1. Identify the configuration code for the EDQ cleansing configuration that you want to use from the Setup and Maintenance work area by going to the following:
   o Offering: Customer Data Management
   o Functional Area: Data Quality Foundation
   o Task: Manage Address Cleansing Configurations

   The configuration code is displayed in the Manage Address Cleansing Configurations page.

2. To cleanse addresses in real-time using Web services, use the following URL:
   https://servername/crmService/DQRealTimeService?WSDL
How You Enable Search Mode for Address Verification Cloud Service

The Address Verification Cloud Service comes with two processing modes, Verify and Search. You can use this functionality to verify an address in real-time while entering information on the create or edit pages of Accounts or Contacts.

Out of the box, the Verify mode is enabled. When the Verify mode is enabled and you verify addresses in real-time on the create or edit pages of Accounts or Contacts, the service returns a single verified address that matches the address information you entered on the page.

The search mode is available in address cleansing configuration as a processing mode. When the Search mode is enabled and you do real-time address verification on the Create or Edit Accounts or Contacts page, the service returns a list of the suggested verified addresses that match the address information you entered. You can then select the appropriate address from the list.

Configure Address Verification Processing Mode

You can configure the address verification process mode by performing the following tasks:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Manage Address Cleansing Configurations

2. On the Manage Address Cleansing Configurations page, click Address Cleansing.
   
   The Edit Address Cleansing Configuration: Address Cleansing page appears.

3. Select Search from the Processing Mode list in the Cleansing Configuration Parameters section.

   **Note:** You can select either Verify or Search mode from the Processing Mode list according to your requirements. Select Verify mode if you want only one verified address to be returned while verifying an address on the Create Accounts or Create Contacts page. Select Search mode to get a list of the suggested verified addresses that match the address you entered so that you can select the appropriate address from the list.

4. Click Save and Close.
Verify Search Mode on Account or Contact Creation Page

You can verify the functionality of the Search mode while creating a new account or contact. Perform the following steps to verify an address in the search mode while creating a new account:

1. Navigate to Accounts work area.
2. Click **Create Account**.
3. Enter Address Line 1, City, and State of the account that you want to create on the Create Accounts page.
4. Click **Verify Address**.

   **Note:** If you click Verify Address after populating all the fields in the Address section of the Create Address page, you will get only one verified address with the complete match.

5. Select the correct address by clicking **Select** for the appropriate address from the list of suggested verified addresses.
6. Click **OK**. When you click OK the selected address gets populated in the Address section of the Create Account page.
7. Enter account details on the Create Account page.
8. Click **Save and Close**.

FAQs for Address Cleansing Setup

What's the difference between cleansing configurations and cleansing server configurations?

Cleansing configurations include parameters that can be set at the cleansing configuration level and modified depending on cleansing strategy, data, and result requirements. You can use these configurations to cleanse address during data entry, and to cleanse and validate existing addresses to ensure data accuracy.

Cleansing server configurations provide the address and port of the data quality server used to process cleanse requests. There are no server configuration parameters for cleansing.

What's the difference between real-time address cleansing and batch address cleansing?

Real-time address cleansing is an online, interactive service to cleanse and validate addresses during the data entry process.

Batch address cleansing cleanses and validates addresses that already exist in the database or are imported into it.
21 Duplicate Resolution Setup

Duplicate Resolution Simplified Profile Options

How You Setup Duplicate Resolution Simplified Profile Options

You can configure the duplicate resolution simplified profile options in the Setup and Maintenance work area using the following:

- Offering: Customer Data Management
- Functional Area: Customer Hub
- Task: Manage Customer Data Management Options

You can use these profiles options to specify:

- Tuning
  
  You can use this group of profile options to fine-tune the performance of your duplicate resolution processes. These settings work together to provide multiple ways to optimize your performance based on your implementation scenario, project phase, and data shape. The profile options under this category are:

  - Maximum Concurrent Merge Jobs Setting
  - Merge Mode Setting
  - Merge Request Job Size Setting
  - Merge Scope Setting
  - Merge Request Notifications

- Duplicate Resolution Control

  Use the profile options belonging to this category to control the flow and level of automation of your duplicate resolution processes. These settings allow you to define where merge requests can originate and when data stewards need to be involved in duplicate resolution activities. The profile options under this category are:

  - Autolink Threshold Setting
  - Automerge Threshold Setting
  - Customer Center Merge Requests Setting
  - Default Resolution Type Setting
  - User Merge Handling Setting

- Merge Behavior

  You can use this set of profile options to configure how the merge process handles the records in a duplicate resolution request. These settings allow you to control the processing logic that governs the final outcome of a
merge request, such as which record is retained as the master and how the process derives its final attributes. The profile options under this category are:

- Agreement Rules Type Setting
- Attribute Selection Type Setting
- Enable Attribute Source Tracking Setting
- Master Record Selection Setting
- Merge Identical Child Records Setting
- Add Groovy to Attribute Selection Setting

You can find more details about the duplicate resolution simplified profile options in the individual topics about them.

Merge Scope

You can use the Merge Scope setting to specify the business areas to be processed during a merge. This setting optimizes the size of the merge memory and execution profile and application performance. The underlying profile option is ORA_ZCH_MERGE_SCOPE.

You can specify any of these areas as the merge scope:

- Customer data management specific areas: Merges Customer Data Management foundation entities such as Organizations, People, Addresses, Phone Numbers, and Email Addresses.
- Customer data management specific areas with restrictions: Merges the same entities as the CDM scope. However, processing throughput is maximized by not invoking survivorship rules, integration events, or extended processing logic. You can use this option for high-volume data initialization scenarios.
- All customer relationship management related areas: Merges Customer Data Management foundation entities and transfers CRM transactional data, such as Opportunities, Activities, or Service Requests, from duplicate records to the master record.
- All functional areas: Merges Customer Data Management foundation entities and all merge-enabled entities on the point of deployment.

Before specifying the merge scope, you should consider these points:

- Select the appropriate merge scope to get the best performance.
- When you use Customer Data Management specific areas with restrictions merge scope, you must only select compatible options for other settings:
  - Master Record Selection can't be survivorship rule.
  - Attribute Selection Type can't be Oracle business rules.
  - Agreement Rules Type can't be Oracle business rules.

Merge Mode

You can use the Merge Mode setting to select the optimized mode for merge to prevent the triggering of non-essential business events. This setting controls whether the merge uses preconfigured processing logic or workflows and generates integration events for Oracle Integration Cloud services.
Ideally, you should enable optimized mode for merge to improve application performance when:

- you're not integrating merge events with external systems.
- you don't need groovy scripts or object workflows to run when a master record is updated by a merge.

**Merge Request Job Size**

You can use the Merge Request Job Size to specify the number of merges that each merge job can handle. A greater number of merge requests per merge job may increase merge processing throughput when the Merge Mode is optimized or the Merge Scope is set to Customer data management specific areas with restrictions. The underlying profile option is ORA_ZCH_MERGE_REQUEST_BATCH_SIZE_LIMIT.

Consider these points before specifying the merge request job size:

- The default value is 100 merge requests per merge job.
- Increasing the number of merge requests per merge job can be helpful during high-volume data initialization scenarios when processing the duplicate resolution queue is a high priority.
- The Merge Request Job Size setting and the Maximum Concurrent Merge Jobs setting work together to let you have a fine-grained control of the merge system.
- Setting no value (null) for the Merge Request Job Size setting distributes all pending merge requests to the available Merge Request Jobs. If the ratio of merge request to merge jobs is too high, system performance may be adversely affected.

**Merge Request Notifications**

Controls whether notifications are sent when duplicate resolution requests are assigned and processed.

The options are:

- Send notifications for new requests: User created merge requests are created with the Send Notifications parameter set to Yes.
- Don't send notifications for new requests: User created merge requests are created with the Send Notifications parameter set to No.
- Don't send any notifications: Merge notifications aren't sent regardless of the Send Notifications parameter value on individual merge requests.

Consider these points:

- The Send Notifications parameter of merge requests created through the Duplicate Identification Batch process can be set at the Duplicate Identification Batch level.
- The Send Notifications parameter value of individual merge requests can be modified on the Duplicate Resolution list page.

**Maximum Concurrent Merge Jobs**

You can use the Maximum Concurrent Merge Jobs setting to control the number of merge jobs that can be processed at any given time. If you don't set the maximum limit, all merge jobs are submitted for concurrent processing. A greater number of concurrent merge jobs may clear a duplicate resolution request queue more
quickly but may impact other processes and functions that use customer records. The underlying profile option is ORA_ZCH_MERGE_MAX_REQUEST_LIMIT.

Before specifying the limit for Maximum Concurrent Merge Jobs, you must consider these points:

- The default value is 10 concurrent merge jobs.
- Increasing the number of concurrent merge jobs can be helpful during high-volume data initialization scenarios when processing the duplicate resolution queue is a high priority.
- The Maximum Concurrent Merge Jobs setting and the Merge Request Job Size setting work together to let you control the merge system better.

**Default Resolution Type Setting**

Controls which duplicate resolution process type are assigned to new duplicate resolution requests. The underlying profile option is ZCH_DEDUP_REQUEST_TYPE_OPTION.

The options are:

- Merge: New duplicate resolution requests are queued for merging the duplicates into one master record.
- Link: New duplicate resolution requests are queued for linking the duplicates to each other without merging the records. The records to remain active.
- Generic: The data steward selects the duplicate resolution process type before processing the resolution requests.

Consider these points:

- To implement automatic duplicate resolution request processing, you must select either Merge or Link for the Default Duplicate Resolution setting.
- A data steward can change the duplicate resolution request type while reviewing a duplicate resolution request.

**Automerge Threshold Setting**

Defines the match score at or above which a duplicate resolution request of type Merge is processed without requiring a data steward to review the request. The underlying profile option is ZCH_AUTO_MERGE_THRESHOLD.

Consider these points:

- The highest possible match score is 100. So, if you set this value to 101, you can prevent automatic Merge processing.
- Use this setting only when the Default Duplicate Resolution type is Merge.

**Autolink Threshold Setting**

Defines the match score at or above which a duplicate resolution request of type Link is processed without requiring a data steward to review the request. The underlying profile option is ZCH_AUTO_LINK_THRESHOLD.

Consider these points:

- The highest possible match score is 100. So, if you set this value to 101, you can prevent any automatic Link processing.
• Use this setting only when the Default Duplicate Resolution type is Link.

Customer Center Merge Requests Setting
Controls whether you can submit merge requests directly from the Customer Center Account and Contact list pages. Consider these points:
• If this option is enabled, the User Merge Handling setting controls whether or not those requests require a data steward’s review before being processed.

User Merge Handling Setting
Controls whether manually created merge requests are processed automatically or require review by a data steward. The underlying profile option is ZCH_USER_MERGE_REQUESTS. The options are:
• Allow Processing Without Approval: Manually created merge requests are processed automatically.
• Process Subject To Approval: Data steward reviews manually created merge requests before processing.

Consider these points:
• Use the Create Resolution Request task in Party Center pages or through the Account and Contact list pages in Customer Center if Customer Center Merge Requests have been enabled to create Manual merge requests.

Master Record Selection Setting
Controls the method used to identify which record in a duplicate set becomes the master during a merge. The options are:
• Select master record using survivorship rule: Logic configured with Oracle business rules using the Manage Survivorship Rules setup task determines the master.
• Select the oldest record as master: The record with the earliest creation date is the master.
• Select the latest record as master: With the most recent creation date is the master.
• Select master based on duplicate identification results: Internal logic of the duplication identification process determines the master.
• Select master record using Data Quality Rules: Logic configured with Application Composer Data Quality Rules determines the master.

Consider these points:
• The Select the older record as master and Select the latest record as master options use optimized internal processes and may offer the best performance.
• Master Record Selection can’t be survivorship rule or Data Quality Rules if the Merge Scope has been set to Customer data management specific areas with restrictions.
• The Duplicate Identification batch process identifies a preliminary master record, but the final determination of master record occurs within duplicate resolution processing per the Master Record Selection Setting. Select the Select master based on duplicate identification results option if you want to retain the master record selection from the duplicate identification results.
Agreement Rules Type Setting

Controls the method used to prevent records from being merged into other records incorrectly. The underlying profile option is .ZCH_AGREEMENT_TYPE. The options are:

- Default agreement rules: Only the seeded agreement rules are processed. These rules can’t be edited or disabled.
- Default agreement rules with Oracle business rules: In addition to the default rules, merge incorporates logic written with Oracle business rules using the Manage Agreement Rules setup task.
- Default agreement rules with Data Quality Rules: In addition to the default rules, merge incorporates logic written with Application Composer Data Quality Rules.

Consider these points:

- You can’t use Oracle business rules to configure agreement rules or Data Quality Rules to configure agreement rules, if you have set the Merge Scope to Customer data management specific areas with restrictions.

Merge Identical Child Records Setting

Controls whether the merge process merges or transfer certain types of child records when they have the same values. This setting currently controls the processing of addresses, phone contact points, and email contact points. The underlying profile options is ORA_ZCH_MERGE_IDENTICAL.

Attribute Selection Type Setting

Controls the method used to coalesce attribute values from the different records in a merge set onto the master record. The underlying profile option is ZCH_SETATTRIBUTE_TYPE. The options are:

- No attribute survivorship rules selected: Merge only replaces null values on the master with non-null values from the duplicates.
- Use source confidence with oldest record as the tie breaker: In addition to replacing nulls with non-nulls, merge picks the attributes for the master based on the source confidence values configured using the Manage Source System Confidence setup task. In the case of multiple records in the duplicate set sharing the highest source confidence value for a given attribute, the value created at the earliest point in time is selected.
- Use source confidence with newest record as the tie breaker: In addition to replacing nulls with non-nulls, merge picks the attributes for the master based on the source confidence values configured using the Manage Source System Confidence setup task. In the case of multiple records in the duplicate set sharing the highest source confidence value for a given attribute, the value created at the most recent point in time is selected.
- Use Oracle business rules: In addition to replacing nulls with non-nulls, merge picks the attributes for the master based on logic configured with Oracle business rules using the Manage Survivorship Rules setup task.

Consider these points:

- The source confidence-based survivorship methods use optimized internal processes and may offer the best performance.
- The Attribute Selection Type can’t be Oracle business rules if the Merge Scope is set to Customer data management specific areas with restrictions.
Enable Attribute Source Tracking Setting

Controls whether the attribute-level change by source system is tracked. This tracking is required for survivorship processes that use source confidence configuration to determine which attribute values in a duplicate set are ultimately written onto the master record. The underlying profile option is ZCH_ENABLE_SURVIVORSHIP.

Consider these points:

- The 'Use source confidence with oldest record as the tiebreaker' and 'Use source confidence with newest record as tiebreaker' attribute selection options require Attribute Source Tracking to be enabled.
- Attribute selection options that use Oracle Business Rules can be used without enabling Attribute Source Tracking but those rules can't access source confidence values.
- Once enabled, Enable Attribute Source Tracking can't be disabled because breaks in the source tracking history invalidate source confidence-based logic.

Add Groovy to Attribute Selection Setting

Controls whether logic written with Application Composer Data Quality Rules are used to determine which attribute values are selected for the master record. The underlying profile option is ZCH_GROOVY_RULE. The options are:

- No: Use only the option selected for the Attribute Selection Type setting to determine which attribute values are selected for the master record.
- Yes: Combine logic written with Application Composer Data Quality Rules with the option selected for the Attribute Selection Type setting to determine which attribute values are selected for the master record.

Consider these points:

- You can't combine Data Quality Rules with the Oracle business rules Attribute Selection Type setting option.

Run Request Dispatch Job

You can use the Run Request Dispatcher process to manage and monitor cleansing and duplicate identification batches, and duplicate resolution requests.

Run the request dispatcher process in the following modes:

- Basic: To submit the request dispatcher job for immediate processing.
- Advanced: To schedule the process to run either immediately or at specified intervals, such as every hour or every day.

Set Up Duplicate Resolution Using Groovy Scripts
Overview of Duplicate Resolution Setup Using Groovy Script

Duplicate resolution is a set of processes that you can use, after duplicate records are identified, to consolidate those records. You can resolve duplicates in two ways, either by linking them or by merging them. Linking involves associating the duplicate records. The linked records are treated as unique records in the data registry, and have their own unique identifiers. Merging involves combining duplicate records into one new master record.

You can setup linking by configuring a couple of profile options discussed in the topic Duplicate Resolution Simplified Profile Options. However, the setup for merging is a bit more elaborate. It consists of configuring logic to:

- Determine which record from a set of identified duplicates should be designated as the master record. You can set this up by configuring Set Master Record Rules.
- Determine which attribute value instances from across the set of duplicates the master record should contain. You can set this up by configuring Set Attribute Value Rules. The Set Master Record Rules and Set Attribute Value Rules are collectively called Survivorship Rules.
- Determine whether the merge is violating any of the conditions under which a merge should be prohibited. You can set this up by configuring Agreement Rules.

You can easily setup survivorship and agreement rules using Groovy Script in Application Composer. If you already have defined survivorship and agreement rules without using the Groovy Scripts, you can migrate them to Groovy Script incrementally. For example, you could continue to use your existing agreement rules while also using Groovy Script for your set master rules.

How You Enable Groovy Script-based Survivorship and Agreement Rules

Before you can start using groovy scripts to configure survivorship and agreement rules, you must enable groovy scripting in Setup and Maintenance.

Follow these steps to enable Groovy Script-based survivorship and agreement rules:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Customer Hub
   - Task: Manage Customer Data Management Options

2. In the Merge Behavior section, select the groovy script options as the value for one or more of the following fields as required:
   - Master Record Selection: Select the Select master record using groovy scripts option to define the rules for selecting master records using Groovy Scripts.
   - Attribute Selection Type: To define attribute selection rules using Groovy Scripts, select the following options:
     - Select either Use source confidence with newest record as the tie breaker or Use source confidence with oldest record as the tiebreaker.
     - Select Yes for the Add Groovy to Attribute Selection field.
   - Agreement Rules Type: Select the Default agreement rules with groovy scripts option to define agreement rules using Groovy Scripts.
Create an Application Composer Sandbox

The configuration of Groovy Script survivorship and agreement rules is done in Application Composer using the standard Unified Sandbox framework for developing and testing your scripts. We recommend that you create a separate, dedicated sandbox for survivorship and agreement rules rather than combine survivorship and agreement rule configuration with other types of Application Composer configuration activities. This approach gives you the greatest flexibility for iterative design, testing, and deployment of your survivorship and agreement rules.

To create an Application Composer Sandbox:

1. Click **Navigator > Configuration > Application Composer > Sandboxes**
2. Click Create Sandbox.
3. Specify a name and select Application Composer under All Tools. Also select the Publishable option as Yes.
4. Click Create and Enter.
5. Click the Application Composer icon.
6. Go to the Advanced Setup task list.
7. Select Data Quality Rules.

You should be able to see six predefined templates for survivorship rules of the type set master and set attributes and agreement rules. You should be able to see three rules for the Contact (Person) entity and three for the Account (Organization) entity.

You are now ready to configure the survivorship or agreement rules using Groovy Script for accounts or contacts. For more information about creating sandboxes, see the Related Topics section.

**Related Topics**

- Overview of Sandboxes

Configure Predefined Data Quality Rules to Your Requirements in Application Composer

You can configure predefined data quality rules to your requirements in application composer by completing the following steps:

1. In your Sandbox dedicated for Data Quality rules, click the Application Composer icon.
2. Go to Advanced Setup.
3. Click Data Quality Rules to view the predefined data quality rules. You should be able to see six predefined templates for data quality rules, three for the Contact (Person) entity and three for the Account (Organization) entity. These templates are:
   - ContactSetMaster: Configure rules for determining the master record in contact merges.
   - ContactSetAttribute: Configure attribute survivorship rules for contact merges.
   - ContactMergeAgreement: Configure merge agreement rules for contact records.
   - AccountSetMaster: Configure rules for determining the master record in account merges.
   - AccountSetAttribute: Configure attribute survivorship rules for account merges.
   - AccountMergeAgreement: Configure merge agreement rules for account records.
4. To configure the merge processing logic for any of these templates, you can:
   - Click the required template.
   - Select the desired row and click Actions > Edit.

5. Create and save your scripts in the Groovy Script editing interface that's displayed when you click edit for a given survivorship or agreement rule.

**Configure Groovy Script Based Set Master Record Rules**

In this example, you will learn how to create a set master record rule to select the master record in an account merge based on the source system references of the records in the merge request. The logical requirements of the scenario are as follows:

- Records integrated with RNOW source system are the top priority to be master record.
- Records integrated with PSFT source system are the second priority to be master record.
- If multiple records are present from a prioritized source system, use the most recently updated record as the tiebreaker.
- If neither PSFT- nor RNOW-integrated records are present in the merge, take whatever record had been designated as master by the upstream process.

**Steps to Perform**

1. Enable Groovy Scripts to select master records:
   - In the Setup and Maintenance work area, go to the following:
     - Offering: Customer Data Management
     - Functional Area: Customer Hub
     - Task: Manage Customer Data Management Options
   - In the Merge Behavior section, select the Select master record using groovy scripts option for the Master Record Selection field.

2. Create an Application Composer sandbox. Refer to the Create an Application Composer Sandbox topic for the steps.

3. Populate the sample script in the AccountSetMaster template:
   - Navigate to Advanced Setup > Data Quality Rules.
   - Click AccountSetMaster.
   - Copy and paste the code given in the Sample Code section in the Edit Data Quality Rules page.
   - Click Save and Close.

4. Test the code. Refer to the Test the Survivorship and Agreement Rules Configuration topic to test the code.

5. Deploy the Code, after you're satisfied with the results of the Set Master Record Rules. See the topic: Deploy the Survivorship and Agreement Rules Configuration.

**What the Sample Script Does**

The script begins by calling the `getRows()` input function to access the records in the merge request. Next, the script loops through the records in the merge request to inspect which source system reference assignments exist for each record. When a prioritized source system reference assignment, for example PSFT or RNOW, is identified, the row is added to the list of records having the given source system reference assignment.
Once all the rows in the merge request have been tested for their source system reference values, the script tests whether any records from the top priority source system reference were found. If records are found in the top priority list, they're sorted by last updated date. Then the most recently updated record having the highest priority source system reference is designated to become the master record. If no record with the top priority source system reference was found, the script tests to see if any records with the second priority source system reference were found, following the same process as was used for the top priority source system.

Finally, the script calls the `selectMaster()` output function to designate the master record. If a top-priority or second-priority record was identified earlier in the script, that record is provided to the `selectMaster()` function. If no priority record was identified, then `selectMaster()` is called with the `getSurvivor()` function to specify that whatever record had been identified as the master upstream of the script should be retained as the master.

Sample Code

```java
try {
    def mergeRows = getRows();
    def rowMaster = false;
    def osrMap = ['RNOW':[], 'PSFT':[]];
    for (row in mergeRows) {
        def osrRows = row.getAttribute("OriginalSystemReference");
        osrRows.reset();
        while(osrRows.hasNext()){
            def osrRow = osrRows.next()
            if (osrRow.OrigSystem == "RNOW") {
                osrMap['RNOW'].add(row);
            } else if (osrRow.OrigSystem == "PSFT") {
                osrMap['PSFT'].add(row);
            }
        }
        if (rowMaster==false && osrMap['RNOW'].size() > 0) {
            rowMaster = osrMap['RNOW'][0];
            for (row in osrMap['RNOW']){
                if (row.LastUpdateDate > rowMaster.LastUpdateDate) {
                    rowMaster = row;
                }
            }
        }
        if (rowMaster==false && osrMap['PSFT'].size() > 0) {
            rowMaster = osrMap['PSFT'][0];
            for (row in osrMap['PSFT']){
                if (row.LastUpdateDate > rowMaster.LastUpdateDate) {
                    rowMaster = row;
                }
            }
        }
        if(rowMaster){
            selectMaster(rowMaster);
        } else{
            selectMaster(getSurvivor());
        }
    }

    catch(Exception e) {
        def sMsg = "Exception in Account Set Master: " + e.getMessage();
        println(sMsg);
    }
}
```

Oracle CX
Implementing Customer Data Management for CX Sales
and B2B Service

Chapter 21
Duplicate Resolution Setup

199
Configure Groovy Script Based Set Attribute Value Rules

In this example, you will learn how to create a set attribute value rule to override the standard attribute source confidence-based survivorship processing with groovy script based on the classification code assignment of the records. The logical requirements of the scenario are as follows:

- If the merge contains a record that has been classified as OFN Category One account, use that OFN Category One record’s value for a set of key fields regardless of the attribute source confidence score.
- If multiple rows in the merge have been classified as OFN Category One, use the attribute values from the most recently updated row.

Steps to Perform

1. Enable Groovy Scripts to select master records:
   a. In the Setup and Maintenance work area, go to the following:
      - Offering: Customer Data Management
      - Functional Area: Customer Hub
      - Task: Manage Customer Data Management Options
   b. In the Merge Behavior section, select the following options:
      - Select either Use source confidence with newest record as the tie breaker or Use source confidence with oldest record as the tiebreaker for the Attribute Selection Type field.
      - Select Yes for the Add Groovy to Attribute Selection field.
   c. Create an Application Composer sandbox. Refer to the Create an Application Composer Sandbox topic for the steps.

2. Populate the sample script in the AccountSetAttribute template:
   a. Navigate to Advanced Setup > Data Quality Rules.
   b. Copy and paste the code given in Sample Code section in the Edit Data Quality Rules page.
   c. Click Save and Close.

3. Test the code. Refer to the Test the Survivorship and Agreement Rules Configuration section to test the code.
4. Deploy the code after you’re satisfied with the results of the attribute value rules, you can. See the topic: Deploy the Survivorship and Agreement Rules Configuration.

What the Sample Script Does

The script begins by calling the getRows() input function to access the records in the merge request. Next, the script loops through each of the row records and accesses its Code Assignment collection. The script then loops through the code assignments to test whether the specified code assignment value is present. When a row having the specified code assignment is identified, the row is copied into an array of prioritized records for subsequent processing.

Once all the rows in the merge request have been tested for their code assignment values, the list of prioritized records is sorted based on the records’ last update date. Finally, the script identifies the most recently updated row having the specified code assignment value. After this row is identified, the script calls the selectAttribute() output function to designate that priority row as being the attribute value source for a set of defined attributes.

Sample Code

```java
try {
    def rowDuplicates = getRows();
    def rowPriorities = [];
    def exceptionAttributes = ['BusinessScope', 'CeoTitle'];
```
def CAs;
def CAi;
for(row in rowDuplicates){
CAs = row.getAttribute("CodeAssignment");
if(CAs){
for(CA in CAs){
CA.reset();
while(CA.hasNext()){
CAi = CA.next();
if(CAi.ClassCategory == "OFN" & CAi.ClassCode == "OFN1"){
rowPriorities.add(row);
}
}
}
if(rowPriorities.size()){ 
def rowPriority = rowPriorities[0];
for (row in rowPriorities){
if (row.LastUpdateDate > rowPriority.LastUpdateDate){
rowPriority = row;
}
for (a in exceptionAttributes){
selectAttribute(a, rowPriority);
}
}
}
}
catch(Exception e) {
def sMsg = "Exception in Account Set Attribute: " + e.getMessage();
println(sMsg);
}

Configure Groovy Script Based Agreement Rules

In this example, we are operating in a complex business ecosystem where it's not always appropriate to merge certain accounts that have been identified as duplicates. When the conditions that prohibit a merge from happening are encountered, the data steward needs to see an informative message explaining exactly which records blocked the merge, and for what reasons. The conditions that can prevent a merge are as follows:

- A victim record is integrated with the Legal Hold system
- A victim record has a Certification Score value of 100

Steps to Perform

1. Enable Groovy Scripts to select master records:
   a. In the Setup and Maintenance work area, go to the following:
      - Offering: Customer Data Management
      - Functional Area: Customer Hub
      - Task: Manage Customer Data Management Options
   b. In the Merge Behavior section, select the Default agreement rules with groovy scripts option for the Agreement Rules Type field.
2. Create an Application Composer sandbox. Refer to the Create an Application Composer Sandbox topic for the steps.
3. Populate the sample script in the AccountMergeAgreement template:
   a. Navigate to Advanced Setup > Data Quality Rules.
   b. Click AccountMergeAgreement.
5. Click Save and Close.
6. Test the code. Refer to the Test the Survivorship and Agreement Rules Configuration topic to test the code.
7. Deploy the code after you’re satisfied with the results of the agreement rules. See the topic: Deploy the Survivorship and Agreement Rules Configuration.

What the Sample Script Does

The script begins by calling the getVictims() input function to access the non-master records in the merge request. Note that the result of a Set Master groovy scripts is expressed in getSurvivor() and getVictims() responses in Agreement Rule and Attribute Selection scripts. Next, the script loops through each of the row records to test for the two different conditions that would lead to the merge being rejected. The first test is to evaluate the source system reference assignments of the records to determine if the record is integrated with the Legal Hold system. The second test is to check the Certification Level value of the victim records. If a given record matches either of the tests, a partial rejection message is added to the vetoMessages array.

After all the victim rows in the merge request have been tested, the script checks to see if the vetoMessages array has any data in it. If it does, then a final rejection message is constructed from the data in the vetoMessages array and the merge is rejected with that constructed message being displayed to the data steward in the duplicate resolution UI.

Sample Code

```java
try {
    def rowVictims = getVictims();
    def sMsg = "";
    def rejectMsg = "";
    def vetoMessages = [];
    for (row in rowVictims){
        def OSRs = row.getAttribute("OriginalSystemReference");
        def OSs = OSRs.get();
        while(OSs.hasNext()) {
            def OS = OSs.next();
            if (OS.getAttribute("OrigSystem") == "LEGAL_HOLD" && sMsg == "") {
                sMsg = "A legal hold has been placed on Account " + row.getAttribute("PartyNumber");
                vetoMessages.add(sMsg);
            }
        }
        sMsg = "";
        if (row.getAttribute("CertificationLevel") == "100") {
            sMsg = "A Certification Level of 100 was found on Account " + row.getAttribute("PartyNumber");
            vetoMessages.add(sMsg);
        }
        if (vetoMessages.size()) {
            rejectMsg = "Merge rejection reasons: ";
            vetoMessages.eachWithIndex { item, index ->
                rejectMsg += "(index +1) + " + item + " ";
            }
            rejectRequest(rejectMsg);
        }
    }
    catch(Exception e) {
        def sMsg = "Exception in Account Merge Agreement: " + e.getMessage();
        println(sMsg);
    }
}```
Test the Survivorship and Agreement Rules Configuration

You can test your Groovy Script-based survivorship and agreement rules configuration while working inside of the sandbox by creating a Test Merge Request in the Duplicate Resolution work area. A Test Merge Request invokes whatever survivorship and agreement rules have been configured inside the current sandbox. For more information about creating test merge requests, see Related Topics section.

After you have identified potential duplicates in your database through a duplicate identification batch, you can resolve these duplicate sets by creating and submitting a duplicate resolution request.

To create and submit a resolution request:

1. Navigate to the Create Resolution Request UI page as follows: Navigator > Customer Data Management > Duplicate Resolution > Tasks
2. Search for and multi-select the duplicate records using the shift key.
3. Click Create Request.
4. Click Test Merge and click OK.
   
   You can optionally select one of the records as master. Once the request is submitted, the application generates a Request ID, which you can use to track the status of the duplicate resolution process.
5. You can tweak your survivorship and agreement rules configuration and retest your code using new test merge requests to ensure that the code is working as expected.

   **Note:** This process tests the merge request configuration without changing your application data.

Deploy the Survivorship and Agreement Rules Configuration

When you're satisfied with your configured survivorship and agreement rules, you can deploy the configuration by using the standard sandbox publication process. When you publish the sandbox, whatever Groovy Script-based rules were previously in the mainline configuration are replaced with whatever scripts are in the sandbox. Once the sandbox has been published, the Request Dispatch scheduled process begins to use the new Groovy Scripts during the processing of regular merge requests.

To publish a sandbox to deploy your survivorship and agreement rules configuration:

1. Click Navigator > Configuration > Sandboxes
2. On the Sandboxes page, click the name of the sandbox you want to publish.
3. Click Publish.

   **Note:** The Publish button might be disabled for your sandbox because of various reasons. For example, you haven't yet made any changes in your sandbox, or the Control Publish Sandbox Action in Production Environment profile option (FND_ALLOW_PUBLISH_SANDBOX) is set to No.

4. Click Continue to Publish. The sandbox is published.
5. Click Done.
Best Practices for Configuring Groovy Scripts Based Survivorship and Agreement Rules

In this topic we discuss the best practices for configuring groovy scripts.

- If you configure your implementation to use Groovy Scripts for Set Master rules, merges aren't processed until a valid Set Master script has been deployed.
- Any survivorship rules written using the Manage Survivorship Rules setup task which uses the Oracle Business Rules framework, continues to function if you don't enable groovy script survivorship rules.
- For a given survivorship process type, such as Set Master or Agreement Rules, you can either use Groovy script or Oracle Business Rules. You can't combine the two frameworks for a single process type. For example you can't define one Set Master rule using Groovy Script and another Set Master rule using Oracle Business rules.
- You can combine Oracle Business Rules and Groovy script between different survivorship process types, such as using Oracle Business Rules for Set Master logic and Groovy script for Set Attribute logic.
- For best performance with attribute survivorship processing, try to use attribute source confidence as much as possible for your Set Attribute survivorship logic.
- Select one of the Use source confidence Attribute Selection Type options from the Manage Customer Data Management Options setup page.
- If needed, use Groovy script along with your source confidence configuration to handle exception scenarios.

Overview of Groovy Scripting Functions

Groovy Script support for configuring survivorship and agreement rules is based on a specific set of functions that let you interact with the data records in the context of a merge request. These functions are of the following categories:

- Functions that let you inspect the records in the merge requests
- Functions that let you define the result of the merge request

These categories of specialized functions help you to create survivorship and agreement rules using standard Groovy Script syntax and operations.

Input Functions

These functions provide the data that your survivorship and agreement rules evaluate. Generally, these functions are called at the beginning of your script to instantiate the information required to determine the proper merge process outputs.

getRuleType()

This function lets you determine the functional context of the script. This function returns SetAttribute, SetMaster, or Agreement depending on which type of script calls it. It's generally not necessary to programatically determine the rule type because the script types are presented as distinct functions within the Application Composer Data Quality Rules task. But there may be cases where it's helpful for logging or testing.

getObjectType()

This function lets you determine what type of party the merge request is processing. This function returns PERSON or ORGANIZATION depending on which type of script calls it. It’s generally not necessary to programatically determine the object type because the scripts for Persons and Organizations are clearly differentiated as distinct functions within the Application Composer Data Quality Rules task. But there may be cases where it's helpful for logging or testing.
getSurvivor()

This function lets you access the data record that has been identified as the master record for the merge request. The function is called without parameters and it returns a single Row object that contains the details of the master record. The following example shows a typical usage of this function:

```java
def rowSurvivor = getSurvivor();
def survivorName = rowSurvivor.getAttribute("OrganizationName");
// etc...
```

getVictims()

This function lets you access the set of data records that have been identified as the non-master records for the merge request, which are also referred to as victim records because the merge process inactivates them. This function is called without parameters and it returns a list of row objects consisting of one list entry for each victim record. It's important to note that the `getVictims` list isn't an ADF recordset object. ADF recordset functions such as reset() and first() don't work with the list. The following example shows a typical usage of this function:

```java
getVictims()
def rowVictims = getVictims();
def victimName;
for (victim in rowVictims) {
    victimName = victim.getAttribute("OrganizationName"); }
// etc...
```

getRows()

This function lets you access the full set of customer records for the merge request, which is the union of the survivor and victim sets of rows. This function is called without parameters and it returns a list of row objects consisting of one list entry for each victim record. Like the `getVictims` function, it's important to note that the `getRows` list isn't an ADF recordset object. ADF recordset functions such as reset() and first() don't work with the list. The following example shows a typical usage of this function:

```java
def rowDuplicates = getRows();
def duplicateName;
for (duplicate in rowDuplicates) {
    duplicateName = duplicate.getAttribute("OrganizationName"); }
// etc...
```

ggetSourceInfo(Row row, String attributeName)

This function lets you access information about which source system provided the current value of an attribute for a given survivor or victim row. This function is called using the following parameters:

- A row object for the victim or survivor row of interest
- The name of a source-confidence configured attribute

This function returns a source information record for the attribute in question. The structure of the source information record is as follows:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Definition</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>RecordId</td>
<td>The party ID of the person or organization record referenced by the row object parameter.</td>
<td>300100184760397</td>
</tr>
<tr>
<td>Attribute</td>
<td>Definition</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>AttributeName</td>
<td>The name of the attribute parameter.</td>
<td>OrganizationName</td>
</tr>
<tr>
<td>AttributeValue</td>
<td>The current value of the attribute on the row.</td>
<td>Pinnacle Systems</td>
</tr>
<tr>
<td>Source</td>
<td>The code of the registered source system for the attribute value.</td>
<td>RNOW</td>
</tr>
<tr>
<td>SourceConfidenceLevel</td>
<td>The configured attribute source confidence value of the given attribute for the given source system.</td>
<td>90</td>
</tr>
<tr>
<td>SourceUpdateDate</td>
<td>The time stamp when the person or organization record was updated with the current value.</td>
<td>1/24/2020 11:48:03 PM</td>
</tr>
</tbody>
</table>

**Note:** The `getSourceInfo` function is only available for attributes that have been configured with source system confidence using the Manage Source System Confidence setup task.

The following example shows a typical usage of this function:

```java
def rowDuplicates = getRows();
def rowSource;
def bestSource;
def bestValue;
bestSource = getSourceInfo(rowDuplicates[0], "OrganizationName");
for (row in rowDuplicates) {
    rowSource = getSourceInfo(row, "OrganizationName");
    if (rowSource.SourceConfidenceLevel > bestSource.SourceConfidenceLevel) {
        bestSource = rowSource;
    }
}
bestValue = bestSource.AttributeValue;
```

**Output Functions**

Output functions create the final behavior of the merge process based on the logic of a survivorship or agreement rule script. Generally, these functions are called at the end of the script after the data provided by the input functions has been evaluated with scripted logic.

**selectMaster(Row row)**

This function is used in Contact Set Master and Account Set Master scripts to specify which record from the merge request should be retained as the master record after the merge. This function takes a data Row instance as its only parameter, and whatever row is passed to the function is the record that's retained as the master. All other records in the merge request are inactivated during merge processing. The following example shows a typical usage of this function:

```java
... 
def masterRow = rowDuplicates[0];
for (row in rowDuplicates) {
    if (row.LastUpdateDate > masterRow.LastUpdateDate {
        masterRow = row;
    }
}
```
selectMaster(masterRow);

selectAttribute(String attributeName, Row row)

This function is used in Contact Set Attributes and Account Set Attributes scripts to define which attribute value instances from across the records in the merge should be used to build the master record. This function takes the name of an attribute and a Row instance as its parameters. The value for the given parameter that's found in the given row is retained on the master record. This function is logically equivalent to using the Duplicate Resolution override flow to select the source record for a given attribute. The following example shows the syntax of this function:

```groovy
def rowDuplicates = getRows();
def bestSourceRow;

def fieldName = "OrganizationName";
rowBestSource = rowDuplicates[0];
for (row in rowDuplicates) {
    if(getSourceInfo(row, fieldName).SourceConfidenceLevel > getSourceInfo(rowBestSource, fieldName).SourceConfidenceLevel) {
        rowBestSource = row;
    }
}

selectAttribute(fieldName, rowBestSource);
```

overrideAttribute(String attributeName, Object attributeValue)

This function is used in Contact Set Attribute and Account Set Attribute rules to specify an attribute value for the master record, which can't be derived in the normal fashion from the records in the merge request. This function takes the name of an attribute and the value for the attribute as its parameters and sets the final value of the master record's given field to the given value. This function is logically equivalent to using the Duplicate Resolution Override flow to enter your own value for a given attribute.

Note: Ensure that the value's data type and format are correct because this function sets an externally-defined value.

The following example shows the syntax for this function:

```groovy
def fieldName = "OrganizationName";
def fieldValue = "Pinnacle Systems";
overrideAttribute(fieldName, fieldValue);
```

This function is used in Contact Agreement Rule and Account Agreement Rule scripts to veto a merge request if a specified set of conditions are observed in the merge request's records. This function takes a single parameter which defines the rejection message that's displayed on the merge request if the rejection criteria are met. The following example shows the syntax for this function:

```groovy
def rowVictims = getVictims;
for (row in rowVictims) {
    if (row.value != null) {
        rejectRequest("Unable to merge contacts that this value");
    }
}
```

Evaluating the Data

Once you have called the appropriate functions, your survivorship or agreement rules script need to evaluate the data to determine the correct merge result. This evaluation process uses standard Groovy Script operators and functions. For more information about Groovy scripts, see the Oracle Applications Cloud Groovy Scripting Reference guide.

Putting It Together

You can generally follow this pattern in groovy scripting:

1. Call Input Functions
2. Evaluate the Data
3. Call Output Functions

To further illustrate this concept, the following is a simple script to determine the master record for a merge request based on the most recent Last Updated Date from the records:

```groovy
/* Input Functions: call getRows() to initialize a list of the party records in the merge request and then define a variable to designate the Master record and set it to the first record in the list of Rows */
def rowDuplicates = getRows();
def masterRow = rowDuplicates[0];
/* Evaluate the Data: iterate through the list of records to determine if the current list item was more recently updated than whatever record has been designated the master. If the current record was more recently updated, promote it to become the new Master */
for (row in rowDuplicates) {
    if (row.LastUpdateDate > masterRow.LastUpdateDate) {
        masterRow = row;
    }
}
/* Call Output Functions: use the selectMaster() function to dictate which record from the merge set should become the master */
selectMaster(masterRow);
```

Best Practices for Groovy Scripting

Consider the following points when planning and configuring your survivorship and agreement rules using groovy scripts:

- The Rows returned by the getRows(), getVictims(), and getSurvivor() functions is a standard Groovy Script list object, not an Oracle ADF recordset object. You must use standard Groovy methods for traversing the recordset such as for (item in list) instead of ADF functions such as reset(), first(), or hasNext().
- The responses of the getRows(), getVictims(), or getSurvivor() functions are cached for each script execution. So the data state of row objects of your scripts don't show any changes within the scope of a script execution.
- The result of a Set Master script is reflected in the response to getVictims() or getSurvivor() functions called in Set Attribute or Agreement Rules scripts.
- You can't access the Resolution Request header object in your survivorship scripts. The only supported means for initializing data objects in your scripts are the input functions described in this topic.
- The selectAttribute() and overrideAttribute() functions can be used on top-level attributes of the Row object. Fields that contain embedded child record collections can't be manipulated with these functions.
- You can interact with custom attributes and custom child objects by using the API name for the attribute or object that was specified when the custom entity was created in Application Composer.
- The script fragments provided in this topic are intended to illustrate the syntax and usage of the Input and output functions. Refer to the Sample Scripts section for examples of complete scripts.
- The Groovy Script survivorship and agreement rule templates should only be used to configure Set Master, Attribute Survivorship and Agreement rules. Use of these templates for general processing extension or automation isn't supported and may cause incorrect or unpredictable behavior.

Set Up Duplicate Resolution Using Oracle Business Rules
Overview of Duplicate Resolution Setup Using Oracle Business Rules

An alternative to using Groovy Scripts based survivorship and agreement rules is to configure them using Oracle Business Rules. Before you process merge requests, you must configure survivorship and agreement rules. You can do this configuration in the Setup and Maintenance work area using the Manage Survivorship Rules and Manage Agreement Rules setup tasks.

Set Up Survivorship

Survivorship Rules
Survivorship rules are a collection of business rules that determine the master or surviving record and its attributes during the merge operation.

Survivorship rules create the best version of a record from multiple source systems, based on business rules. You can configure survivorship rules to resolve conflicts while merging duplicate records.

Survivorship Rules Types
There are two types of survivorship rules. You can configure them based on your business needs. They are as follows:

- **Set master record**: Configure the set master record rule to define the criteria for selecting the master record from a set of potential duplicate records.
- **Set attribute value**: Configure the set attribute value rule to define the criteria for selecting the best attribute values from multiple input records.

Predefined Survivorship Rules
Six predefined set attribute value rules are provided ready-to-use with the application:

- **Least Recently Updated Organization Attribute (History Wins)**: This rule selects the organization attributes that have the oldest updated date.
- **Most Recently Updated Organization Attribute (Recent Wins)**: This rule selects the organization attributes that have the most recent updated date.
- **Highest Source Confidence Level Wins for Organization**: This rule selects the organization attribute values that have the highest source confidence.
- **Least Recently Updated Person Attribute (History Wins)**: This rule selects the person attributes that have the oldest updated date.
- **Most Recently Updated Person Attribute (Recent Wins)**: This rule selects the person attributes that have the most recent updated date.
- **Highest Source Confidence Level Wins for Person**: This rule selects the person attribute values that have the highest source confidence.

In addition, you can use predefined templates to create new Set Attribute Value rules.

To see these predefined attribute rules, click Search button on the Manage Survivorship Rules task. You can use these predefined survivorship rules as a starting point to define the criteria that's best for your business. These rules are updated with every release. You can also create, edit, and delete these rules. However, deleting an existing rule isn’t
How You Enable Survivorship Rules

You can enable the survivorship functionality by setting the `ZCH_ENABLE_SURVIVORSHIP` profile option to Yes in the Setup and Maintenance work area, using the following:

- Offering: Customer Data Management
- Functional Area: Customer Hub
- Task: Manage Customer Hub Profile Options

How You Manage Survivorship Rules

You can create, edit, and delete survivorship rules in the Setup and Maintenance work area by going to the following:

- Offering: Customer Data Management
- Functional Area: Customer Hub
- Task: Manage Survivorship Rules

The rules use source system confidence level and other criteria to determine the attributes of the record that should be retained from a particular source system, and are stored in the survivorship rules dictionary XML file.

**Note:** The application doesn't support changing survivorship rules inside the Application Composer sandbox. Therefore, the merge engine doesn't pick up the changes made to these rules inside the Application Composer sandbox. When you define custom attributes or custom objects in an Application Composer sandbox, you should Publish and Exit the sandbox before changing a survivorship rule in the Manage Survivorship Rules setup task.

Define Survivorship Rules

This example demonstrates how to create a survivorship rule. Survivorship rules enable intelligent creation of the best version record, especially from multiple source systems, by specifying criteria for selecting the record to be retained during a merge operation.

Create A Survivorship Rule

To create a survivorship rule:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Customer Hub
   - Task: Manage Survivorship Rules
2. On the Manage Survivorship Rules page, click **Add** from the Actions menu.
3. Enter the sample information provided in the following table on the Create Survivorship Rule page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Name</td>
<td>PickPersonMasterRule</td>
</tr>
<tr>
<td>Description</td>
<td>Select the master person record based on original source system of the record.</td>
</tr>
</tbody>
</table>
Implementing Customer Data Management for CX Sales and B2B Service

Chapter 21
Duplicate Resolution Setup

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Type</td>
<td>Set master record</td>
</tr>
<tr>
<td><strong>Note</strong>:</td>
<td>You can create the following two types of survivorship rules: Set Master Record and Set Attribute Value. You can use predefined templates to create the Set Attribute Value rules.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Person</td>
</tr>
<tr>
<td><strong>Note</strong>:</td>
<td>You can create a survivorship rule for the following two types of party records: Person and Organization.</td>
</tr>
</tbody>
</table>

4. Click **Apply**. The Define Survivorship Rules: Select Master Record page appears.

Specify Criteria for Selecting the Master Record
The following are the steps to specify criteria for selecting the master record:

1. Navigate to the Define Survivorship Rules: Select Master Record page.
2. Enter the information provided in the following table as IF/THEN rules condition in the Define Survivorship Rules: Select Master Record page.

<table>
<thead>
<tr>
<th>Rule Condition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IF Condition</td>
<td>IF PersonParty is a TCHFactTypeDictionary.PersonPartyVO and there's a case where (OrigSourceSystem) != null and OrigSourceSystem.OwnerTableId == PersonParty.PartyId and OrigSourceSystem.OrigSystem == &quot;GSI&quot;</td>
</tr>
<tr>
<td>THEN Condition</td>
<td>THEN Assert new Result (name: &quot;masterId&quot;, value: &quot;PersonParty.PartyId&quot;)</td>
</tr>
</tbody>
</table>

Note the following specification in the Define Survivorship Rules: Select Master Record page.

- Click the + icon to add additional patterns to include additional conditions
- Click the Surround with Parenthesis option to add more features to the conditions
- Select the + Simple Test option to add additional clauses
3. Click the Advanced Settings button to verify the effective date of the rule that you're going to create.

The following figure shows Advanced Settings icon on the Define Survivorship Rule: Select Master Record page.

4. Select an effective date, as appropriate. The default effective date is Always. You can select an Effective From or Effective To date, or you can select an Effective Date range.
5. Select a priority for the rule, as appropriate.

The default priority of the Survivorship rules is Medium. These rules get executed in the order of their priority.
6. Ensure that the Rules Active option is selected.
The following figure shows how the survivorship rule looks like when fully defined. The details include the rule name and the IF and THEN conditions for determining the master.

7. Click Save and Close. You can view the newly created rule in the Manage Survivorship Rules page by searching for it.
8. Click Submit.

Tip: To activate the rule you must click Submit. You may have selected the Active mode, but that doesn't activate a rule unless submitted.

Related Topics
- Implementing Customer Data Management: Define Survivorship
- MOS document: Define Survivorship Rules

Define Set Master Record Rules
This procedure demonstrates how to create a survivorship rule of the type Set Master Record. You can determine survivorship at the record level using the set master record rule type. Set master rules are used in party merge to set a single record as the master record.

Create Set Master Record Rules
The input to the survivorship rule is given in the IF clause. In a set master rule, the input is a set of party records. The THEN clause contains the output that determines the master record. In the Set Master Record rule, the output is a
result object that contains a specific Party ID. If multiple records with different Party IDs are returned, then it results in a conflict error. To create Set Master rules, you may perform the following steps:

To create Set Master rules, you perform the following steps:

1. Navigate to the Manage Survivorship Rules task.
2. Click Add. The Create Survivorship Rule page appears.
3. Enter the information provided in the following table on the Create Survivorship Rule page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Name</td>
<td>PickOrganizationMasterRule</td>
</tr>
<tr>
<td>Description</td>
<td>Select the master organization record based on the specified criteria for setting the master record.</td>
</tr>
<tr>
<td>Rule Type</td>
<td>Set master record</td>
</tr>
<tr>
<td>Object Type</td>
<td>Organization</td>
</tr>
</tbody>
</table>

4. Click Apply. You’re taken to the Define Survivorship Rules: Select Master Record page.

In the Define Survivorship Rules: Select Master Record page, you specify criteria for picking the master record. The criteria that you define in this page determine the output of the rule.

The following topics contains three worked examples that show different ways of defining criteria in the Define Survivorship Rules: Select Master Record page to set a master records:

- Set the Record with Oldest Creation Date as Master
- Set the Record with D-U-N-S Number and Smallest Party ID as Master
- Set the Record with D-U-N-S Number and Highest Number of Party Site as Master

How You Set the Record with the Oldest Creation Date as Master

This rule has a single condition to set a record that has the oldest creation date as the master.

1. Navigate to the Define Survivorship Rules: Select Master Record page.
2. Enter the information provided in the following table as IF/THEN rules condition in the Define Survivorship Rule: Select Master Record page.

<table>
<thead>
<tr>
<th>Rule Condition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IF Condition</td>
<td>IF master is an HZ_PERSON_FactType.PersonPartyVO and there is no case where {nonmaster == HZ_PERSON_FactType.PersonPartyVO and master.PartyId isn't nonmaster.PartyId and master.creationDate is more than nonmaster.CreationDate}</td>
</tr>
<tr>
<td>THEN Condition</td>
<td>THEN Assert new Result (name:&quot;masterId&quot;, value: master.PartyId)</td>
</tr>
</tbody>
</table>
The following figure displays the Define Survivorship Rules: Select Master Record page with completely filled IF and THEN rules conditions for setting a record that has the oldest creation date as the master.

How You Set the Record with D-U-N-S Number and Smallest Party ID as Master

This rule identifies and returns the master record based on the following three conditions in the order of priority listed:

1. Pick master that has D-U-N-S Number.
2. If more than one record has D-U-N-S Number, pick one based on the smallest Party ID.
3. If no record has D-U-N-S Number, pick one based on the smallest Party ID.

The following are the use cases for a set master record rule to pick the master based on the D-U-N-S number and the smallest Party ID.

**Use Case 1**

In this case, there are two records with D-U-N-S number. Therefore, the record with the smaller party ID is picked as the master record. The following table contains the sample record information for this use case.

<table>
<thead>
<tr>
<th>Record Name</th>
<th>Party ID</th>
<th>D-U-N-S Number</th>
<th>Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>11</td>
<td>998837472</td>
<td>Yes</td>
</tr>
</tbody>
</table>
The following table lists the IF and THEN rules condition values that you must enter on the Define Survivorship Rules: Select Master Record page for this use case.

<table>
<thead>
<tr>
<th>Rule Condition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IF Condition</td>
<td>Pick D-U-N-S number{IF master is an HZ_PERSON_FactType.OrganizationPartyVO master.DUNsNumberC isn’t null} masterPartyID is the minimum of masterPartyID where {master= HZ_PERSON_FactType.OrganizationPartyVO and master.DUNsNumberC isn’t null}</td>
</tr>
<tr>
<td>THEN Condition</td>
<td>THEN Assert new Result (name:&quot;masterId&quot;, value:” master.PartyId)</td>
</tr>
</tbody>
</table>
The following figure shows the Define Survivorship Rules: Select Master Record page with IF and THEN rules conditions for picking the record with D-U-N-S number and minimum party ID as master.

Use Case 2

In this case, there is no record with D-U-N-S number. Therefore, the record with smallest party ID is picked as the master record. The following table lists the sample record information for this use case.

<table>
<thead>
<tr>
<th>Record Name</th>
<th>Party ID</th>
<th>D-U-N-S Number</th>
<th>Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>21</td>
<td>null</td>
<td>Yes</td>
</tr>
<tr>
<td>Record 2</td>
<td>22</td>
<td>null</td>
<td>No</td>
</tr>
</tbody>
</table>
The following table lists the IF and THEN rules condition values that you must enter on the Define Survivorship Rules: Select Master Record page for this use case.

<table>
<thead>
<tr>
<th>Record Name</th>
<th>Party ID</th>
<th>D-U-N-S Number</th>
<th>Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 3</td>
<td>23</td>
<td>null</td>
<td>No</td>
</tr>
</tbody>
</table>

The following figure displays the Define Survivorship Rules: Select Master Record page with completely filled IF and THEN rules conditions to set the record that has the smallest party ID as the master when no record with D-U-N-S number is found.
In this example, you have created two set master rules for Organization. First rule is for the cases where the input records have at least one record with D-U-N-S number. The second is for the case where no records have D-U-N-S Number.

**Note:** You can activate more than one survivorship rule at a time. When you activate multiple rules, make sure that the rules aren't conflicting and the conditions in the rule are set according to the priority.

How You Set the Record with D-U-N-S Number and Highest Number of Party Sites as Master

This rule identifies and returns the master record based on the following three conditions in the order of priority listed:

1. Pick master that has D-U-N-S Number.
2. Pick master that has more party sites.
3. Pick master that has the smallest Party ID.

The following are two use cases for creating a set master rule to select the master record based on D-U-N-S number, number of party sites, and party ID:

**Use Case 1**

In this case, there are three records with D-U-N-S number and two records with highest number of party sites. Among those two records, the one with the lower value for party ID is selected as master. The following table contains the sample record information for this use case.

<table>
<thead>
<tr>
<th>Record Name</th>
<th>Party ID</th>
<th>Number of Party Sites</th>
<th>D-U-N-S Number</th>
<th>Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>11</td>
<td>3</td>
<td>198837472</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Use Case 2

In this case, there are no records with D-U-N-S number. So, among the two records with higher number of party sites, the record with the smaller party ID is picked as the master record. The following table contains the sample record information for this use case.

<table>
<thead>
<tr>
<th>Record Name</th>
<th>Party ID</th>
<th>Number of Party Sites</th>
<th>D-U-N-S Number</th>
<th>Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 2</td>
<td>12</td>
<td>3</td>
<td>489203901</td>
<td>No</td>
</tr>
<tr>
<td>Record 3</td>
<td>13</td>
<td>2</td>
<td>384792392</td>
<td>No</td>
</tr>
<tr>
<td>Record 4</td>
<td>14</td>
<td>1</td>
<td>null</td>
<td>No</td>
</tr>
</tbody>
</table>

To create a master record with D-U-N-S number, number of party sites, and party ID, you add one more condition to the previous example where you set a master record with D-U-N-S number. Adding a condition to the previous example makes the rules complicated and cumbersome. Instead, you can create a simple rule for each condition to narrow down the list of potential master records and create another simple rule in the end to pick one record from the remaining potential master records.

**Note:** You can activate more than one survivorship rule at a time. When you activate multiple rules, make sure that the rules aren't conflicting and the conditions in the rule are set according to the priority.

The following figure displays the Survivorship Rules: Select Master Record page with the IF and THEN rules condition values for creating a set master rule to set the record that has D-U-N-S Number as master. The priority of the rule is set as highest. The details of the conditions are as follows:

**Priority: Highest**

**IF condition:** If number of non-null DUNS records is the count where {master is a HZ_ORGANIZATION_FactType.OrganizationPartyVO and master.DUNSNumberC isn't null} and number of non-null DUNS records more than 0 and master is a HZ_ORGANIZATION_FactType.OrganizationPartyVO and master.DUNSNumberC is null.
THEN condition: Then retract master

Now, you set the conditions to set the record with the maximum number of party sites as the master.

The following figure shows the Survivorship Rules: Select Master Record page with the IF and THEN condition values to set the record with the maximum number of party sites as the master from the remaining potential records. The priority of the rule is set as higher. The details of the conditions are as follows.

Priority: Higher

IF condition: If maximum party site number is the maximum of master.PartySite.size() where {master is a HZ_ORGANIZATION_FactType.OrganizationPartyVO} and master is a HZ_ORGANIZATION_FactType.OrganizationPartyVO and master.PartySite.size() isn't maximum party site number

THEN condition: Then retract master
When the records are screened with two previous conditions, you create a third condition to screen all remaining potential records with the smallest party ID.

The following figure shows the Survivorship Rules: Select Master Record page with the IF and THEN condition values for creating a set master rule to set the record with the smallest party ID as the master. The priority of the rule is set as medium. The details of the conditions are as follows.

**Priority:** Medium

**IF condition:** If masterPartyId is the minimum of master.PartyId where {master is a HZ_ORGANIZATION_FactType.OrganizationPartyVO}

**THEN condition:** Assert new Result(name: "masterId", value:masterPartyId)
In this example, the rules are created to narrow down the list of potential master records. When you activate more than one rule at a time you should set the conditions for the rule according to the priority to narrow down the list of potential master records. In this example Eliminate Null D-U-N-S Number rule is executed first to select records with D-U-N-S Number. Select the Most Address rule is executed next to find the master record with most number of party sites among the potential master records having D-U-N-S Number. Finally, Select Minimum Party ID rule is executed at the end to pick the minimum party ID from the remaining party records.

**Define Set Attribute Value Rules**

This example demonstrates how to create a survivorship rule of the type Set Attribute Value. You can determine survivorship at the attribute level using the set attribute value survivorship rule type. Set attribute value rules are used in party merge to determine which attribute value should come from which record.

The input to the survivorship rule is given in the IF clause. In a set attribute value rule, the inputs are the party records and their source information. The source information contains information about all attributes for each record in the database. If you're creating rules that use the Source information VO, you define it in the Define Source Systems Confidence page of the Manage Source System Confidence task. You must map each attribute to its source system and given a Source Confidence score on a scale of 1 to 100.

The following table lists the attributes in the source information VO to create a set attribute value rule.
<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RecordId</td>
<td>The record ID of a specific attribute.</td>
</tr>
<tr>
<td>AttributeName</td>
<td>The name of the attribute.</td>
</tr>
<tr>
<td>Source</td>
<td>The source system from where the attribute is updated.</td>
</tr>
<tr>
<td>SourceConfidenceLevel</td>
<td>The source confidence level assigned to the source system.</td>
</tr>
<tr>
<td>SourceUpdateDate</td>
<td>The date when the attribute was last updated.</td>
</tr>
</tbody>
</table>

The THEN clause determines the output object that picks the survivor record. In this case, `setAttribute` function creates the output object. To create Set Attribute Value rules, you perform the following steps:

1. Navigate to the Manage Survivorship Rules task.
2. Click Add. The Create Survivorship Rule page appears.

   **Tip:** You can select attributes from the available attributes in the Create Survivorship Rule page. It pre-populates the rule template with the selected attributes. It’s not mandatory to set attributes from the available attribute.

3. Enter the sample information provided in the following table on the Create Survivorship Rule page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Name</td>
<td>PickAttributeValueRule</td>
</tr>
<tr>
<td>Description</td>
<td>Select the survivor value for a specific attribute based on specified survivor selection criteria.</td>
</tr>
<tr>
<td>Select the survivor value for a specific attribute based on specified survivor selection criteria.</td>
<td>Set attribute value</td>
</tr>
<tr>
<td>Object Type</td>
<td>Organization</td>
</tr>
<tr>
<td>Template</td>
<td>Select the Attribute Based template to select the surviving value based on the characteristic of the attributes. For example, you need an Attribute Based template to pick an attribute with the highest or lowest value such as a party number, or salary, or the earliest incorporated year. Select the Source Confidence Based template to select the surviving value based on the confidence in the source information.</td>
</tr>
</tbody>
</table>

4. Select attributes from the available attributes to pre-populate the rules template. In case you want to use the predefined set attribute rules, don’t select any attributes.
5. Click Apply. You’re taken to the Define Survivorship Rules: Select Attribute Value page.
In the Define Survivorship Rules: Select Attribute Value page, you specify criteria for selecting the survivor attribute value. The criteria that you define in this page determine the feature of the rule. You also have the option of using one of the following three predefined templates:

- Highest Source Confidence Level Wins for Organization (or Person): Use this rule to select the attribute values with the highest source confidence level.
- Most recently updated Organization (or person) attribute: Use this rule to select the attribute values with the most recently updated date.
- Least recently updated Organization (or person) attribute: Use this rule to select the attribute values with the oldest updated date.

The following sections of this topic contain three worked examples that show different ways of manually setting survivor attribute values in the Define Survivorship Rules: Select Attribute Value page. They are as follows:

- Set the Values with the Earliest Update Date as the Surviving Attribute Values
- Set the Value with the Highest Source Confidence Level as the Surviving Attribute Value for D-U-N-S Number
- Set the Values with the Earliest Incorporated Year as the Surviving Attribute Values

How You Set the Values with the Earliest Update Date as Surviving Attribute Values

This rule has a single condition to set all the surviving attribute values based on the earliest update date. The following is a use case for a set attribute rule to select the values with the earliest update date as surviving attribute values:

**Use Case 1**

**Party Record**

The following table contains information for party records.

<table>
<thead>
<tr>
<th>Record Name</th>
<th>Party ID</th>
<th>Party Name</th>
<th>D-U-N-S Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>1</td>
<td>Oracle Corp</td>
<td>198837472</td>
</tr>
<tr>
<td>Record 2</td>
<td>2</td>
<td>Oracle USA Corp</td>
<td>489203901</td>
</tr>
<tr>
<td>Record 3</td>
<td>3</td>
<td>Oracle</td>
<td>null</td>
</tr>
</tbody>
</table>

**Source Information**

The following table contains information for source information records.

<table>
<thead>
<tr>
<th>Record ID</th>
<th>Attribute Name</th>
<th>Source</th>
<th>Source Confidence Level</th>
<th>Source Update Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Party Name</td>
<td>FUSION</td>
<td>95</td>
<td>1/5/2016</td>
</tr>
<tr>
<td>2</td>
<td>Party Name</td>
<td>FUSION</td>
<td>95</td>
<td>1/5/2010</td>
</tr>
</tbody>
</table>
In this case:

- The D-U-N-S number attribute value from the record with ID 1 is selected as survivor because the source information indicates that it has the earliest source update date.
- The Party Name attribute value from the record with the ID 3 is selected as survivor because the source information indicates that it has the earliest source update date.

Populate the Define Survivorship Rules: Select Attribute Values page with the IF and THEN rules condition values provided in the following table.

<table>
<thead>
<tr>
<th>Rule Condition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IF Condition</strong></td>
<td>IF picked attribute is a AttributeSourceInfoVO and there is no case where { Other Attribute == AttributeSourceInfoVO and there is no case where Other Attribute is a AttributeSourceInfoVO Picked Attribute.AttributeName is OtherAttribute.AttributeName and PickedAttribute.RecordId isn't Other Attribute.RecordId and Picked Attribute.SourceUpdateDate more than OtherAttribute.SourceUpdateDate}</td>
</tr>
<tr>
<td><strong>THEN Condition</strong></td>
<td>THEN call setAttribute (picked attribute.AttributeName, Picked Attribute.RecordId)</td>
</tr>
</tbody>
</table>

The following figure displays the Define Survivorship Rules: Select Attribute Values page with the IF and THEN rules conditions to create the set attribute value rule that selects the values with the earliest source update date as the surviving attribute value. The figure provides the following details.

Name of the rule: History Wins

IF condition: If picked attribute is a AttributeSourceInfoVO and there is no case where {Other Attribute is AttributeSourceInfoVO and Picked Attribute.AttributeName is Other Attribute.AttributeName and PickedAttribute.RecordId isn't Other Attribute.RecordId and Picked Attribute.SourceUpdateDate more than Other Attribute.SourceUpdateDate}
Then call `setAttribute (Picked Attribute.AttributeName, Picked Attribute.RecordId)`

How You Set the Value with the Highest Source System Confidence Level as the Surviving Attribute Value for D-U-N-S Number

This rule has a single condition to select the D-U-N-S number value with the highest source confidence level as the surviving attribute value for the D-U-N-S number attribute. The following is a use case for a set attribute rule to select the D-U-N-S number value with the highest source confidence level as the surviving attribute value:

**Use Case**

**Party Record**

The following table contains information for party records.
In this case, the party record contains three records with the attribute Party Name and two records with D-U-N-S number. These attributes are picked to create the source information. The source information table defined using the attributes from this party record table is as follows:

### Source Information

The following table contains information for source information records.

<table>
<thead>
<tr>
<th>Record ID</th>
<th>Attribute Name</th>
<th>Source</th>
<th>Source Confidence Level</th>
<th>Source Update Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Party Name</td>
<td>FUSION</td>
<td>95</td>
<td>1/5/2016</td>
</tr>
<tr>
<td>2</td>
<td>Party Name</td>
<td>FUSION</td>
<td>95</td>
<td>1/5/2010</td>
</tr>
<tr>
<td>3</td>
<td>Party Name</td>
<td>SIEBEL</td>
<td>90</td>
<td>1/5/2000</td>
</tr>
<tr>
<td>1</td>
<td>D-U-N-S Number</td>
<td>DNB</td>
<td>100</td>
<td>2/5/1990</td>
</tr>
<tr>
<td>2</td>
<td>D-U-N-S Number</td>
<td>FUSION</td>
<td>95</td>
<td>1/5/2016</td>
</tr>
</tbody>
</table>

In this case, the D-U-N-S attribute value for the record with ID 1 is selected as survivor because the source information indicates that it has the highest source confidence level among all records that have the D-U-N-S Number attribute.

The following figure displays Define Survivorship Rules: Select Attribute Values page with the IF and THEN rules condition values to set the attribute value with the highest source system confidence level as the survivor. The figure provides the following details.

Name of the rule: Highest Source Confidence Level

**IF condition**: If picked attribute is a AttributeSourceInfoVO and Picked Attribute.AttributeName is EnquireDUNSNumberC and there is no case where {Other Attribute is a AttributeSourceInfoVO and Picked Attribute.AttributeName is Other Attribute.AttributeName and Picked Attribute.RecordId isn’t Other Attribute.RecordId and Picked Attribute.SourceConfidenceLevel is less than OtherAttribute.SourceConfidenceLevel}
THEN condition: Then call setAttribute (Picked attributeAttributeName, Picked Attribute.RecordId)

How You Set the Values with the Earliest Incorporated Year as the Surviving Attribute Values
This rule has a single condition to select values with the earliest incorporated year as the surviving attribute values. The following is a use case for creating such a set attribute value rule:

**Use Case 1**

**Party Record**

The following table contains information for party records.

<table>
<thead>
<tr>
<th>Record Name</th>
<th>Party ID</th>
<th>Party Name</th>
<th>Incorporated Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>1</td>
<td>Oracle Corp</td>
<td>1980</td>
</tr>
<tr>
<td>Record 2</td>
<td>2</td>
<td>Oracle USA Corp</td>
<td>1990</td>
</tr>
<tr>
<td>Record 3</td>
<td>3</td>
<td>Oracle</td>
<td>2000</td>
</tr>
</tbody>
</table>

In this case, the party record table contains three records with the attributes Party Name, Party ID, and Incorporated Year. The attribute values for the record with the earliest incorporated year are picked as survivor attribute values.
The following figure displays Define Survivorship Rules: Select Attribute Values page with the IF and THEN rules condition values to set the attribute with the earliest incorporated year as the survivor. The figure provides the following details.

Name of the rule: Selecting the Earliest Incorporated Year

IF condition: If for each case where org is a OrganizationDVO and org.IncorpYear isn't null and there is no case where another org is a OrganizationDVO and org.PartyId isn't another org.PartyId and another org.IncorpYear isn't null and org.IncorpYear.intValue() is more than another org.incorpyear.intValue()

THEN condition: Then call setAttribute ("IncorpYear", org.PartyId)

Survivorship Rules for Parties with Custom Objects and Attributes

This topic describes how to define survivorship rules for merging parties having custom objects and attributes. For example, you can define a survivorship rule of the type Set Master Record to select the party with the maximum number of custom objects or the party with a specific attribute as the master. You can also define a survivorship rule of the type Set Attribute Value to select the smallest value for a specific attribute.
Custom Objects and Attributes
You can use Oracle Application Composer to configure and extend Oracle CX Sales and B2B Service applications. The Application composer provides you the ability to extend an Oracle CX Sales and B2B Service application's object model. You can configure CX Sales and B2B Service objects by adding new fields (custom fields or custom attributes) to an existing object (standard objects). Or you create entirely new objects (custom objects) and related fields (custom attributes).

Custom Objects and Attributes in Survivorship Rules
The following table describes the basic merge operations that can be performed on standard or custom objects.

<table>
<thead>
<tr>
<th>Object</th>
<th>Examples</th>
<th>Can be merged</th>
<th>Can be transferred</th>
<th>Can be removed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Top-Level Object</td>
<td>Account/Organization</td>
<td>Yes</td>
<td>Not applicable for top-level objects</td>
<td>Not applicable for top-level objects</td>
</tr>
<tr>
<td></td>
<td>Contact/Person</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard Child Object</td>
<td>Address</td>
<td>Yes (by reviewing in the Data Steward UI)</td>
<td>Yes (by default if not merged or removed)</td>
<td>Yes (by reviewing in the Data Steward UI)</td>
</tr>
<tr>
<td></td>
<td>Phone</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard Child Object</td>
<td>Lead</td>
<td>No</td>
<td>Yes (always)</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Opportunity</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom Top-Level Object</td>
<td>Not applicable (implementation specific)</td>
<td>No</td>
<td>Not applicable for top-level objects</td>
<td>Not applicable for top-level object</td>
</tr>
<tr>
<td>Custom Child Object</td>
<td>Not applicable (implementation specific)</td>
<td>No</td>
<td>Yes (always)</td>
<td>No</td>
</tr>
</tbody>
</table>

The following table describes whether or not these objects and attributes can be used while defining conditions, clauses, and actions for survivorship rules of the type Set Master Record and Set Attribute Value.

<table>
<thead>
<tr>
<th>Object</th>
<th>Examples</th>
<th>Can be used in Set Master Record rule conditions</th>
<th>Can be used in Set Master Record rule actions</th>
<th>Can be used in Set Attribute Value rule conditions</th>
<th>Can be used in Set Attribute Value rule actions</th>
<th>Can be used for Attribute Override in Data Steward UI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Top-Level Object</td>
<td>Account/Organization</td>
<td>Yes (standard and custom attributes)</td>
<td>Yes (standard record ID attribute)</td>
<td>Yes (standard record ID attribute)</td>
<td>Yes (standard record ID attribute)</td>
<td>Yes (standard and custom attributes)</td>
</tr>
<tr>
<td></td>
<td>Contact/Person</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Example of Defining Set Master Record Rules for Parties with Custom Child Objects

This topic explains how to define a survivorship rule of the type Set Master Record to select the party with the maximum number of custom child objects.

This rule identifies and returns the master record based on the following two conditions:

1. Pick master that has the most custom child objects.
2. Pick master that has the highest party ID.

The following table provides the details of a use case for set master record rule to select the party with the maximum number of custom child objects and the highest party ID as the master record.

<table>
<thead>
<tr>
<th>Record Number</th>
<th>Party ID</th>
<th>Number of Custom Child Objects</th>
<th>Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>11</td>
<td>3</td>
<td>No</td>
</tr>
<tr>
<td>Record 2</td>
<td>12</td>
<td>3</td>
<td>Yes</td>
</tr>
<tr>
<td>Record 3</td>
<td>13</td>
<td>3</td>
<td>No</td>
</tr>
<tr>
<td>Record 4</td>
<td>14</td>
<td>1</td>
<td>No</td>
</tr>
</tbody>
</table>
In this case, there are two records with the same number of custom child objects. Therefore, the record with the highest party ID is picked up as the master record.

**Note:** The number of child objects of the custom object is shown up as Fact Types. You can also find out the number of child objects using the accessor inside OrganizationDVO or PersonDVO.

The following figure displays Define Survivorship Rules: Select Master Record page with the IF and THEN rules condition values for creating the set master rule to pick up the record with the highest party ID and maximum custom child objects as the master record.

---

### Example of Defining Set Master Record Rules for Parties with Custom Attributes

This topic explains how to define a survivorship rule of the type Set Master Record to select the party with a specific custom attribute as the master.

This rule identifies and returns the master record based on the following two conditions:

1. Pick master that has a specified custom attribute. In this case the custom attribute is Testfieldone_c.
2. Pick master that has the highest Party ID.

The following table provides the details of a use case for setting master record rule to select the party with a specific custom attribute as the master.
In this case, there are two records with the custom attribute Testfieldone_c. Therefore, the record with highest party ID is picked as the master record.

The following figure displays Define Survivorship Rules: Select Master Record page with the IF and THEN rules condition values to create the set master record rule to pick the record with specified attributes as the master. The details of the conditions are as follows:

**IF condition:** If masterPartyId is the maximum of master.PartyId where {master is a HZ_PERSON_FactType.PersonDVO and master.Testfieldone_c isn't null}

**THEN condition:** Then Assert new Result (name: "masterId", value: masterPartyId)

<table>
<thead>
<tr>
<th>Record Number</th>
<th>Party ID</th>
<th>Testfieldone_c</th>
<th>Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>11</td>
<td>Test</td>
<td>No</td>
</tr>
<tr>
<td>Record 2</td>
<td>12</td>
<td>Test</td>
<td>Yes</td>
</tr>
<tr>
<td>Record 3</td>
<td>13</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Record 4</td>
<td>14</td>
<td>None</td>
<td>No</td>
</tr>
</tbody>
</table>
Example of Defining Set Attribute Value Rules for Custom Attributes

This topic explains how to define a survivorship rule of the type Set Attribute Value to select the smallest value for a specific attribute. This rule has a single condition where it picks a record that has the smallest value for the specified custom attribute.

The following table contains the details of a use case for a set attribute value rule to select the smallest value for a specific custom attribute as the survivor. In this case the example attribute name is CustomField1_c.

<table>
<thead>
<tr>
<th>Record Number</th>
<th>Party ID</th>
<th>CustomField1_c Attribute Value</th>
<th>Party Name</th>
<th>Survivor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>11</td>
<td>123</td>
<td>Oracle Corp</td>
<td>Yes</td>
</tr>
<tr>
<td>Record 2</td>
<td>12</td>
<td>1456</td>
<td>Oracle USA Corp</td>
<td>No</td>
</tr>
<tr>
<td>Record 3</td>
<td>13</td>
<td>239940</td>
<td>Oracle</td>
<td>No</td>
</tr>
</tbody>
</table>

In this case, there are three records with CustomField1_c custom attribute. The value 123 is picked up as the survivor value for the CustomField1_c custom attribute because it's the smallest value for that attribute.

The following figure displays the Define Survivorship Rules: Select Attribute Value page with the IF and THEN rules condition values to create the set attribute value rule to pick the smallest value for the CustomField1_c custom attribute as the survivor. The details of the conditions are as follows:

**IF condition:**

If (for each case where) {org is a OrganizationDVO and org.CustomField1_c isn't null } and there is no case where {another org is a OrganizationDVO and another org.CustomField1_c isn't null and org.PartyId isn't another org.PartyId and org.CustomField1_c.length() more than another org.CustomField1_c.length()}
THEN condition: Then call setAttribute("CustomField1_c", org.PartyId)

What's the difference between survivorship rules and merge agreement rules?
Survivorship rules are a collection of business rules defined for the creation of the best version record intelligently, especially from multiple source systems, by specifying criteria for selecting record and attributes to be retained during merge or link operations.

A merge agreement rule is a collection of patterns and conditions that are defined to determine whether a merge request should be vetoed by the application or not. Merge requests that violate these rules are either rejected or end in error.
How can I check if the survivorship rules that I created work?
You can create two parties and merge them into a single record to check if your survivorship rules are working. You must ensure that your survivorship rules are active before merging the parties.

What are the seeded sample survivorship rules that Oracle Fusion Applications provide by default?
Oracle Fusion Applications offer the following sample survivorship rules:

- For organizations, history wins: The attribute value with earlier source update date wins. This rule is applicable for all organization attributes.
- For persons, recent wins: The attribute value with later source update date wins. This rule is applicable for all person attributes.
- For organizations, assign the highest source confidence level to the D-U-N-S number.

The seeded survivorship rules are in inactive status out-of-the-box. These rules are updated with every release. However, once you change these rules, these rules aren't updated.

Agreement Rules

Overview of Agreement Rules
An agreement rule is a collection of patterns and conditions that are defined to determine whether a merge request should be vetoed by the application or not. Merge requests that violate these rules are either rejected or end in error.

Agreement rules let you check a merge request for any veto conditions that can prevent a merge from occurring. These rules save resources and time by obviating the need to review merge requests to prevent undesired merge from being processed. Besides, agreement rules prompt you to consider alternative duplicate resolution mechanism such as linking.

Agreement rule can be of the following two types:

- Predefined
- User-defined

Predefined Agreement Rules
These are agreement rules that are predefined in the application. You can only view the predefined agreement rules. The following table describes the predefined agreement rules shipped out of the box with the application. Merge requests that violate these rules are automatically rejected.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR_APPLICANT_VETO</td>
<td>Prevents a person party with an active party usage of HR_APPLICANT from merging with another party.</td>
</tr>
<tr>
<td>HR_EMPLOYEE_VETO</td>
<td>Prevents a person party with an active party usage of HR_EMPLOYEE from merging with another party.</td>
</tr>
</tbody>
</table>
## Duplicate Resolution Setup

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR_CONTINGENT_WORKER_VETO</td>
<td>Prevents a person party with an active party usage of <code>HR_CONTINGENT_WORKER</code> from merging with another party.</td>
</tr>
<tr>
<td>HR_PARTY_SITE_VETO</td>
<td>Prevents a party site with active original system reference from Oracle Fusion Human Capital Management system from merging with another party site.</td>
</tr>
<tr>
<td>RESOURCE_PERSON_VETO</td>
<td>Prevents a person party with an active party usage of <code>RESOURCE</code> from merging with another party.</td>
</tr>
<tr>
<td>BANK_VETO</td>
<td>Prevents an organization party with an active party usage of <code>BANK</code> from merging with another party.</td>
</tr>
<tr>
<td>CLEARINGHOUSE_VETO</td>
<td>Prevents an organization party with an active party usage of <code>CLEARINGHOUSE</code> from merging with another party.</td>
</tr>
<tr>
<td>BANK_BRANCH_VETO</td>
<td>Prevents an organization party with an active party usage of <code>BANK_BRANCH</code> from merging with another party.</td>
</tr>
<tr>
<td>BRANCH_CLEARINGHOUSE_VETO</td>
<td>Prevents an organization party with an active party usage of <code>CLEARINGHOUSE_BRANCH</code> from merging with another party.</td>
</tr>
<tr>
<td>LEGAL_EXTLEGAL_PARTYUSGRULE_VETO</td>
<td>Prevents an organization party with active party usage of <code>LEGAL_ENTITY</code> from merging with another organization party with active party usage of <code>EXTERNAL_LEGAL_ENTITY</code>.</td>
</tr>
<tr>
<td>IC_PARTICIPANT_PERSON_VETO</td>
<td>Prevents a person party with an active party usage of <code>INCENTIVE_COMP_PARTICIPANT</code> from merging with another party.</td>
</tr>
<tr>
<td>IC_PARTICIPANT_ORG_VETO</td>
<td>Prevents an organization party with an active party usage of <code>INCENTIVE_COMP_PARTICIPANT</code> from merging with another party.</td>
</tr>
<tr>
<td>PARTNER_VETO</td>
<td>Prevents an organization party with an active party usage of <code>PARTNER</code> from merging with another party.</td>
</tr>
<tr>
<td>INACTIVE_PARTNER_VETO</td>
<td>Prevents an organization party with an active party usage of <code>INACTIVE_PARTNER</code> from merging with another party.</td>
</tr>
<tr>
<td>CUST_CONTACT_DIFF_RESOURCE_ORG_VETO</td>
<td>Prevents two partner owned contacts belonging to different resource organizations from being merged.</td>
</tr>
<tr>
<td>CUST_CONTACT_INTERNAL_PARTNER_VETO</td>
<td>Prevents a partner owned contact that doesn't belong to a resource organization from merging with another partner owned contact that belongs to a resource organization.</td>
</tr>
<tr>
<td>CUST_CONTACT_INTERNAL_PARTNER_ORG_VETO</td>
<td>Prevents a contact owned by an internal user from merging with a contact owned by a partner user.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CARD_ISSUER_VETO</td>
<td>Prevents an organization party with an active party usage of CREDIT_CARD_PROVIDER from merging with another party.</td>
</tr>
<tr>
<td>LEGAL_ENTITY_VETO</td>
<td>Prevents an organization party with an active party usage of LEGAL_ENTITY from merging with another party.</td>
</tr>
<tr>
<td>ESTABLISHMENT_VETO</td>
<td>Prevents an organization party with an active party usage of ESTABLISHMENT from merging with another party.</td>
</tr>
<tr>
<td>HIERARCHY_CYCLE_PREVENTATION_VETO</td>
<td>Prevents merge from happening when the master party record is at a level lower than the nonmaster party record within the same active tree version.</td>
</tr>
<tr>
<td>NAMEDACCOUNT_UNNAMEDACCOUNT_VETO</td>
<td>Prevents merge from happening when the master party record isn’t a named account whereas the nonmaster party record is a named account and these are in active hierarchies.</td>
</tr>
</tbody>
</table>

**User-defined Agreement Rules**

These are additional agreement rules that you can define to determine whether a merge request should be vetoed by the application. You can create, view, update, and delete user-defined agreement rules.

**Note:** The application doesn't support changing agreement rules inside the Application Composer sandbox. Therefore, the merge engine doesn’t pickup the changes made to these rules inside the Application Composer sandbox.

**Agreement Rules Dictionary**

An agreements rules dictionary is a collection of predefined terms and attributes that can be used to define agreement rules. The Oracle Customer Data Hub comes with a single predefined dictionary (HZ_Parties) that contains all the predefined Agreement Rules shipped out of the box with the application. You can also use this dictionary to define custom agreement rules according to your business requirements. Note that you can only view the predefined agreement rules. You can’t edit them. In contrast, you can create, view, update, and delete user-defined agreement rules. Merge requests that violate agreement rules are rejected.

Before using this dictionary to define custom agreement rules, you must review whether the agreement rule terms and term attributes existing in the predefined agreement rules dictionary are sufficient to define custom agreement rules needed to meet your business requirements. If required, refresh terms to import the latest terms, term attributes, and related metadata, for example, fact types such as entities and objects. Refreshing the dictionary help you pull in all the newly added custom attributes for accounts and contacts.

**Define Agreement Rules**

This example demonstrates how to create user-defined agreement rules that you can use to prevent a merge request from being processed.

Agreement rules are collections of patterns and conditions that are defined to determine whether a merge request should be vetoed by the application or not. Perform the following tasks to define agreement rules:

- Review and refresh terms in the predefined agreement rules dictionary shipped out of the box
- Add a new agreement rule

**Review and Refresh Terms in the Predefined Agreement Rules Dictionary**

The Customer Hub application is shipped with a predefined agreement rules dictionary that contains all the predefined Agreement Rules shipped out of the box with the application. Before using this dictionary to define custom agreement rules, you must review whether the agreement rule terms and term attributes existing in the predefined agreement rules dictionary are sufficient to define custom agreement rules needed to meet your business requirements. If required, refresh terms to import the latest terms, term attributes, and related metadata, for example, fact types such as entities and objects. Refreshing the dictionary helps you pull in all the newly added custom attributes for accounts and contacts. Use the following steps to review and refresh the agreement rules dictionary:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Customer Hub
   - Task: Manage Agreement Rules
2. On the Manage Agreement Rules page, review whether the agreement rule terms and term attributes existing in the predefined agreement rules dictionary are sufficient to define custom agreement rules needed to meet your business requirements.
3. Click **Refresh Terms** to import the latest terms, term attributes, and related metadata.
4. Click **OK** in response to the confirmation message.

**Add a New Agreement Rule**

After reviewing and refreshing the Agreement Rules Dictionary using the earlier steps, perform the following steps to create a new custom agreement rule:

1. On the Manage Agreement Rules page, click **Next** to navigate to the Manage Agreement Rules: Define Rules page.
2. Click **Add** from the Actions menu to add a new rule.
3. Enter a rule name.
4. Click **Define Rule**.
5. Enter the reason for creating the agreement rule in the **Justification Reason**.
6. Click **Add** from the Actions menu to create a new pattern.
7. Complete the fields in the new pattern field using the sample information provided in the following table. Use the default values except where indicated. Note that the relation is always AND between patterns and can’t be edited. You must include the Dictionary Terms OrganizationPartyVO and PersonPartyVO, with defined MergeType, into the Define Patterns column. These patterns determines the master and nonmaster records.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Dictionary Term</th>
<th>Term Alias</th>
<th>Relation</th>
</tr>
</thead>
<tbody>
<tr>
<td>for each case where</td>
<td>PersonPartyVO</td>
<td>Person</td>
<td>AND</td>
</tr>
<tr>
<td>for each case where</td>
<td>OrganizationPartyVO</td>
<td>NonmasterParty</td>
<td>AND</td>
</tr>
<tr>
<td>there is a case where</td>
<td>PartyUsageAssignmentVO</td>
<td>PartyUsageAssignment</td>
<td>AND</td>
</tr>
</tbody>
</table>

8. Navigate to the Conditions table.
Click Add from the Actions menu to add a new condition and complete the fields using the sample information provided in the following table. Use the default values except where indicated.

<table>
<thead>
<tr>
<th>Term Attribute</th>
<th>Operator</th>
<th>Value</th>
<th>Relation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person.PartyNumber</td>
<td>is not</td>
<td>1234</td>
<td>AND</td>
</tr>
<tr>
<td>NonmasterParty.MergeType</td>
<td>=</td>
<td>Nonmaster</td>
<td>AND</td>
</tr>
<tr>
<td>UsageAssignment.PartyUsag</td>
<td>=</td>
<td>HR_APPLICANT</td>
<td>AND</td>
</tr>
</tbody>
</table>

Click Save or Save and Close.

Click Submit.

Related Topics
- Agreement Rules: Explained

Source System Confidence

Source System Confidence Levels

Source system confidence levels indicate the reliability of a particular source system for specific attributes. They are used to determine the master or surviving record among multiple duplicate records from different source systems. For each source system, you can set source confidence score for attributes in the Person and Organization objects. The scores are used to select attributes for the master record during merge operation. The scores are used to select attributes, based on the survivorship rules, for the master record during merge operation. You assign source confidence levels based on your understanding of the quality of the data stored in the various source systems within your organization.

Source system confidence levels range from 0 to 100.

How Source System Confidence Levels Work With Survivorship Rules

You can use source system confidence levels for creating survivorship rules. Survivorship rules are used to retain master records during merge, insert, or update operations.

Source system confidence levels

You can import data from legacy or source systems into the application. The legacy or source systems usually store data associated with the same attributes across systems. Similarly, multiple source systems may have data related to the same account.
Source system confidence levels let you indicate how much you trust the data from a specific source system for an attribute. For example, you may trust the customer address data coming from a financial system more than the same data from a marketing system. Similarly, you may trust the employee name data coming from the Human Relationships system more than the same data coming from the Marketing system. While specifying source system confidence levels, you must ensure that only the most reliable data is selected as the master data.

**Survivorship rules**
Oracle CX Sales and B2B Service uses a central data model updated by authorized users from multiple applications. Often, different applications or source systems update the same data resulting in a data conflict.

Survivorship rules are custom business rules that determine how conflicts should be automatically resolved while merging or updating duplicate records from different source systems or applications. For example, you can create a survivorship rule to select the latest customer address data when there are duplicate records.

**Relationship between source system confidence levels and survivorship rules**
Source system confidence levels enable you to build your survivorship rules to resolve duplicate data associated with specific attributes. For example, you could create survivorship rules to:

- Select the record from a source system with confidence values of 80 and above as the master record.
- Automatically reject records from source systems with confidence values of 30 and below.

**FAQs for Source System Confidence**

**What are Set Master and Set Attribute rules?**
Set Master rules enable you to define the logical business criteria for selecting the master record from a set of potential duplicate records for merge operations.

Set Attribute rules enable you to define the logical business criteria for selecting the best attribute values from multiple input records during merge operation.

**Can multiple attributes of an object type have the same source system confidence level?**
Yes, you can apply the same source system confidence level to multiple attributes of an object type. You can manage source system confidence levels using the following in the Setup and Maintenance work area: offering: Customer Data Management; functional area: Customer Hub; task: Manage Source System Confidence.

**Automerger**
The automerge functionality merges duplicate records without any approval or intervention from the data steward. Automatic processing of merge requests is critical when processing large volumes of customer data as automerge can expedite the resolution of duplicate records without manual review. During automerge, the child entities of the duplicate records, such as contact points, relationships, classifications, and cross references, become the child entities of the master record. Note that groovy scripts on relationship objects don't run during merges. If they're critical, you can re-implement the scripts on the parent account or contact.
How Records are Selected for Automerge

Records are selected for automerge based on the following criteria:

- **Score threshold**: The score threshold is defined in the Match Configuration and determines if a record is included in a duplicate set.
- **Automerge threshold**: The automerge threshold is defined by the ZCH_AUTO_MERGE_THRESHOLD profile option and determines if the merge request for a duplicate set is processed automatically or if it must be reviewed manually.

Three possible outcomes for each record with regard to duplicate identification and merging are as follows:

- **Low score below score threshold**: The record isn’t included in duplicate set and in the merge request for that duplicate set.
- **Medium score above score threshold and below automerge threshold**: The record is included in duplicate set but merge request for that duplicate set must be reviewed manually.
- **High score above score threshold and above automerge threshold**: The record is included in duplicate set and merge request is processed automatically.

The score for all the records in a duplicate set must be above the automerge threshold for automated processing. If one record in the duplicate set is below automerge threshold, and the other records are above the automerge threshold, the merge request must be reviewed manually.

**Note**: When you merge two or more records with exactly same children information under phone, email, or address the children information is merged and rolled up to the survivor record.

How You Configure Automerge

Enabling Automerge involves several implementation steps that must be completed by an implementor using the following tasks from the Customer Data Management offering in the Setup and Maintenance work area:

- **Manage Customer Hub Profile Options**: Use this task from the Customer Hub functional area to perform the following implementation steps:
  - Set Auto Merge Threshold profile option (ZCH_AUTO_MERGE_THRESHOLD) to the required value. This profile option specifies the threshold for auto merge. Merge requests with lower scores need data steward review. An exact match is 100.
  - Review the Record Size Limit of Duplicate Set (ZCH_DI_MERGEREQ_REC_SIZE). This profile option determines the maximum number of records in the duplicate set that can be merged automatically. By default, the maximum number is set to 10 records.
  - Set the Survivorship Enabled profile option (ZCH_ENABLE_SURVIVORSHIP) to Yes. This profile option enables the survivorship rules to select the master record and retain the attributes during a merge operation.

- **Manage Survivorship Rules**: Use this task from the Customer Hub functional area to create Set Master survivorship rules to choose the master record for merge requests created from the duplicate identification batch and set the rule to active.

If there are no active Set Master rules or if the Set Master rules didn't trigger, the merge request must be reviewed manually, even if the ZCH_AUTO_MERGE_THRESHOLD profile option is set, the score for all records is above the threshold value, and the number of records is below the record size limit.
Note: You can use the Set Attribute rules with Set Master rules to determine the Golden Master record. For automerge, Set Master rule is mandatory.

- **Manage Enterprise Data Quality Matching Configurations:** Use this task from the Data Quality Foundation functional area to perform the following implementation steps:
  - Create an active Match Configuration in Manage Enterprise Data Quality Matching Configurations task or use a predefined Match Configuration. Rebuild the keys if necessary.
  - Enable EDQ Real Time and Batch Basic Match Server in Manage Server Configurations task.

### Run Automerge

This task involves the following two steps:

1. Create a duplicate identification batch and select Create Merge Request as the Automatic Processing Option.
2. Perform the task Run Request Dispatch Job to disposition the duplicate resolution sets.

The Dispatch Job processes any resolution request in Pending or Submitted status. You can run this job in two modes:

- **On demand:** Run Request Dispatch Job > Submit
- **Per a specific schedule:** Do the following steps to set up a recurring job:
  a. Click Advanced on the Run Request Dispatch Job task.
  b. Click Schedule tab and select the Using a Schedule radio button.
  c. Select the frequency you want and click Submit.

To see the list of dispatch jobs, and their statuses, navigate to Scheduled Processes under Tools.

### Troubleshoot Automerge Issues

After you create your Duplicate Identification Batch, drill down into the completed batch to see the results. If duplicate sets have been found, and automerge is enabled, resolution requests are automatically submitted for merge.

If the resolution request wasn’t submitted automatically, you can drill down to the duplicate set and compare the score for each record with the threshold in the ZCH_AUTO_MERGE_THRESHOLD profile option and the number of records with the limit in the ZCH_DI_MERGEREQ_REC_SIZE profile option. If all scores are above the threshold and the number of records is below the limit, verify that the following are true:

- Set Master rules are active and triggered to choose a master for the records in the duplicate set.
- ZCH_ENABLE_SURVIVORSHIP is set to yes.

### High Volume Batch Deduplication

Batch deduplication of account or contact records in Oracle Customer Data Management Cloud Service consists of the following two steps:

- **Duplicate Identification:** This step includes the identification of duplicate records by submitting a Duplicate Identification Batch job.
  
  You can define and submit this job from the Duplicate Identification page.
Duplicate Resolution: This step includes the resolution of the duplicates, typically by merging each set of duplicate records. You can resolve the duplicates either automatically by submitting the Duplicate Identification Batch job (called Automerge) or manually by submitting records in bulk from the Duplicate Identification Batch results review page.

For more details on these steps and for configuration of Automerge, see Merge Requests, Implementing Customer Data Management.

Both of these jobs are data-intensive operations that can read or update millions of rows of data in various Oracle Application Cloud tables. This document is intended to provide the guidelines and best practices for planning the data-sets, and applying appropriate configurations to achieve optimal throughput for high volume deduplication in Oracle Customer Data Management Cloud Service. Each customer's data set is unique. The time required to process a duplicate identification batch varies on the data shape.

**Best Practices for High Volume Batch Deduplication**

Customer Data Management merge is a data-intensive process that scans and updates a large number of tables in Oracle Applications Cloud, to correctly merge two or more Accounts or Contacts.

This section describes how you can use the following profile options to optimize the merge process:

- **Scope of Merge Process** (ORA_ZCH_MERGE_SCOPE): You can use this profile option to define the scope of the merge process.
- **Master Record Selection Method** (ORA_ZCH_SETMASTER): You can use this profile option to specify the method for selecting the master record in a merge request.
- **Create Automerge with Review** (ORA_ZCH_AUTOMERGE_REVIEW): You can use the profile option to select an appropriate processing option for Automerge.
- **Maximum Number of Concurrent Merge Jobs** (ORA_ZCH_MERGE_MAX_REQUEST_LIMIT): Specify the maximum number of merge jobs to be processed at a time. If you don’t set the maximum limit, all merge jobs are submitted for concurrent processing.

You can set these profile options in the Setup and Maintenance work area using the following:

- Offering: Customer Data Management
- Functional Area: Customer Hub
- Task: Manage Customer Hub Profile Options

**How You Define the Scope of the Merge Process**

When you merge two or more records, the application scans hundreds of transactional and reference tables across all modules in the Oracle Applications Cloud such as, Core Customer Data Management, CRM, Financials, and Manufacturing. This can make merge a data-intensive and time consuming process. However, you can use the Scope of Merge Process (ORA_ZCH_MERGE_SCOPE) profile option to define and limit the scope of merge process in an implementation so that the application scans only the necessary business areas. This optimizes the size of the merge memory and execution profile.

The following options are supported by the Scope of Merge Process profile option:

- **All Functional Areas** (ALL): This is the default option and scans across all areas of Oracle Applications Cloud. You use this option when there's a global implementation running various modules of Oracle Applications Cloud such as, Core Customer Data Management, CRM, Financials, and Manufacturing.
• All Customer Relationship Management Related Areas (CRM): This option limits the scope of the process to handle all the CRM entities such as, Opportunities, and Leads, core Customer Data, Common Entities such as, Notes, and Activities, and Custom Objects. You use this option when there’s a CRM implementation along with the use of Customer Data Management functionality.

• Customer Data Management Specific Areas: This option limits the scope of the process to core Customer Data, Common Entities such as Notes and Activities, and Custom Objects. You use this option during the initial customer data consolidation and to achieve best performance for Customer Data management implementations.

**Note:** The profile option settings can be changed at any time, if additional modules are turned on the instance. For instance, the Customer Data Management option might be used during initial consolidation and cleanup of customer data and then changed to CRM or ALL options if other modules are implemented later.

**How You Define the Master Record Selection Method**

The performance of the merge process also depends on the method used to select the master record. You can use the Master Record Selection Method (ORA_ZCH_SETMASTER) profile option to specify an appropriate option for selecting the master party automatically during merge. The following options are supported by the Master Record Selection Method profile option:

• Select master record using survivorship rule (RULE): This is set as the default master selection option. This option selects the master record based on the Set Master rules defined in the Manage Survivorship task. These rules are applied using the Oracle Business Rules component. You use this option when there are complex business rules required to pick the master.

• Select the oldest record as master (OLDEST): This option selects the party with the earliest creation date as the master.

• Select the newest record as master (NEWEST): This option selects the party with the newest creation date as the master.

• Select master based on duplicate identification results (ANY) - This option randomly selects one of the parties in the set as a master.

**How you Configure Automerge Action**

Automerge is the process of automatically merging identified duplicate sets that exceed the automerge threshold. The process is initiated by creating a duplicate identification batch with the Create Merge Request option. You can use the Create Automerge with Review (ORA_ZCH_AUTOMERGE_REVIEW) profile option that has Yes and No values to select an appropriate processing option for Automerge:

• Create merge requests only for duplicate sets exceeding the automerge threshold: To enable this processing option, select No as the value for the Create Automerge with Review (ORA_ZCH_AUTOMERGE_REVIEW) profile option. If you select this option, the application processes duplicate sets as follows:
  - The application preprocesses the duplicate sets exceeding the automerge threshold and merges them into a single job. This option is ideal for processing high volumes of merge requests when the duplicate sets require no review or any further action.
  - Duplicate sets not exceeding the automerge threshold remain in Not Reviewed status in the Duplicate Identification page, from where they can be manually converted to merge requests, or rejected, if needed.

• Create Merge Requests for all duplicate sets: To enable this processing option, select Yes as the value for the Create Automerge with Review (ORA_ZCH_AUTOMERGE_REVIEW) profile option. If you select this option, merge requests are created for all duplicate sets. All requests are first pre-processed. Then they’re either
merged (if they exceed the automerge threshold), or put in "New" status (so that they can be reviewed) if they don’t exceed automerge threshold.

How you Control the Concurrency of Merge Processes

Each merge request executes as a single batch process in the Enterprise Service Scheduler (ESS). The number of merge requests executing concurrently is limited by the number of batches being concurrently processed. Therefore, if there are other ESS processes competing for threads when there are a large number of merge requests queued up, then the scheduling of those jobs could get delayed.

During initial consolidation of customer data, it’s advantageous to use the maximum available threads. However, in steady state when there are other processes running in the background, it may be necessary to limit and control the number of concurrent merge ESS jobs.

To achieve this, set the following profile option to an appropriate value:

- **Profile Option Name**: Maximum Number of Concurrent Merge Jobs
- **Profile Option Code**: ORA_ZCH_MERGE_MAX_REQUEST_LIMIT
  - When the profile option value is left blank or when no value is defined, the ESS will allocate merge requests according to the threads available. This is recommended during initial high volume data processing.
  - After initial data load, set the profile option value to ten or lower if other processes such as Web services or other ESS jobs are running.
22 Customer Data Management Integration with Other Cloud Services

Customer Data Management Integration Approaches

You can integrate the Customer Data Management functionality of Oracle CX Sales and B2B Service with other cloud services using REST APIs and SOAP APIs to provide address cleansing, duplicate identification, and duplicate resolution capabilities. Alternatively you can use the Integration Cloud Service to develop work flows to integrate Customer Data Management with other cloud based or on-premise applications.

Customer Data Management Integration Using REST APIs

The Oracle Customer Data Management functionality of Oracle CX Sales and B2B Service provides multiple public REST APIs that can be used to access data stored in the Customer Data Management database and construct integrations to other systems. The APIs include resources to Get, Post (create), Patch (update), and Delete organizations (accounts) and persons (contacts). Also there are resources to identify and create resolution request for duplicate parties.

For more information on public REST APIs, see REST API for CX Sales and B2B Service.

Customer Data Management Integration Using SOAP APIs

The Customer Data Management functionality of Oracle CX Sales and B2B Service provides SOAP services to create and update organizations (accounts) and persons (contacts). You can also use these services to identify and resolve duplicate parties.

For more information on SOAP APIs, see Oracle CX SOAP Web Services for CX Sales and B2B Service.

Customer Data Management Integration with Import and Export

You can use Import and Export Management, File-Based Data Import and Export, Bulk Export, and Data Import to import and export application data using text or XML files into and out of the Customer Data Management registry.

You can also import attachments using Import and Export Management and File-Based Data Import. Note that the imported attachments aren't visible in Customer Data Management if you used the Account or the Contact import objects but can be viewed in Customer Center. To import attachments in Customer Data Management, using Import and Export Management you must use the Organization and Person import objects. For more information about importing attachments, see the Related Topics section.

You can also use import to create or update records in the Customer Data Management registry.

You can configure the import process to:

- Define deduplication within the data being loaded.
- Define deduplication of the data being loaded against the records that exist in the database.

You can also select a matching configuration to identify duplicates and specify the action to perform on the duplicate records during the import process.
For more information on File-Based Data Import and Export, see Understanding File-Based Data Import and Export, and Understanding Import and Export Management.

Customer Data Management Integration Using the Integration Cloud Service

You can use the Integration Cloud Service to leverage predefined integrations between Customer Data Management, other cloud services, and on premise applications. For example, you can integrate Oracle Service Cloud with Customer Data Management to provide the duplicate resolution capability. Using this capability, you can merge an Oracle CX Sales and B2B Service account (organization) or contact (person) with an Oracle Service Cloud account (organization) or contact (person).

For more information on the Integration Cloud Service, see Oracle Integration Cloud Service in the Related Topics section.

Customer Data Management Integrations for Accounts (Organization) and Contacts (Persons)

The following table shows the possible integrations options for Oracle Customer Data Management. The table also lists the available REST and SOAP web services that you can use to perform the different Customer Data Management processes.

<table>
<thead>
<tr>
<th>Customer Data Management Process (Batch Job)</th>
<th>SOAP Service</th>
<th>REST Service</th>
<th>Data Import (for account Receivables only)</th>
<th>File-Based Data Import</th>
<th>File-Based Data Import (Simplified View)</th>
<th>File-Based Data Export</th>
<th>ICS Events</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Cleansing</td>
<td>Yes, DQRealTime</td>
<td>Address Cleansing is available by the REST service from Address Verification Cloud Service only.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Yes (Batch Summary only). Doesn’t include child object such as duplicate address and relationships.</td>
<td>No</td>
<td>File Export is only available from Customer Data Management work area.</td>
</tr>
<tr>
<td>Duplicate Identification</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes (Batch Summary only). Doesn’t include child object such as duplicate address</td>
<td>No</td>
<td>File Export is only available from Customer Data Management work area.</td>
</tr>
<tr>
<td>Customer Data Management Process (Batch Job)</td>
<td>SOAP Service</td>
<td>REST Service</td>
<td>Data Import (for account Receivables only)</td>
<td>File-Based Data Import</td>
<td>File-Based Data Import (Simplified View)</td>
<td>File-Based Data Export</td>
<td>ICS Events</td>
<td>Comments</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>--------------</td>
<td>--------------</td>
<td>-------------------------------------------</td>
<td>------------------------</td>
<td>------------------------------------------</td>
<td>------------------------</td>
<td>------------</td>
<td>----------</td>
</tr>
<tr>
<td>Duplicate Resolution and Merging</td>
<td>Yes. The Resolution SOAP service can create new resolution requests and query existing resolution requests but can’t update the existing requests.</td>
<td>Yes. The crmRestApi/resources/latest/resolutionF REST service can create new resolution request and query existing resolution requests but can’t update the existing requests.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes. Public Resolution Request Updated. Bulk Export can be used for duplicate party details in the Duplicate Resolution. See, Implementing Customer Data Management in the Related Topics section.</td>
</tr>
<tr>
<td>Data Enrichment</td>
<td>No</td>
<td>Data enrichment is available by REST service from Oracle Data as a Service only.</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Non-Duplicate</td>
<td>N/A</td>
<td>crmRestApi/resources/latest/nonDuplicate</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Resolution Link</td>
<td>N/A</td>
<td>crmRestApi/resources/latest/resolutionLink</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Related Topics

- Oracle Integration Cloud Service
- Perform Bulk Export
- Import Attachments
- Import Attachments Using File-Based Data Import
Merge Operation Process During Integration Cloud Service Based Integration

The Customer Data Management functionality of Oracle CX Sales and B2B Service acts as the customer master during Integration Cloud Service based integration between different cloud services (also known as spoke systems). You can use Customer Data Management to cleanse, consolidate, and share customer data across integrated cloud services. This topic explains how the duplicate resolution capability of the Customer Data Management functionality merges records across integrated cloud services, for example, how it merges an Oracle CX Sales and B2B Service account or contact with an Oracle Service Cloud account or contact.

Merge Operation Process for Point to Point Integration

In this integration scenario, Customer Data Management provides the duplicate resolution capability to a single spoke system.

The following diagram shows the before merge status of two contacts, Contact A and Contact B, of an account from Spoke 1.

The following diagram illustrates how the two contacts, A and B, of the account from Spoke 1 are being merged in CDM and how the Contact A emerges as the survivor and the Contact B becomes the victim.
The following diagram shows the after merge status of two contacts, A and B, of the account. Note that in Spoke 1 only Contact A has survived and remained active after the merge.
Merge Operation Process for Publish and Subscribe Integration

In this integration scenario, Customer Data Management provides the duplicate resolution capability to two or more integrated cloud services or spoke systems. Duplicate data from spoke systems is consolidated in CDM and the mastered data is published to the subscribing spoke systems.
The following diagram shows the before merge status of two contacts, A and B, of an account that exists both in Spoke 1 and Spoke 2.

The following diagram shows the after merge status of two contacts, A and B, of the account.
Take note of the following:

- Data about Contacts A and B comes in Customer Data Management registry from both the spoke systems.
- The merge is taking place in Customer Data Management registry and any owned objects by the victims are moved (re-parented) to survivor record in CDM.
- The mastered data is published to both the spoke systems and, consequently, Contact B is deleted from both the spoke systems.
- When performing merge across different cloud services using ICS based integration, you should explicitly publish to merge events and not rely on account, contact, and household composite events. You can publish merge events by implementing the Resolution Request Updated business event in ICS.
Glossary

address style format
Specifies the layout of an address, such as how many address lines it contains, and whether a city name is mandatory.

classification category
A grouping of classification codes, categorizing entities such as parties, tasks, and orders. Allows classification code assignment rules to be defined.

geocode
The latitude and longitude coordinates for a location.

identifier type
An identifier type is a specific category of additional identifiers, numeric or otherwise, which can identify members. Examples of identifier types could be bank account numbers, passport numbers, and so on.

Items
Entries within the Product master database. For example, items for a manufacturing company can include nuts, bolts, and screws.

lookup code
An option available within a lookup type, such as the lookup code BLUE within the lookup type COLORS.

lookup type
The label for a static list that has lookup codes as its values.

marketing list
A static selection of contacts for the purpose of communicating a marketing message by email, direct mail or phone.

name style format
Specifies the layout of a name, such as first name, last name, and phonetic last name.

name type
A name type is a specific category of additional names that can identify trading community members. Examples of name types could be maiden names, aliases, doing-business-as names, and so on.

profile option
User preferences and system configuration options that users can configure to control application behavior at different levels of an enterprise.
profile option value
The setting mapped to the level of a profile option. A profile option may have multiple values set at different levels, such as Site or User.

Query By Example
The icon for filtering data in a table.